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Notes to the Third Edition 

 Traffic Count Estimation enables you to combine historical traffic data with 

intelligent Carriageway Section linking to produce a traffic counting and 

estimation programme which delivers the most Network coverage, the most 

accurate and up to date ADT Estimates for the minimum number of counts. 

Below you will find the areas of refinement of this system for the 2011 version of 

: 

• Initial Processes and Parameters (on page 57) 

You set initial parameters so that Traffic Count Estimation is implemented to match your 

circumstances. First you select your Region and Road Council. Next you define the 

number of years of your most recent Count data you want to be taken into account 

when setting up  Traffic Count Estimation. The major decision you take is to 

determine the percentage of your Network VKT that you want to count. 

• Traffic Link Maintenance 

There are a number of refinements to the creation and maintenance of Traffic Links in 

 2011. These refinements are particularly useful when you have created the 

recommended Traffic Links and are associating them. 

• Traffic and Loading Definition 

Traffic and Loading in  2011 has been updated to accommodate the 

requirements of different sets of users. 

• Traffic and Loading Data Import (on page 249) 

When importing Traffic and Loading count data into  you have a 

specialised data file import option. You use this rather than the generic 

 Import File option. 

http://www.ramm.co.nz/
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• MetroCount File Import 

MetroCount Traffic Count and Loading data files can now be imported into  

databases using the MetroCount Import utility. You access this from RAMM 

Applications or from . 
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C H A P T E R  1  

Your traffic data is important  database information. Best practice is to use 

 Traffic Count Estimation to manage this data. 

Traffic Count Estimation is a sophisticated traffic data management system which you 

can implement in . It: 

• recommends Carriageway Sections for you to link to maximise the efficacy of count 

data 

• identifies the Roads which you need to count most often 

• recommends sites at which to perform counts 

• recommends a count schedule based on parameters you have set. 

You use your knowledge of your Network to link Carriageway Sections to the 

Roads where counts take place. Then those Carriageway Sections which take a 

known percentage of traffic can automatically have an Average Daily Traffic 

(ADT) Estimate calculated for them based on the actual count and other factors. 

 Traffic Count Estimation enables you to combine historical traffic data with 

intelligent Carriageway Section linking to produce a traffic counting and 

estimation programme which delivers the most Network coverage, the most 

accurate and up to date ADT Estimates for the minimum number of counts. 

In  Th is  Chap ter  

Overview ....................................................................................... 2 

Traffic Count and ADT Data Entry ............................................. 2 

Loading Data Entry ....................................................................... 3 

Audience ........................................................................................ 4 

Related Guides .............................................................................. 5 
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Overview 

 Traffic Count Estimation is designed to generate the most accurate possible 

Estimates of traffic volumes for each Carriageway Section in your Road Network. 

It does this by taking actual Traffic Counts which you have made and extrapolating 

Average Daily Traffic (ADT) Estimate values for each and every Carriageway 

Section in your Road Network. 

This is achieved by the creation of Traffic Links. These are linked Carriageway 

sections with the same traffic volumes. Traffic Links which receive traffic from 

another Traffic Link can also have a known percentage of the total traffic of the 

feeder Traffic Link set as their Estimated traffic volume. 

Once the Traffic Links have been set,  can recommend Count Sites. 

When you have set up the Traffic Links and Count Sites in your  database, have 

updated your legacy data and generated a count schedule, you perform your Traffic 

Counts. You then enter the ADT and Loading values into . The data 

collected measures only the traffic which occurred during the time period of the 

survey. So, to make this more meaningful,  takes a variety of factors into 

account: 

• the duration of the count 

• the time of day of the count 

• the day of the week of the count 

• the week of the year of the count 

• the region in which the count was taken  

• the season in which the count was taken 

• the classification of the Road on which the count was taken 

• the traffic growth profile for the Count Site at which the count was taken. 

This is then used to update the ADT Estimates. 

 

Traffic Count and ADT Data Entry 

Prior to setting up  Traffic Count Estimation you would enter Average Daily 

Traffic (ADT) values and Count Status values at the Traffic screen, shown below, for 

each Carriageway in your database. The Traffic screen has now been replaced by the 

Traffic and Loading screen 

Standard practice was to enter the data into  by importing a file containing 

the information. Often, this meant that those Carriageway Sections which were 

not counted every year were then not updated every year. 
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Data Entry for Traffic Count Estimation 

Once you have set up  Traffic Count Estimation you will need to enter ADT 

values only for those Carriageway Sections on which an actual Traffic Count has 

taken place.  

 will then generate ADT Estimate values for all the linked Carriageway 

Sections based on decisions you made during set up. 

You can still manually enter ADT values at the Detail tab of the Traffic and Loading 

screen. See Traffic and Loading (on page 161). 

 

Loading Data Entry 

Once you have set up  Traffic Count Estimation you will enter ADT and 

Loading values only for those Carriageway Sections on which an actual Traffic Count 

has taken place. 

 will then generate Loading Estimate values for all the linked Carriageway 

Sections based on decisions you made during set up. 

Data Entry for Traffic Count Estimation 

You can manually enter Loading values at the Detail tab of the Traffic and Loading 

screen. 
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Audience 

This  Traffic Count Estimation guide is for Network Engineers, Consultants 

and their staff. It is for those who set up and manage traffic counting in their 

 databases. It may be of use to Contractors who perform the actual Traffic 

Counts if they also enter the data into the  database. 

The guide contains: 

• the reasons to institute  Traffic Count Estimation 

• how  Traffic Count Estimation works 

• how to set up  Traffic Count Estimation in your  database 

• advice on the set up of Count Sites to maximise the efficient use of resources 

• how to generate Dispatches in  to ensure the Traffic Counts take 

place 

• useful Traffic Count Estimation reports 

• a series of appendices with the values of the variable factors used in the Traffic Count 

Estimation calculations. 
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Related Guides 

There are several guides related to  Traffic Count Estimation which you should 

consider reading. 

Using RAMM 

This  primer takes a new user through the basics of using . If you 

are unfamiliar with  you will find the chapters on the  Workspace, 

Filters and in particular, Mapping very helpful. 

RAMM Contractor 

If you use a Contractor to perform the actual Traffic Counts you can read this guide. 

It has step-by-step instructions on how to set up a Contract. It also explains how to 

use  Dispatches. 

For a list of  guides see  Guides and Manuals (on page 25). 

 





 

  

C H A P T E R  2  

Road Assessment and Maintenance Management ( ) is software developed 

and supported by RAMM Software Limited. This software is used by Road Controlling 

Authorities (RCAs) to manage Road Inventory Assets and Condition for their 

Network. 

 is the complete package for Asset maintenance, valuation, assessment, 

Forward Work Planning as well as inventory-based Asset management. It also 

includes a range of report and analysis applications which complement the 

management functions. 
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What is RAMM? 

The  (Road Assessment and Maintenance Management) software from 

RAMM Software Limited is a comprehensive suite of applications to maintain and 

manage Road Inventory and Condition data. 

 

 

The name  is used not only for a suite of Road Assessment 

and Maintenance Management applications but also for the central 

software application itself. 

 

The RAMM Suite 

The full  suite includes  (sometimes referred to as  for 

Windows), , , , 

, , ,  

and .  

When  was introduced to the industry in the 1980s, it was a green screen 

application. Later a GUI (graphical user interface) was introduced. This is when it 

was sometimes called  for Windows. As users came to expect more from 

 other applications were added. , 

 and  were added to facilitate Lookup, Staff Permissions, 

process, report and Network maintenance, database manipulation and data 

extraction. When Network Owners and Contractors needed a better system for 

contract management,  and  were introduced. 

Recently the  has been added to enable NZ Corridor Managers to 

manage access to their Network.  has been designed to 

give clients greater control over the users who access their Network data. It will be 

rolled out to our New Zealand clients in the near future.  enables easy 

viewing of  data on a map without having to log in to . 
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Your RAMM Applications 

The full  suite includes the following applications. You can access each 

individual application only if you have the correct Staff Permissions. 

 RAMM (for Windows) 

 (for Windows) is the central application of the  suite. You access 

your Inventory, Asset and Condition data for your Network from . 

 RAMM Manager 

 is the module in the  suite of products which you use to 

set up Lookups, to maintain Staff Permissions, to run processes such as Status 

Check, and to run reports. 

 RAMM Contractor 

 is the module of the  suite of products which enables 

Contractors, Network Owners and Consultants to manage Road Asset 

Maintenance Contracts. In particular, it has been optimised to facilitate the 

Programming of Network maintenance and the Estimation and Claims process 

which is integral to Programmed Maintenance Contracts. It also includes the 

special features for the managing of Contracts for Signs, Street Lights and Traffic 

Signals maintenance. 

 Pocket RAMM 

 is the module of the  suite of products which enables a 

user to run  on a netbook, laptop, tablet or PDA, and to perform Contract, 

Inventory and Claim management while mobile, in the field. Virtually all of the 

everyday maintenance ability of  is present in . 

Please note that the  application has become so comprehensive that 

the use of PDAs with  is no longer recommended. PDAs are no 

longer powerful enough to deliver a positive user experience. 

 RAMM SQL  

 is the module of the  suite of products which enables a power 

user to manipulate  data using SQL (Structured Query Language). It is a 

very powerful tool and should be used only by advanced users who have a detailed 

knowledge of the  database. 
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 RAMM Network Manager  

 is the module in the  suite of products which 

you use to manage the details of your Network and in particular, the Road centre 

lines.  is a powerful, flexible and comprehensive Road 

Network maintenance tool that helps you automate tasks and perform complex 

Network management actions. For example, you can reverse a Road with a single 

press of your mouse. When you apply this change  

will update all relevant tables within the database. It also has a graphical display 

which displays current and historical views of the changes you are making. 

 Hosting Administration 

The  is an online application which enables users to 

manage access to their Network. It enables Network Administrators to create 

logins for individual users and allows those individuals to maintain their own 

passwords. At the time of writing, Hosting Administration is available only to 

Western Australian LGAs who are clients of <arrb>. 

 CAR Manager 

 is the online application used by corridor managers to manage 

requests by utility operators, or their contractors, to access the Road corridor. 

Access to the corridor is required to make changes to electricity, gas, 

telecommunications, water, wastewater and postal infrastructure. At the time of 

writing,  is available only to New Zealand RCAs who are clients of 

RAMM Software Limited. 
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 RAMM GIS 

 is the  Geospatial Information Service. Using it is a bit like 

flying over your network and viewing your  data, but without ever leaving 

the office. 

 

 

Your ability to view and access the complete suite of  

products will depend on your Staff Permissions. Best practice is to 

grant you permission to view and access only those applications 

which you need for your normal duties. 

 

 

Your RAMM Database 

All your Road Inventory and Condition information in  is stored in a 

central database. Everything you do in  is linked to it. All the actions you 

perform affect it. 

How the Database Is Arranged 

The information in the  database is stored in tables. There are many of 

these, one for each aspect of the Road Network. Examples of  tables are 

Surface Structure and Roughness.  often combines information from 

different tables when you are working with it. 

Each table holds its data in a combination of rows and columns. Each row in a 

table can also be called a record. It contains all the details for the particular aspect 

of the Road section - for example, the Start Displacement, Material, Construction Date 

and so on of a particular Road section. Each individual item of data is held in its 

own column. 

These columns are related to the fields on  screens. Information in a field 

on a  screen resides in a table column. The column contains information 

about all the Roads, but pertaining only to one aspect of the Road - for example, 

just the Displacements for the various Roads and Road sections you are looking at. 
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Road Asset:  Column (Field):    

Surface 

Structure 

Table 

Road Name Start 

Displacement 

Pavement Type Construction 

Date 

Row (Record): Smith Street 000m Thin Surfaced 

Flexible 

17/03/2003 

 
Jones Road 100m Concrete 12/02/2000 

 

 

 

You will see messages and warnings from time to time, some 

accompanied by detailed, database related information. It is always useful 

to either print or record this information somewhere and have it at hand 

when you call RAMM Software Limited for assistance. See Contact RAMM 

Software Limited (on page 28). 

 

 

 

Your Other Software and RAMM 

When you are working with , you will use other software. The following 

list is not exhaustive. Also, you might not use some of the software listed. 

Internet Browser 

Your web or internet browser is the software application you use for accessing, 

presenting, and navigating information on the World Wide Web. You use it to 

access  through the  Hosting Service. Common browsers are Internet 

Explorer, Firefox, Safari and Chrome. Best results for accessing  through 

the  Hosting Service have been achieved using Internet Explorer. 

Citrix Client 

The Citrix client is a third party, remote access application. It allows users to 

access  remotely. It enables secure passing of data between a remote server 

and your local, or client pc or other device. Once the Citrix connection is 

established, you work with  as if it were running on your local device. 
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Microsoft Excel and Others 

You can export  data in a format usable in Microsoft Excel, Access and 

other data manipulation and reporting software. 

Windows Explorer 

You use Windows Explorer (sometimes referred to as My Computer) to access 

files on your computer which you attach to records in  on the Multimedia tab 

of the  Detail screens. Similarly you can use the software to download and 

save  multimedia files to your own hard drive. 

dTIMS 

Deighton Total Infrastructure Management System (dTIMS) is a software tool 

used to model Pavement Deterioration.  provides a method of extracting 

Treatment Length, Maintenance Cost and related data from the Road Network in 

a format that can be imported into dTIMS.  You export information from  

for use in dTIMS, and then import the results of your analysis back into . 

RAMM Web Service 

A web service is software application supporting one software product to talk to 

another. You use the  Web service to enable your CSRs (Customer Service 

Representatives) to use their customer service software to add a Job into 

 for, say, a Street Light out, and to monitor the Job progress. 

Configuring access to the  Web Service is the responsibility of 

the Network Owner. 

 

The RAMM Main Screen 

The  main screen is your portal to your  database. You should 

familiarise yourself with its main items. 
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No Item Comments 

 

Menu Bar This contains the standard drop-down lists with 

which all Windows users will be familiar.  

 

Tool bar This is a repository for shortcuts to the screens you 

use most often. 

 

Show toolbar menu (screen 

selection drop-down list) 

You press this button for the drop-down list to access 

all the  Inventory, Condition and other data 

screens. 

 

Roads list panel This panel lists all the Roads in your Network. You 

can Filter this list to include only the group of Roads 

you require. 

 

Expanded tree You press  to expand the tree and reveal the 

Carriageway Sections for a Road. 
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Detail screen Detail screens display the details for one  

Inventory, Condition or other data record. You edit 

the item details at the Detail screen. 

 

Grid screen Grid screens display the details for one or more 

 Inventory, Condition or other data records. 

You use Grid screens for reporting and other 

purposes. 

 

Map 
The Map in  is a wonderful tool for 

visualising your Network and updating it. 

 

Status bar This is where you look to see useful information 

about what you are doing. 

 

 

RAMM Terminology 

In , as with any software application, there are terms which have a meaning 

specific to the software. When you are working in  you will encounter 

these terms. You should have an understanding of them before you do. Some of 

these terms are also used in the wider Road industry. The definitions below are 

specific to .  

The following list is a minimum of the terms you need to understand before you 

start to work with . You can also look at the Glossary at the end of this 

guide for a more comprehensive list. 

RCA 

A Road Controlling Authority (RCA) is the organisation responsible for a 

particular Road Network. An example of an RCA could be the New Zealand 

Transport Agency (NZTA) or a TLA (Territorial Local Authority). 

Network 

A Network is a collection of Roads managed by a particular Road Controlling 

Authority (RCA). Each  database usually contains all the information for 

one Network. 
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Road 

For Local Authorities, a Road denotes a single named Road that is part of their 

Network. For State Highways, a Road is a segment of the State Highway. Roads 

may include associated Assets such as Pavement, Top Surface, and Shoulders. 

Assets such as Signs and Surface Water Channels are associated with a Road. 

Carriageway 

Roads in  are divided into logical sections named Carriageways. These start 

and end at easily identifiable Locations such as Intersections and Bridges. You can 

define your Carriageway Sections to suit your own purposes. For instance you 

may define them to start and end when the number of Lanes in the Road changes 

or if the Road changes between Sealed and Unsealed sections. A Carriageway 

Section starts at one Displacement along the Road and ends at another 

Displacement. Carriageways define the lengths of Road against which other Assets 

can be referenced. 

Displacement 

Displacement is the distance along a Road measured from the start of the first 

Carriageway Section of the Road. It is stated in metres. 

Location 

Location refers to the collection of details used to position an Asset or Inventory 

item within a database. The most basic Location information is a combination of 

Road and Displacement. Location information can also include helpful notes such 

as nearby landmarks. Point Assets such as Signs have a Location field whose value is 

the Displacement of the Sign from the start of the Road. 

Asset 

An Asset is an item in a Network which has a value. It could be a physical 

component of a Road, such as its Surface. It could be something real such as a 

Bridge, a Footpath or a Street Light. Where no table exists in  for one of 

your Asset Types, you set up a User Defined Table (UDT) to manage the Assets. 

Nonasset 

Nonassets are items for which screens exist in  but which have no 

monetary value. They are generally something not physically present on the Road 

Network such as Roughness, Maintenance Cost and Crash. You can set up User 

Defined Tables (UDTs) to manage Nonassets which do not have their own 

screens in . Examples could be slips, hazards and certain Condition data.  
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Stock Asset 

In  the three Asset Types, Signs, Street Lights and Traffic Signals are 

referred to as Stock Asset Types. This is because, unlike the other Asset Types, 

when Signs, Street Lights and Traffic Signals Assets or components are replaced, a 

detailed record is kept of the replacements including the Replacement Reason. So 

you have an itemised list of the current and past Assets. You create Stock UDTs to 

manage those of your Assets (if any) which do not already exist in  and for 

which you need to keep replacement records. 

Network Inventory 

Your Network Inventory is your  database records including real items 

such as a Bridges and Footpaths as well as your Survey and other data such as 

Crashes and Bylaws. Your Condition data such as Roughness and your report data 

such as  3D do not form part of your Network Inventory. 

Condition 

The term Condition has two related meanings in . In  Assessment 

the Condition of an Asset describes its fitness or readiness for use. Typical  

and NAMS Conditions are Excellent, Good, Average, Poor and Very Poor. Assessment 

Condition Weighting is used to determine Risk of Failure and the Consequences 

of Failure. 

There are also Road Conditions which have their own  screens. 

Roughness, High Speed Rutting and Skid Resistance are examples of  items 

used to describe the Condition of your Roads. 

You will be able to tell from the context in which it is used, which meaning of the 

term Condition is intended. 

Assessment 

An Assessment is the record of an inspection of an Asset. You use Assessments for 

a number of reasons including to record the Condition of an Asset or its associated 

Likelihood and Consequences of Failure (Risks). Rating and HSD are used to 

Assess Roads. 

Rating 

Rating is the process of recording the state of a Road by measuring the extent of 

the deterioration which has occurred. This includes factors such as the length of 

Cracking and Potholes. This is sometimes referred to as Condition Rating. 
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HSD 

High Speed Data (HSD) is the collective name for particular properties and state 

of a Road as measured by specialised equipment mounted on a vehicle. The 

properties of the Road include its slope and curvature values. The state of the 

Road includes its Roughness and Skid Resistance values. 

Treatment Length 

A Treatment Length is a section of a Road with consistent performance and 

purpose. For example, it could have the same Top Surface material and Annual 

Average Daily Traffic (AADT) count along its length. A Treatment Length may 

have had similar Treatments applied along its length and is often different from its 

adjoining sections. 

Treatment Lengths may coincide with Carriageway sections, but the same 

Carriageway section may have more than one Treatment Length. A Treatment 

Length may span more than one Carriageway section. Treatment Lengths will 

usually change over time, as conditions change. 

Treatment Selection 

A Treatment Selection is a recommended treatment for a Treatment Length to be 

carried out in the next twelve months. This recommendation can of course be No 

Treatment. Treatment Selections are generated in  using the Treatment 

Selection Algorithm (TSA). 

 

Log in to RAMM 

You must log in to  before you can use it. 

You cannot log in to any of the  applications unless you have a login name 

and a password. Once you have logged in you need appropriate Staff Permissions 

to carry out tasks related to your role. 

Contact the Systems Administrator for the correct Staff Permissions to perform 

your normal tasks. See the Security chapter of the Working with RAMM guide. 

You log in to  using the  Hosting Service. 
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RAMM Hosting Service 

The  Hosting Service is a service run by RAMM Software Limited. It enables you 

to run  across the Internet. It hosts your database and the software on a 

server at a centralised location. You use your standard internet browser to access 

the software and work with your data, so you do not need any specialised software. 

It is very secure. 

You use the  Hosting Service from anywhere with an internet connection. 

The graphic below shows the the options to access  using the  

Hosting Service. 

 

 

 

Logging in to the RAMM Hosting Service 

Introduction 

You log in to the  Hosting Service to access the  applications.  

Before you do this you need to have: 

• been granted access with a username and password by RAMM Software Limited. To 

contact RAMM Software Limited for assistance, see Contact RAMM Software Limited (on 

page 28). 
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• Downloaded the MetaFrame Presentation Server Client for 32-bit Windows. You do 

this by clicking the link on the RAMM Software Limited website Log in page and 

following the instructions. 

• opened your web browser such as Internet Explorer or Mozilla Firefox. 

Menu Path 

Follow the menu path ramm.co.nz https://login.ramm.co.nz/ to open the Log in page. 

►  To  Log  in  to  th e  RAMM Hos t ing  Serv ice  

 

 

To do this you follow these steps: 

1 Type your username and password in the User name: and Password: fields. 

2 Press Log In. 

The Applications panel will open. What you see in the Applications panel will depend on 

your Security Permissions. 

 

 

3 Do you want to use ? 
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Yes go to step 4. 

No go to step 6. 

4 Press the Pocket Applications icon. 

The  applications will become available. 

5 Go to step 7. 

6 Press RAMM 2011. 

The Applications panel will open. The software icons will be available. 

 

 

7 Press the icon for the  software you want to use. 

The  software application will open. If you have access to more than one 

database, a dialog will open so that you can choose the database which you require. 

 

 

If you use an older version of Mozilla Firefox as your internet 

browser, a Warning telling you that you do not have the MetaFrame 

Presentation Server Client for 32-bit Windows will display as in 

the Log in page screen shot above. Once you have downloaded the 

software you can ignore this warning. 

 

 

RAMM Help Options 

The time will come when you will want to know more about  so that you 

can be both more proficient and efficient. Use the following options to upskill: 

• use the Help from within the software. See Context-sensitive Help (on page 22). 

• use internet-based Help. See  Help on the Internet (on page 24). 

• read the  documentation. See  Guides and Manuals (on page 25). 

• discover the  tables and columns. See Database Details (on page 27). 

• talk to other  users. See Help from Other Users (on page 26). 

• seek professional help. See Contact RAMM Software Limited (on page 28). 
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Context-sensitive Help 

User assistance has been integrated into the  applications. 

Most screens in  have a Help  menu option. You press F1 on your 

keyboard or press Help  at the top of the screen to open the context-sensitive 

Help. 

As you can see in the graphic below, when you press Help  at the top of the 

screen, one page in a .chm file will open. In this example information to enable 

you to view Scheduled Traffic Counts on the Map on  is being offered. 

If the information on the page does not solve your issues, you can navigate 

through the .chm file. Use the Search and Index to speedily locate the information 

you require. 
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If you still need further information you can follow the menu path Help > Website > 

Read Latest Manuals. This will take you to a list of the latest  manuals and 

guides where you can search for answers. 

 

 

 



 

2 4  T r a f f i c  C o u n t  E s t i m a t i o n  
 

RAMM Help on the Internet 

The  user guides and manuals are available from the RAMM Software Limited 

web site (http://www.ramm.co.nz). They are generally available in both 

downloadable .pdf versions and in online Web Help versions. 

 

 

Web Help 

The Web Help versions of the user guides and manuals are the primary versions 

you will want to use. They are available from the web site and so are available to 

you, so long as you have access to the internet. 

The Web Help versions open in your internet browser and are very attractive. 

They are fully searchable. They have both a table of contents and an index for 

quick access to the information you want. 

Their only disadvantages are that you can print only one page at a time and they 

are not available to you when the internet is not available. 

PDFs 

The .pdf versions of the user guides and manuals are useful mainly if you want to 

print complete documents or large portions of them. 

Also, the .pdfs may be useful if you want to keep your own copy of the manual on 

your desktop or mobile device. 

Google Search 

If you type a question into the Google search, this will sometimes return the 

information you are after. This can be hit or miss. 

 

http://www.ramm.co.nz/
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RAMM Guides and Manuals 

RAMM Software Limited offers useful guides and manuals to enable you to maximise 

the benefits to you of using . 

Release Notes 

Users who want to know what is in the latest version of  should read: 

• What's New in RAMM 2011 (Web Help) 

This is a detailed description of the changes and improvements to the  software 

suite in the 2011 release. In particular, it is the changes to Assets, Data, Finance, 

Patrols, Reports, Roads and Traffic Count Estimation, which are featured. The Web Help 

version of this document is fully detailed and fully searchable. 

Basic Help 

Users who are new to  need to understand the  basics to maximise 

their experience with the software. They should read the following  primer 

as it includes very helpful introductory information: 

• Using RAMM 

This is a basic help guide introduction to . It covers the essentials, common 

tasks, procedures as well as Mapping and Decision Cube functions. There is a 

comprehensive explanation of the  tool bar controls. 

Advanced RAMM Functions 

Users familiar with  and ready for its more advanced functions should read: 

• Best Practice for Assessment in Pocket RAMM 

This guide shows how you can set up Assessments for  and record 

your Assessments in the field. This guide is available online only. 

• Managing RAMM 

This advanced guide includes sections on Skid Resistance, Treatment Selection and 

Auditing Survey data. It has not been updated recently. This guide is available online 

only. 

• RAMM Assessment 

This guide is for those who manage and record Assessment Inspections of Network 

Assets, enter the results into  and generate analyses of Condition and Risk. 

• RAMM Asset Valuation 

This advanced guide to the Asset Valuation process covers valuing a Road Network and 

calculating Replacement Costs. 

• RAMM Forward Work Programme 

This guide is for those who use  Forward Work Programme (FWP) - also 

known as NOMAD. It is an advanced tool for forecasting and analysis. 
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• Traffic Count Estimation 

This guide explains the set up and use of the  Traffic Count Estimation 

System. 

• Working with RAMM 

This is an advanced help guide for power users of . Use this guide only if you 

have a good working knowledge of , its Assets, the database structure and key 

components such as Treatment Lengths. This guide covers: User Defined Assets, 

Surfaces, , Bridges, Maintenance Activity, Pavement Structure, Pavement 

Strength and  Security. 

RAMM Contractor Guides 

Those users who need to know how to use  should read the 

following manuals: 

• RAMM Best Practice 

This guide gives step-by-step instructions on how to run a Programmed Maintenance 

Contract in . It is available as a .pdf or .xhtml file but not as a 

printed manual. 

• RAMM Contractor 

This guide is for those Road Maintenance Contractors and Network Owners who use 

 software. It covers setting up Contracts, managing Dispatches, 

generating Claims for work done and reporting on Contract activities. 

Printed Manuals 

RAMM Software Limited is happy to provide you with printed manuals to which you 

can refer at your convenience. 

There is a small charge for additional copies of the manuals. Printed manuals do 

not require access to a computer or the Internet and are ideal for browsing, 

reference or learning about something in depth. 

There are a number of guides which are available to  users. The following 

list includes those most used and gives a brief overview of what they cover. For a 

full list of available guides, see the RAMM Software Limited web site Documentation 

page (http://www.cjntech.co.nz/index.php?section=55). 

 

Help from Other Users 

Other users can be a mine of information. 

If there are other users in your organisation, you should approach them if they 

perform the same tasks as you do or if they have been using  for longer 

than you. 

http://www.cjntech.co.nz/index.php?section=55
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They probably know shortcuts, tips and tricks which they can teach you. Don't 

reinvent the wheel. Talk to someone who knows more than you. 

 

 

 

RAMM Database Details 

When you begin to carry out more complex tasks, you will need to know where 

specific details are stored in the  database. These details are available in the 

Database Structure report. 

The Database Structure report is a listing of all tables and columns in the  

database. It is available from the  main menu. You follow the 

menu path Reports > Database Structure.  
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You then choose the tables you wish to view and then press Preview or Print to view 

or print the report. 

 

 

 

Contact RAMM Software Limited 

Internet 

This is the link to open the RAMM Software Limited web site 

(http://www.ramm.co.nz). 

Email 

This is the link to send an email to  Support 

(mailto:support@ramm.co.nz). 

This is the link to send an email to  Documentation 

(mailto:documentation@ramm.co.nz). 

Phone 

+ 64 9 475 0500 

0800 256 832 from within New Zealand only 

1800 196 213 from within Australia only 

http://www.ramm.co.nz/
mailto:support@ramm.co.nz
mailto:documentation@ramm.co.nz
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Fax 

+ 64 9 475 0501 

Postal Address 

PO Box 302 278 

North Harbour 

Auckland 0751 

New Zealand 

Physical Address 

102 Rosedale Road 

Albany 

Auckland 

New Zealand 

 

Comments and Suggestions 

If you have any feedback about this document or about the software itself, please 

contact RAMM Software Limited at whichever address above is convenient to you. 

Your observations and suggestions are welcome. Your feedback is an important 

element in improving and updating the  experience. 
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There are many compelling reasons to ensure that you have the most accurate 

Estimates of traffic volumes for your Roads. Traffic data is used for funding issues, 

traffic management, network planning and cost effectiveness. 

In  Th is  Chap ter  

Funding ....................................................................................... 32 

Traffic Management .................................................................... 32 

Planning ....................................................................................... 32 

Cost Effectiveness ....................................................................... 32 

 

 

 

Why Optimise Traffic Data in RAMM? 
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Funding 

One of the factors which funding agencies use to grant funds is traffic volume. In 

general terms, the greater the traffic volumes on your Network of Roads, the 

greater your share of the available funds will be. 

Funding agencies have auditors to check the accuracy of the information provided 

to support funding applications. The  Traffic Count Estimation model is 

particularly robust when correctly implemented. 

 

Traffic Management 

You will want to ensure that your traffic management resources are directed to 

those areas of your Network of Roads with the greatest traffic volumes. The 

 Traffic Count Estimation model is gives particularly accurate Estimates of 

traffic volumes when correctly implemented. This enables you to identify the high 

volume areas and to prioritise your traffic management resources. 

 

Planning 

When making decisions concerning intersection controls and Traffic Management 

Plans for Road works and other traffic disruptions, the level of planning and 

control will vary dependent on the traffic volumes. More accurate traffic Estimates 

allow you to plan with confidence. 

 

Cost Effectiveness 

You will have a budget for counting traffic volumes on your Network of Roads. 

The  Traffic Count Estimation model, when correctly implemented, has the 

potential to maximise the outcomes from your traffic counting budget. You may 

require fewer actual Traffic Counts. The greater likelihood is that rather than reduce 

the amount you spend on counting traffic volumes, you will be able to schedule 

the Traffic Counts for greater cost effectiveness. 
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 uses the Traffic Link model in which Traffic Counts at one Location are 

automatically linked to other Locations. This increases the coverage of the Traffic 

Count programme. Count values are adjusted using Correction Factors. 

In the graphic below the Main St Carriageway Sections link together to form a 

Traffic Link. The Side St Traffic Link is associated with the Main St Traffic Link. Its ADT is 

defined as ten per cent of Main St's. Short St Traffic Link is associated with Side St Traffic 

Link and its ADT is five per cent of Side St's. 

So if a Count taken at the Count Site on Main St results in an ADT of one thousand 

then, subject to Correction Factors, Side St will have an ADT of one hundred (ten 

per cent of one thousand) and Short St will have an ADT of five (five per cent of 

one hundred). 

 

 

In  Th is  Chap ter  

Traffic Counts and Traffic Links ................................................ 34 

Count Sites and the Counting Programme ................................ 35 

How Does Traffic Count Estimation Work? 



 

3 4  T r a f f i c  C o u n t  E s t i m a t i o n  
 

 
 

Traffic Counts and Traffic Links 

Traffic Counts are taken at a point Location. These Locations are recorded in the 

 databases and are referenced in terms of: 

• the Road identification and  

• a displacement in metres from the start of that Road to the Location at which the 

Traffic Count was undertaken. 

The Traffic Count is converted to an Average Daily Traffic (ADT) value. This is the 

value which is entered into  in the ADT field in the Count section of the 

Detail tab on the Traffic and Loading screen. 

 

 

The ADT value on the Carriageway Section that has been counted can then be 

used to update the ADT Estimates on any adjacent Carriageway Sections which 

carry the same or similar traffic volumes. This is achieved by linking the 

Carriageway Sections. 

The linked Carriageway Sections are called Traffic Links. 

Traffic Links 

The Traffic Link model allows aggregation of adjacent  Carriageway Sections 

that carry essentially the same traffic. This approach has two significant benefits: 

• it maximises the Network coverage of the count programme, particularly if it can be 

automated 

• it reduces the size of the sampling framework. 

A Traffic Count undertaken at any Location on a Traffic Link is then used to derive the 

Estimated ADT for all  Carriageway Sections that form the Traffic Link. In 

addition it is also possible to relate one Traffic Link to another. For example it is 

possible to specify that the ADT on link A will always be 10% of that recorded on 

link B.  In this way it is only necessary to undertake Traffic Counts on link B. 
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Count Sites and the Counting Programme 

Once you have created your Traffic Links you then create a Network of Count Sites, 

taking into account that you need to count an entire Traffic Link only once as the 

count applies to the entire length of the Traffic Link and any associated with it. 

You select the initial Count Sites using the Locations where existing counts were 

taken as well as sites recommended by . See Generating Recommended 

Count Sites (on page 104) and Saving Recommended Count Sites (on page 107). 

Traffic Count Programme 

Best practice is to count traffic on all Count Sites every year. So you would place all 

Count Sites in the Core Monitoring – Annual Group 1 Sample Group. However, budget and 

time constraints may prevent the taking of Traffic Counts on every Count Site every 

year. If so, you optimise the Traffic Count programme by grouping Count Sites based 

on how often they should ideally be counted. See Select Sites and Develop a 

Programme (on page 131). 

There are nine Sample Groups in . They are: 

• Core Monitoring – Annual Group 1 

These sites are the most important and are counted every year 

• Biannual Group 2 

These are the second most important and are counted every alternate year when 

Biannual Group 3 is not being counted 

• Biannual Group 3 

These are the second most important and are counted every alternate year when 

Biannual Group 2 is not being counted 

• Five Yearly - Year 1 

These are less important and are counted in the first year of a five year sequence 

• Five Yearly - Year 2 

These are less important and are counted in the second year of a five year sequence 

• Five Yearly - Year 3 

These are less important and are counted in the third year of a five year sequence 

• Five Yearly - Year 4 

These are less important and are counted in the fourth year of a five year sequence 

• Five Yearly - Year 5 

These are less important and are counted in the fifth year of a five year sequence 

• Ad Hoc 

These are all the other sites which are available should extra counts be required 

The creation of Traffic Links means that selecting Count Sites and developing a new 

more efficient traffic counting programme is made simpler. 
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The Annual Average Daily Traffic (AADT) is a figure to describe traffic levels for 

the length of a Network. It is used in many ways throughout  and by the 

regulatory authorities. Potentially, it could be used to determine whether Speed 

Limit Signs were required. For instance, if the AADT Estimate for a Road did not 

exceed 500 vehicles per day, a Sign could be required on the left hand side. If it 

were greater than 500, a Sign on the right hand side or in the centre could also be 

required. 

This figure is calculated from the Average Daily Traffic (ADT) value. 

ADT, is a measure used primarily in transportation planning and transportation 

engineering. It is the total volume of vehicle traffic of a Highway or Road for a 

year divided by 365 days. ADT is a useful and simple measurement of how busy 

the Road is. It is also sometimes reported as Average Annual Daily Traffic. 

 

 

In  Th is  Chap ter  

ADT Estimate Calculation .......................................................... 38 

ADT Calculation Factors ............................................................ 40 

ADT and AADT in RAMM 
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AADT Calculation ...................................................................... 41 

 
 

ADT Estimate Calculation 

The Average Daily Traffic (ADT) value is critical to the Traffic Count Estimation 

process. 

You calculate the ADT from the counts you have taken. For instance, if the result 

of a seven day Traffic Count were 7,000 vehicles, then you would calculate the ADT 

as 1,000. 

General Section of the Traffic Screen 

You then enter the value in the ADT field in the General section of the Traffic and 

Loading screen as below. 

 converts ADT count values into ADT Estimates by taking into account the 

Duration, Time of Day, Week Number, Season, the Day of the Week and the Growth Profile 

of the Count Site. 

It does this when you run the Status Check process. See Update Traffic Counts and 

Estimates (on page 230). 

 

 

General Tab of the Traffic Link Screen 

So, the ADT value of 21,622 which you calculated and entered in the Traffic and 

Loading screen above becomes an ADT Estimate. 

This has the value of 22,806 in the examples below. 

One place this becomes available is at the General tab of the Traffic Link screen, as 

below after you have run the Status Check. 
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The Traffic Link Tab of the Carriageway Screen 

The ADT value of 21,622 also becomes an ADT Estimate value of 22,806 at the 

Traffic Link tab of the Carriageway screen as below, after you have run the Status 

Check. 

 

 

The Summary Tab of the Carriageway Screen 

The ADT value of 21,622 is recorded at the Count field along with the date of the 

Latest Count. 

This will remain until another Traffic Count is taken on the Carriageway Section. 

The ADT Estimate value of 22,806 is recorded at the Estimate field along with the 

date on which the Status Check was most recently run to produce this Latest 

Estimate. 

These values are on the Summary tab of the Carriageway screen as below, after you 

have run the Status Check. 

 

 

 

 

 determines the traffic growth on a daily basis. 

This means that your ADT Estimate can be different from the 

actual count even though they are determined in the same year. 

There is an example of this in the graphic above where the dates 

of the Count and Estimate are one month apart. 
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ADT Calculation Factors 

The Average Daily Traffic (ADT) Estimate is used within . The method 

for calculating the Traffic ADT Estimate for Carriageway Sections is designed to 

derive values from the actual count data. 

ADT Estimate 

Firstly, an ADT Estimate is calculated based on the most recent actual count 

within the Traffic Link or an associated Traffic Link. 

Part Day Count Calculation 

If the actual count which has taken place was for only part of a day this would have 

been for a three hour period either in the morning or the afternoon.  When 

dealing with a Part Day count, the ADT Estimate for the Traffic Link will be calculated 

as follows. 

ADT = Traffic x Part Day x Week Day x Week Number x Region x Season Profile 

x Traffic Growth 

Full Day Counts 

If the actual count has been for the full day, then the ADT Estimate for the Traffic 

Link will be calculated as follows. 

ADT = Traffic x Week Day x Week Number x Region x Season Profile x Traffic 

Growth 

Full Week Counts 

If the actual count has been for a full week, then the ADT Estimate for the Traffic 

Link will be calculated as follows. 

ADT = Traffic x Week Number x Region x Season Profile x Traffic Growth 

Traffic Growth 

You will see that the formulae above use a Traffic Growth Factor. This is required 

when the latest actual count is not current. In order to get an ADT Estimate any 

growth in Traffic volumes since the date of the count must be taken into account. 
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Traffic Links are associated with a Growth Group and so in order to calculate the 

Traffic Growth for a given Count Site  looks at the previous count history at 

all Count Sites within the same Growth Group. Looking at all the counts over time at 

each site  works out the Traffic Growth for each consecutive pair of actual 

Counts using the following calculation. 

% Growth = ((Count - Previous Count) / Previous Count) / No of Days between 

Counts 

This calculation is repeated for each consecutive pair of counts within a Count Site 

and again for each Count Site. The actual Traffic Growth that is an average of each 

of these calculated figures.  The average Traffic Growth can then be applied to 

ADT calculated using one of the above methods. 

Multiple Traffic Count Sites 

If more than one Count Site is associated with a Traffic Link then  will go 

through the appropriate processes in order to calculate an ADT Estimate from 

each. These values will them be averaged in order to get one value for the Traffic 

Link. 

 

AADT Calculation 

The Annual Average Daily Traffic (AADT) value is not stored anywhere in 

. It is calculated when it is required. It is used in the Network VKT 

calculation. 

Vehicle Kilometres Travelled (VKT) is the total kilometres travelled by motor 

vehicles on a Road Network during a given period of time. VKT is an important 

variable in the analysis of traffic density, highway safety and other areas. VKT can 

equally be applied to Traffic Links. However, VKT for Traffic Links is not explicitly 

recorded in .  

AADT = ADT Estimate x 365 

VKT = (AADT x Carriageway length in metres) / 1,000 
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There are two issues that directly impact on the accuracy and currency of the ADT 

Estimate recorded in .  You should keep these in mind when 

implementing  Traffic Count Estimation. They are: 

1 is the traffic being counted at the right Location 

2 is the process of converting Traffic Counts to ADT Estimates robust? 

In order to ensure that the best possible Estimates of ADT are available for each 

counted site, each Traffic Link is allocated a Road Type and a Traffic Growth Group. The 

Road Types have factors to correct for the time of day, day of the week, week of the 

year, Region and Season Profile. A Traffic Growth Group is a group of Traffic Links that 

are believed to have approximately the same level of traffic growth from year to 

year.  averages the actual Traffic Counts for Count Sites on Traffic Links in the 

Traffic Growth Group and uses the results when updating ADT Estimates. 

Each Count Site is allocated to a Sample Group to determine how often a Traffic Count 

should occur at the site. 

These groups allow  to automatically adjust a traffic survey to reflect the 

expected seasonal variation in traffic. They provide a means of automatically 

updating Estimates to a particular date. 

In  Th is  Chap ter  

Select Count Sites ....................................................................... 44 

Season Profiles for Road Types .................................................. 45 

Road Type Selection Process ...................................................... 47 

Traffic Growth Groups ............................................................... 48 

Other Factors .............................................................................. 49 

 
 

Improve the Accuracy of ADT Estimates 
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Select Count Sites 

Traffic Counts are undertaken at a specific Location. It should be a Location that is 

representative of the Traffic Link as a whole. 

It is not possible to assess how representative the traffic volume recorded at the 

Traffic Counts is. There is considerable potential for the practical aspects of traffic 

counting to introduce significant bias. 

 

 

To help address this issue  identifies the historical traffic counting sites on a 

particular Traffic Link and, if there are no sites, will recommend a possible Location. 

This is only an indicative recommendation based on a simple random distribution 

of Locations along uncounted links. The purpose of this tool is to provide a first 

cut of Locations that will assist in reducing systematic bias. 

 

 

It is important to note that the recommendations take no account 

of the actual conditions on the link. There is no specific 

requirement to adopt the recommended Location for a new Count 

Site.  

 

Where there have been multiple Traffic Counts on a Traffic Link, or where for some 

other purpose, such as monitoring a screen-line, there is a desire to undertake 

multiple Traffic Counts on a Traffic Link, the ADT Estimation route will use all 

seasonally adjusted counts on that link to establish the ADT Estimate. 
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Season Profiles for Road Types 

Traffic volumes on particular Traffic Links vary throughout the year. This seasonal 

variation depends on the function of the Traffic Link. For example, a Road to a 

popular beach is likely to be used more in the summer months than in the winter. 

Conversely a Road servicing an industrial area will typically carry less traffic during 

the weekend and over the Christmas to New Year period. So the traffic counted in 

a particular week may not accurately represent the Average Daily Traffic (ADT). 

An analysis of the seasonal variation in traffic volumes for different Roads suggests 

that there are at least seven very different Season Profiles. These typical profiles 

provide seasonal adjustment factors that can be applied to the Traffic Count 

undertaken in a particular week to provide a better Estimate of the ADT. Selection 

of the most appropriate profile for a particular Traffic Link should be based on a 

comparison of the predefined Season Profiles and the actual seasonal profile of the 

Traffic Link. You should use the Road Type selection process flow diagram to assist in 

making this decision. See Road Type Selection Process (on page 47). However, 

when using this diagram, it is important to remember that the questions and 

answers relate to the Season Profile of the traffic on the Road, not to the type of 

Road or its allocation in a Road hierarchy. 

Associate Profiles with Traffic Links 

Each Traffic Link should be associated with one of the profiles shown in the graphics 

below.  

Urban Profiles 
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Rural and Recreational Profiles 

 

 

The Season Profile is used to seasonally adjust the Traffic Counts undertaken at the 

Count Site to provide a more reliable Estimate of ADT. Traffic Count values will 

automatically be multiplied by an adjustment factor to produce a seasonally 

adjusted Estimate of ADT. 

The adjustment varies from those recorded in the graphic above, depending on the 

region of the RCA and the AADT Estimate for the site - Low, Medium, or High. An 

AADT Estimate is chosen for each Traffic Link at the link model stage. See Correction 

Factors Screen (on page 212). 

The typical Season Profiles are already in  but it is possible to create your 

own, if you have sufficient data. You associate a Season Profile Road Type for each 

Traffic Link based on your Network knowledge. Seven different types of Season 

Profile have been defined. Each has been associated with a Road Type: 

• Urban Commuter 

• Urban Commercial 

• Urban Industrial 

• Rural/Urban Fringe 

• Rural 

• Summer Recreational 

• Winter Recreational. 

 

 

You should be aware that it is the expected shape of the Season 

Profile that is important, not the name it has been given. 
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Road Type Selection Process 

Use the following flowchart when you are deciding the correct Road Type for a 

Traffic Link. 
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Traffic Growth Groups 

One aspect of the Average Daily Traffic (ADT) Estimates process which you may 

consider for improvement is the regular updating of the Estimates. In many 

instances prior to the introduction of  Traffic Count Estimation, count data has 

been added to the database but the Estimates have not been updated. 

 

 

Not updating the ADT Estimates can pose problems if you use 

software such as dTIMS which uses the Estimates not the counts. 

Traffic Count Estimation uses Growth Groups to solve this issue. 

 

Each Traffic Link is allocated to a Traffic Growth Group. This is a group of Traffic Links 

that are believed to have approximately the same level of traffic growth from year 

to year. 

This allows a previous ADT Estimate at a site that has not been counted in the 

current year to be updated using the average traffic growth recorded at other 

similar sites that have been counted. The same mechanism ensures that all 

Estimates are updated to the current date. 

 

 

When calculating the traffic growth for a Traffic Growth Group,  

finds all the actual Traffic Counts for Count Sites on Traffic Links in the 

Traffic Growth Group. It then averages the growth factors for all these 

Traffic Counts except that it ignores any which are greater than one 

and one half standard deviations above or below the mean growth 

for the group. 

 

This feature is particularly important in situations where the Rotational Sample is 

monitored over a two year period, but will be of general use when seeking to keep 

all ADT Estimates up to date. 

 A single default Traffic Growth Group is entered for each Traffic Link when you create 

the Traffic Links. You can update this value later. Best practice is to update the 

Growth Group values when associating the Traffic Links. See Updating Count Site 

Sample Group Values (on page 122). 

 



 

 C h a p t e r  6   –   I m p r o v e  t h e  A c c u r a c y  o f  A D T  E s t i m a t e s  4 9   

Other Factors 

As well as the Season Profiles and Growth Groups, there are other factors taken into 

account when  generates the ADT Estimates during Status Check. They 

are: 

• Part Day Factors 

Some Traffic Counts are for only part of a day.  can accept data from three hour 

counts and uses different factors for the morning and the afternoon.  

See Part Day Factors (on page 213). 

• Week Day Factors 

Estimates generated by  on the basis of a Traffic Count of 3 Hour or 24 Hour 

duration will differ dependent on the day of the week on which they were performed. 

So  Traffic Count Estimation uses different factors in calculations to take this into 

account. 

See Week Day Factors (on page 214). 

• Week Number Factors 

Estimates generated by  on the basis of a Traffic Count of 3 Hour, 24 Hour or 7 

Day duration will differ dependent on the week of the year in which they were 

performed. So  Traffic Count Estimation uses different factors in calculations to 

take this into account. 

See Week Number Factors (on page 215). 

• Region Factors 

Estimates generated by  on the basis of a Traffic Count will differ dependent on 

the Region in which they were performed. So  Traffic Count Estimation uses 

different factors in calculations to take this into account. 

See Region Factors (on page 216). 
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There is a process to follow in order to set up  Traffic Count Estimation. You 

must: 

• turn on Traffic Management 

• set initial Traffic Count Estimation parameters 

• fix your existing traffic data 

• create Traffic Links 

• create Count Sites 

• associate the Traffic Links with each other 

• update the Traffic Count and Estimate data 

• schedule your Traffic Count programme 

• create your Traffic Count dispatches. 

The process is detailed further below in the Traffic Count Estimation Set Up Process. 

 

 

Best practice is to set up Traffic Count Estimation from the Map within 

. If you are not familiar with the Map you should read the 

Mapping chapter of the Using RAMM guide. 

You may also find it useful to read the chapter in this guide which 

reveals the Map functions which relate to Traffic Count Estimation. See 

Traffic Count Estimation and the Map (on page 175). 

 

In  Th is  Chap ter  

Traffic Count Estimation Set Up Process .................................. 52 

 
 

Traffic Count Estimation Set Up 
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Traffic Count Estimation Set Up Process 

You follow the steps in the order as below. This is ensure that all the prerequisites 

for each individual procedure have been carried out before you attempt it. 

Follow these steps to set up  Traffic Count Estimation for your database. 

Step Action Comments 

 

Run Status Check to update 

Latest Counts and Estimates. 

Prior to activating Traffic Count Estimation you should 

run the Status Check. Select the Set most recent flags 

for Traffic and Loading Data option. Then when you 

are setting up Traffic Links and other items you will 

be using the most up-to-date ADT Estimate data. 

You run Status Check in  at the 

Status Check screen. 

See Update Traffic Counts and Estimates (on page 

230). 

 

Activate Traffic Count 

Estimation. 

You can implement Traffic Count Estimation only after 

it has been Activated. Activation makes all the 

required functions and processes available in 

,  and 

. You turn on the processes 

you require. 

You Activate Traffic Count Estimation at the Processes 

tab of the Parameter screen. 

See Activating Traffic Counting Processes (on page 

61). 

 

Set initial Traffic Count 

Estimation parameters. 

You set initial parameters so that Traffic Count 

Estimation is implemented to match your 

circumstances. First you select your Region and Road 

Council. Next you define the number of years of your 

most recent Count data you want to be taken into 

account when setting up  Traffic Count 

Estimation. The major decision you take is to 

determine the percentage of your Network VKT that 

you want to count. 

You do this in  at the Traffic 

Counting tab of the Parameter screen. 

See Setting Traffic Counting Parameters (on page 

67). 
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Step Action Comments 

 

Fix your legacy data. Some traffic records which existed prior to the set up 

and use of  Traffic Count Estimation will be 

missing the data required to enable it to work 

properly. 

You do this in  at the Filter Road Details - 

Traffic dialog. 

See Fixing Missing Count Duration Data in Bulk (on 

page 76). 

 

Generate Recommended 

Traffic Links. 

You can manually create your own Traffic Links for 

your database. However, it is more efficient to accept 

the  Recommended Traffic Links which are 

contiguous Carriageway Sections from the same 

Road that have the same Average Daily Traffic 

(ADT) Estimate value, plus or minus 10%. 

You do this in  at the Map. 

See Generating Recommended Traffic Links (on page 

87). 

 

Save the Recommended 

Traffic Links. 

Once you have created the Recommended Traffic 

Links, you group and then save them. Each Traffic 

Link must have a Road Type, a Traffic Growth Group 

and an AADT Band. So you are best to group all 

Roads with matching parameters and save them in 

bulk. 

You address this in  at the Recommended 

Traffic Links screen. 

See Saving Recommended Traffic Links (on page 90). 

 

Generate Recommended 

Count Sites. 

You create Count Sites so that Traffic Counts can best 

be positioned and scheduled. You could manually 

create Count Sites for your database. However, it is 

more efficient to accept the  Recommended 

Count Sites. These are based on historical counts or a 

random Location on Traffic Links which have never 

been counted. 

You do this in  at the Map. 

See Generating Recommended Count Sites (on page 

104). 
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Step Action Comments 

 

Save the Recommended 

Count Sites. 

Once you have created the Recommended Count 

Sites, you select those which represent the value you 

set at the Network Coverage  % of VKT field at the 

Parameter screen in .  

highlights these for you. You then save them to 

create Count Sites so that you can schedule Traffic 

Counts for the most important Roads in your 

Network. 

You do this in  at the Recommended Count 

Sites screen. 

See Saving Recommended Count Sites (on page 107). 

 

Associate Traffic Links. When you have defined your Traffic Links on which 

you want to count traffic and the Count Sites where 

you want to perform the Traffic Counts you can then 

relate subsidiary, or secondary, Traffic Links to the 

traffic-contributing, or primary, Traffic Link. 

You do this in  at the Map. 

See Associating Traffic Links (on page 119). 

 

Update Count Site Sample 

Group values. 

The logical and efficient time to decide to which 

Sample Group Count Sites should belong, is when 

you are relating Traffic Links at the Map. That is why 

when you created your Count Sites you gave them all 

a default value at the Sample Group field. 

You do this in  at the Map. 

See Updating Count Site Sample Group Values (on 

page 122). 

 

Locate and fix any unlinked 

Carriageway Sections. 

It is possible that some Carriageway Sections will not 

have been associated with a Traffic Link. An Average 

Daily Traffic (ADT) Estimate value would not be 

calculated for these Carriageway Sections unless this 

is corrected. 

You find these unlinked Carriageways by running 

the Unlinked Carriageways report. You do this in 

 at the Map. 

See Unlinked Carriageways (on page 128). 

 

Update Traffic Count and 

Estimate Data 

You run a Status Check process to update the 

database to take into account any Traffic Counts and 

Estimates entered since the most recent Status 
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Step Action Comments 

Check. It then updates the ADT Estimates taking 

into account the new readings and the other factors. 

It also updates Loading data. 

You run Status Check in  at the Map. 

See Run Status Check (on page 129). 

 

Locate and fix Traffic Links 

with no ADT. 

Running Status Check outputs the Traffic Latest 

Errors report. You can easily identify Traffic Links 

with no ADT on the Map. 

You fix Traffic Links with no ADT in  at the 

Map. 

See Traffic Links with No Average ADT (on page 

129). 

 

Schedule Traffic Counts. Once the Traffic Count Estimation set up has been 

completed, you schedule the Traffic Counts. You do 

this based on the Sample Group of the Count Sites 

combined with the date of the most recent count 

entered into . When you have the list of 

Scheduled Traffic Counts, you can create Dispatches 

in  for a selected Contract. 

You carry out the Recommended Traffic Counts 

process in  at the Map. 

See Select Sites and Develop a Programme (on page 

131). 

 

Create Traffic Count 

Dispatches. 

When you have generated the scheduled Traffic 

Counts you can create Dispatches for them. These 

will be listed in . The 

Contractor who will perform the Traffic Counts can 

then see the future work load. 

You do this at the Create Dispatches screen in 

 or . 

See Traffic Count Dispatches (on page 153). 
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Before you create and associate Traffic Links and Count Sites you need to make 

decisions to ensure that the  processes are optimised for your particular 

circumstances. 

You do all this at the Parameter screen in . 

 

 

In  Th is  Chap ter  

Processes and Parameters Overview ........................................... 58 

Activate Traffic Counting Processes ........................................... 58 

Available Processes ...................................................................... 60 

Process Deactivation ................................................................... 60 

Activating Traffic Counting Processes ....................................... 61 

Traffic Counting Parameters ...................................................... 62 

Setting Traffic Counting Parameters .......................................... 67 

 
 

Initial Processes and Parameters 
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Processes and Parameters Overview 

You Activate  Traffic Count Estimation at the the Parameter screen in 

. Then you turn on your initial processes and define your initial 

parameters. 

Process Activation 

You can implement Traffic Count Estimation only after it has been Activated. 

Activation makes all the required functions and processes available in , 

 and . You turn on the processes 

you require. See Activating Traffic Counting Processes (on page 61). 

Initial Parameter Definition 

You set initial parameters so that Traffic Count Estimation is implemented to match 

your circumstances. First you select your Region and Road Council. Next you define 

the number of years of your most recent Count data you want to be taken into 

account when setting up  Traffic Count Estimation. The major decision you 

take is to determine the percentage of your Network VKT that you want to count. 

See Region (on page 63), Road Council (on page 64), Include Count Sites for (on 

page 64), and Network Coverage (on page 65). See Setting Traffic Counting 

Parameters (on page 67). 

Pavement Use ADT Range Options 

You also decide whether you want: 

•  to automatically update the Pavement Use ADT range value to match a Latest 

reading or 

• the opportunity to make the changes manually yourself. 

See Latest Traffic Estimate (on page 66). 

 

Activate Traffic Counting Processes 

 Traffic Count Estimation is not enabled by default. When you decide to 

institute the system in your database you first need to turn on the Traffic Count 

Estimation processes for your database type. 
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Off by Default - True 

In the graphic below you can see  Traffic Count Estimation is inactive (Off) by 

default. The Off option is selected (True). To use Traffic Count Estimation you need to 

deactivate this setting. You do this by Activating your Network type. 

 

 

Activate Traffic Counting 

You activate Traffic Count Estimation by selecting your Network type and following 

the menu path Actions > Active. In the graphic below the Network type is 

NZLocalAuthority. 

 

 

Other Processes 

There are a number of processes which are used during the Traffic Count Estimation 

set up process. When you activate Traffic Count Estimation at the Processes tab of the 

Parameter screen you will see a list of the Traffic Count Estimation processes available 

to you. These will vary depending on your Network type. 

At the time of writing, the ability to maintain Correction Factors is not available. This 

process may become available at a later date. 
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The TrafficLinkGeneration and CountSiteGeneration processes are always selected and 

cannot be cleared. They are only available when Traffic Count Estimation has been 

Activated for your Network type. 

 

 

Your Database Type determines the processes that you see. The 

graphic above displays the standard process set for NZLocalAuthority. 

 

 

Available Processes 

To see the functions which become available once you have activated the Traffic 

Count Estimation  processes see: 

• Traffic Count Estimation and  (on page 157) 

Best practice is to perform the majority of Traffic Count Estimation set up and 

maintenance activities in . 

• Traffic Count Estimation and the Map (on page 175) 

You use the Map in  to manage almost every aspect of Traffic Count Estimation. 

• Traffic Count Estimation and  (on page 209) 

Users who prefer to use screen-based processes can perform all the Traffic Count 

Estimation activities from within  rather than using the Map from 

within . 

• Traffic Count Estimation and  (on page 247) 

If you use  to manage your Network, you need to be 

aware that there are now some elements which take  Traffic Count Estimation 

into account. 

 

Process Deactivation 

If, after having set up  Traffic Count Estimation and created the Traffic Links, 

Count Sites and updated all your data, you deactivate Traffic Count Estimation, this will 

not affect the data in the database. It will remove the menu options, screens and 

tabs for  Traffic Count Estimation. 

You will then be unable to update your Traffic Count Estimation data. 

Any Traffic Counts you enter after you have deactivated your Traffic Count Estimation 

processes will not be adjusted by the Correction Factors. This is not recommended. 
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Activating Traffic Counting Processes 

Introduction 

You can implement Traffic Count Estimation only after it has been Activated. 

Activation makes all the required functions and processes available in , 

 and . You turn on the processes 

you require. 

Before you do this you need to have: 

• run a Status Check to ensure that the Latest Count data is up to date. You do this at the 

Status Check screen. See Update Traffic Counts and Estimates (on page 230). 

• the correct Staff Permissions. See Granting Staff Permission to Update the Parameter 

Screen (on page 285). 

• logged in to . 

Menu Path 

Follow the menu path Maintenance > Parameter > (press Processes) to open the 

Parameter screen at the Processes tab. 

►  Ac t i va t i ng  T ra f f i c  Coun t in g  Processe s  

 

 

To do this you follow these steps: 

1 Select your Database Type code in the Traffic Counting section of the Process Option 

Code panel. 

2 Press Actions. 

The Active button will appear. 
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3 Press Active. 

The Active value for your Network Type code will become True. The Active value for the 

Off code will become False. 

4 Press . 

Your changes will be saved and Traffic Count Estimation will be activated. 

 

 

5 Go to Setting Traffic Counting Parameters (on page 67). 

 

Traffic Counting Parameters 

Once you have Activated the Traffic Counting Processes, you must select and 

define the initial parameters before you can set up and use Traffic Count Estimation. 

You do this in  at the Traffic Counting tab on the Parameter screen. 
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Parameters 

You need to set the following Traffic Count Estimation parameters: 

• Region (on page 63) 

• Road Council (on page 64) 

• Include Count Sites for (on page 64) 

• Network Coverage (on page 65) 

• Latest Traffic Estimate (on page 66). 

 

Region 

Regions are used as a factor in determining ADT values. So you need to select the 

code for your Region for your ADT calculations to be correct. You select your 

Region code at the Region drop-down list at the Traffic Counting tab on the Parameter 

screen. 

 

 

Region Factors 

 You define Region Factor values at the Region tab of the Road Type and Multiplication 

Factors screen. See Region Factors (on page 216). 



 

6 4  T r a f f i c  C o u n t  E s t i m a t i o n  
 

 

 

 

 

Regions are added by RAMM Software Limited. Your Region code will be 

available by default. At the time of writing, all the Region Factor 

values have been set to 1. 

 
 

Road Council 

You need to select your Road Council code from the Road Council drop-down list at 

the Traffic Counting tab on the Parameter screen. 

 

 

 

Road Council codes are added by RAMM Software Limited. Road Councils 

are also referred to as RCAs (Road Controlling Authorities). 

 

 

Include Count Sites for 

Traffic Count Estimation uses historical counts when recommending Count Sites. You 

need to decide how many years' worth of historical counts  should take into 

account. 
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You select a number of years prior to which  will ignore Traffic Counts when 

recommending Count Sites. You do this at the Include Count Sites for field at the Traffic 

Counting tab on the Parameter screen. 

 

 

Which Date 

You might make this decision on the basis of when you introduced new traffic 

counting technology or practices which increased the accuracy of the Counts. 

 

 

Historical Counts require extra data added before Traffic Count 

Estimation can use them in its calculations. 

You should select an Include Count Sites for value to include only 

those historical counts for which you know the Count Duration and if 

necessary, Time of Day values. See Fixing Missing Count Duration 

Data in Bulk (on page 76). 

 
 

Network Coverage 

You define the percentage of your Network traffic which you want to count. You 

do this at the Network Coverage field at the Traffic Counting tab on the Parameter 

screen. 

Count Traffic on Only the Busiest Roads 

It is not necessary to count traffic on every Road in your Network. It is a most 

efficient use of resources to spend most of the traffic counting budget on those 

Roads which carry the most traffic. So you might make a decision that you are not 

interested in counting traffic on the Roads which carry the bottom twenty per cent 

of your Network Vehicle Kilometres Travelled (VKT). In this case you would set 

the Network Coverage % value to 80. 
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Then when you run the recommend Count Sites process,  will create 

recommended Count Sites for all Traffic Links but will group and highlight those 

which carry the percentage you have specified. 

See How  Recommends Count Sites (on page 102). 

 

Latest Traffic Estimate 

During the  Traffic Count Estimation set up process,  checks if the 

Pavement Use ADT range value matches the Latest reading. You set a parameter to 

determine whether  automatically updates the value or leaves it for you to 

check and to update the values yourself manually if appropriate. 

You do this in the Latest Traffic Estimate section on the Traffic Counting tab of the 

Parameter screen. You have the option of selecting: 

• Auto Update Pavement Use 

You select this option if you want  to automatically update the Pavement Use 

ADT range value to match a Latest reading 

• Check Pavement Use Match 

You select this option if you want  to automatically check whether the 

Pavement Use ADT range value matches a Latest reading. You can then run a report to 

find the discrepancies and update the values manually if appropriate. See Traffic Latest 

Errors Report (on page 297). 

 

 

 

Where is the ADT Range Displayed 

The ADT range for the Carriageway is displayed in the Pavement Use field in the 

Pavement section of the General tab of the Carriageway Detail screen. 
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Setting Traffic Counting Parameters 

Introduction 

You set initial parameters so that Traffic Count Estimation is implemented to match 

your circumstances. First you select your Region and Road Council. Next you define 

the number of years of your most recent Count data you want to be taken into 

account when setting up  Traffic Count Estimation. The major decision you 

take is to determine the percentage of your Network VKT that you want to count. 

Before you do this you need to have: 

• Activated Traffic Count Estimation. See Activating Traffic Counting Processes (on page 

61). 

• logged in to  

• been granted the correct Staff Permissions. You do this at the Staff Permissions screen 

in . See Data Maintenance Staff Permissions (on page 287). 

Menu Path 

Follow the menu path Maintenance > Parameter > (press Traffic Counting) to open the 

Parameter screen at the Traffic Counting tab. 

►  Se t t i ng  T ra f f i c  Coun t ing  Paramet ers  

 

 

To do this you follow these steps: 

1 Select the Region for your Network from the Region drop-down list. See Region (on 

page 63). 

2 Select the name of your Network from the Road Council drop-down list. See Road 

Council (on page 64). 
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3 Type, in the Include Count Sites for   years field, the number of years of historical data 

you wish  to take into account when recommending Count Sites. See Include 

Count Sites for (on page 64). 

 

 

Historical Counts require extra data added before Traffic Count 

Estimation can use them in its calculations. 

You should select an Include Count Sites for value to include only 

those historical counts for which you know the Count Duration and if 

necessary, Time of Day values. See Fixing Missing Count Duration 

Data in Bulk (on page 76). 

4 Type in the Network Coverage  % field the percentage of your Network Vehicle 

Kilometres Travelled (VKT) for which you want  to highlight recommended 

Count Sites. See Network Coverage (on page 65). See View a List of Recommended 

Count Sites (on page 97). 

5 Do you want  to automatically update the Pavement Use ADT range value to 

match a Latest reading? See Latest Traffic Estimate (on page 66). 

Yes then go to step 6. 

No then go to step 8. 

6 Select the Auto update pavement use option. 

7 Go to step 9. 

8 Select the Check pavement use match option. 

 will now automatically check whether the Pavement Use ADT range value 

matches a Latest reading. You can then run a report to find the discrepancies and 

update the values manually if appropriate. 

9 Press . 

Your changes will be saved and Traffic Count Estimation parameters have been set. 

10 Close the screen in the normal manner. 

You will be returned to the RAMM Manager main screen. 
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Some traffic records which existed prior to the set up and use of  Traffic 

Count Estimation will be missing the data required to enable it to work properly. 

It is important that your existing data is compatible with  Traffic Count 

Estimation before you set up Traffic Count Estimation in your database. However, as the 

data fields are not available unless Traffic Management has been Activated for your 

Network Type, you cannot fix the data until it has been turned on. See Initial 

Processes and Parameters (on page 57). 

State Highway Databases 

If your database is for State Highways only, you can ignore this chapter as your 

legacy data will not be missing data. 

 

 

Count data for State Highway databases do not require correction 

as traffic is counted for 365 days a year on State Highways. So for 

State Highway databases, the Correction Factor process is not 

turned off but all the Correction Factors are set to 1. 

 

In  Th is  Chap ter  

Count Duration Data .................................................................. 70 

Time of Day Data ........................................................................ 72 

Sample Group Data ..................................................................... 74 

Fixing Missing Count Duration Data in Bulk ............................ 76 

 

 

 

Legacy Data 
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Count Duration Data 

 Traffic Count Estimation uses criteria including the duration of the Traffic Count 

to fine tune Average Daily Traffic (ADT) Estimates. The accuracy of a Traffic Count 

is affected by its duration. The longer the duration of the count, the more accurate 

it is. There are three standard Count Durations in  being 3 hours, 24 Hours and 7 

Days. 

If your legacy data does not include Count Duration information, you need to add it. 

 

 

Identify Records with Missing Data 

If you prefer using  to manipulate your data you use the Missing 

Data report to identify the records which need to be updated. See Missing Data 

Report (on page 295). 

If you prefer to use the Map, you follow the menu path View > Missing Data > Latest 

Traffic Counts > Count Duration. 

 

 

The Traffic Counts which have no Count Duration values will display on the Map. 



 

 C h a p t e r  9   –   L e g a c y  D a t a  7 1   

 

 

Fix the Data 

You select the Traffic Count you want to edit, right-click and select Show Traffic Count 

Detail. The Traffic and Loading Detail screen will open at the Count tab. 

 

 

 

 

When you right-click on the icon for the missing Count data, you 

may be offered the Show Traffic Link Detail option instead of the Show 

Traffic Count Detail option. You fix this by opening the Map Legend and 

toggling the Traffic Link visibility so that Traffic Links do not display.  

You then press Update Record  to make the fields available. You can then select 3 

Hours, 24 Hours or 7 Days from the Count Duration drop-down list. 
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If you selected 3 Hours you then need to select a Time of Day value. 

 

Time of Day Data 

 Traffic Count Estimation uses criteria including the time of day of the Traffic 

Count to fine tune Average Daily Traffic (ADT) Estimates. The time of day affects 

the volume of traffic which will travel along a Road. Traffic Counts taken in the 

morning are likely to vary from those taken in the afternoon.  Traffic Count 

Estimation uses a Time of Day factor to account for this when a Traffic Count is taken, 

unless it is for 24 hours or for 7 days. 

If your legacy data does not include Time of Day information for Traffic Counts with a 

Count Duration value of 3 Hours, you need to add it. 

 

 

Identify Records with Missing Data 

If you prefer using  to manipulate your data you use the Missing 

Data report to identify the records which need to be updated. See Missing Data 

Report (on page 295). 

If you prefer to use the Map, you follow the menu path View > Missing Data > Latest 

Traffic Counts > Time of Day.  

 

 

The Traffic Counts which have no Time of Day values will display on the Map. 



 

 C h a p t e r  9   –   L e g a c y  D a t a  7 3   

 

 

Fix the Data 

You select the Traffic Count you want to edit, right-click and select Show Traffic Count 

Detail. The Traffic and Loading Detail screen will open. 

 

 

 

 

When you right-click on the icon for the missing Count data, you 

may be offered the Show Traffic Link Detail option instead of the Show 

Traffic Count Detail option. You fix this by opening the Map Legend and 

toggling the Traffic Link visibility so that Traffic Links do not display.  

You then press Update Record  to make the fields available. You can then select 

Morning or Afternoon from the Time of Day drop-down list. 
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Sample Group Data 

Sample Groups group Count Sites with the same count frequency. You count traffic 

on high volume Roads more often than on low traffic volume Roads. So you 

assign a Sample Group to each Count Site based on how often it needs to be counted, 

whether this is every year, every second year or once every five years. 

 Traffic Count Estimation uses the Sample Group of a Count Site to schedule Traffic 

Counts. If your legacy data does not include Sample Group values, you need to add 

them. 

 

 

Identify Records with Missing Data 

If you prefer using  to manipulate your data you use the Missing 

Data report to identify the records which need to be updated. See Missing Data 

Report (on page 295). 

If you prefer to use the Map, you follow the menu path View > Missing Data > Count 

Sites > Sample Group.  
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The Count Sites which have no Sample Group values will display on the Map. 

 

 

Count Sites do not exist before Traffic Management Mode has been 

turned on. So under normal circumstances there will be no legacy 

Count Sites. If you have added Count Site records using  it 

is possible to create them without Sample Group values. These are 

the only records which would display. 

 

 

Fix the Data 

You select the Traffic Count you want to edit, right-click and select Show Count Site 

Detail. The Count Site Detail screen will open. 

 

 

You then press Update Record  to make the fields available. You can then select 

the appropriate value from the Sample Group drop-down list. 
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Fixing Missing Count Duration Data in Bulk 

Introduction 

 Traffic Count Estimation uses criteria including the duration of the Traffic Count 

to fine tune Average Daily Traffic (ADT) Estimates. Some traffic records which 

existed prior to the set up and use of  Traffic Count Estimation will be missing 

the data required to enable it to work properly. If your legacy data does not include 

Count Duration information, you need to add it. 

The most efficient method of adding data in  is the Bulk Update. So you 

can set a filter to list all Counts with the same Count Duration for the period set at 

the Parameter screen in . 

Before you do this you need to have: 

• set initial Traffic Count Estimation parameters. You do this at the Traffic Counting tab of 

the Parameter screen in . See Setting Traffic Counting Parameters 

(on page 67). 

• been granted the correct Staff Permissions. You do this at the Staff Permissions screen 

in . See Data Maintenance Staff Permissions (on page 287). 

• logged in to . 

Menu Path 

Follow the menu path (press Show Traffic and Loading) > (press Edit Filter) to open the 

Filter Road Details - Traffic and Loading Filter screen. 

►  F i x ing  M iss ing  Coun t  Dura t i on  Da ta  i n  Bu lk  

 

 

To do this you follow these steps: 
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1 Clear the Latest and Not Latest check boxes. When  recommends Count Sites it 

will look at all count records in the period you defined at the Traffic Counting tab of the 

Parameter screen in . See Traffic Counting Parameters (on page 

62). 

2 Select Count Date in the Fields panel. 

3 Press the By Range tab. 

4 Select, from the Range Start drop-down calendar, the date which aligns with the value 

you set in the Include Count Sites for   years field on the Parameter screen in 

. 

5 Select today's date at the Range End drop-down calendar. 

6  What you do next depends on your records and your data. If all your Counts were for 

a set duration, you do not need to filter further. Otherwise you need to set the filter to 

group those Counts which you know had the same Count Duration. 

7 Press . 

The Confirm Filter Option dialog will open. 

 

 

8 Select the All Roads in Entire Network option. 

9 Press . 

The Confirm Filter dialog will close and you will be returned to the Traffic and Loading 

Grid screen with the count records listed. 

10 Are the Count Duration and Time of Day columns available? 

Yes then go to step 14. 

No then go to step 11. 

11 Press the Panel Sizer. 

The Layout panel will open. 

 

12  Select the Time of Day and Count Duration Descriptions. 

13 Press the Panel Sizer. 

The Layout panel will close and the Time of Day and Count Duration columns will 

appear on the Traffic Grid screen. 
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14 Follow the menu path Actions > Bulk Update. 

The Bulk Update screen will open. 

15 Make your selections. 

16 Press . 

Your changes will be saved. 

17 Close the screen in the normal manner. 

You will be returned to the RAMM main screen. 

 

 

All clients will have a different set of legacy count records and will 

have different methods of identifying records with identical Count 

Durations. So a one-size-fits-all filter cannot be described here. 

All clients will at least want to filter for all Counts during the time 

period  has been set to consider when recommending Count 

Sites, not just Latest Counts. 
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Traffic Links are combinations of sequential  Carriageway Sections that are 

considered to carry the same volume of traffic over the entire length of the link. 

Once you have set the initial Traffic Count Estimation parameters and fixed your 

legacy data, you can create Traffic Links in your  database.  

You can manually create your own Traffic Links for your database. However, it is 

more efficient to accept the  Recommended Traffic Links which are 

contiguous Carriageway Sections from the same Road that have the same Average 

Daily Traffic (ADT) Estimate value, plus or minus 10%. 

You can accept these recommendations in bulk and fine tune the results later. 

 

In  Th is  Chap ter  

View Recommended Traffic Links on the Map ......................... 80 

Select Recommended Traffic Links ............................................ 83 

Generating Recommended Traffic Links ................................... 87 

Saving Recommended Traffic Links........................................... 90 

 
 

Traffic Link Creation 
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View Recommended Traffic Links on the Map 

 can recommend Traffic Links for you to create for Traffic Count Estimation. You 

can choose to accept them all in bulk or to accept them in groups, such as by 

suburb. 

Best practice is for you accept in bulk the Traffic Links recommended by  and 

to fine tune them later. 

You can carry out the Recommended Traffic Links process in  or 

in  using the Map. For more information on the process in 

 see Recommend Traffic Links (on page 223). 

The Map in RAMM 

To view the recommended Traffic Links on the Map, you: 

• press  to open the Map in  

• then press  to turn on Traffic Management Mode. This makes the required tool 

bars and buttons available.  

• then press  to make the Traffic Management information display on the Map. 

Recommended Traffic Links 

You follow the menu path View > Recommended Traffic Links to start the process to 

generate a Layer on the Map of Traffic Links recommended by . A screen will 

open asking if you want to run the Recommend Traffic Links for all Roads. 

Initially you would opt to run the process for all Roads. 

 

 

A screen will then open showing the progress in the Layer generation. When the 

process is completed, the recommended Traffic Links will display in the Map. More 

options will become available at the Map Legend. 



 

 C h a p t e r  1 0   –   T r a f f i c  L i n k  C r e a t i o n  8 1   

 

 

The first time you create the Map Layer, there will be no Recommended Traffic 

Links. These will not appear until you have run the Recommend Traffic Links 

process at the Recommended Traffic Links screen or from within . 

 

 

You create Traffic Links for only those Roads whose traffic you are 

going to count. So you have no need to create Traffic Links for Roads 

you do not own. 

 

 

View a List of Recommended Traffic Links 

The View/Create Traffic Links button  becomes available once you 

have created the Map Layer of Recommended Traffic Links. You press this button to 

open the Recommended Traffic Links screen and run the Recommend Traffic Links 

process. You can then group and save the Recommended Traffic Links in bulk. 

The list of Recommended Traffic Links will be the same as when you last closed the 

screen and will reflect the Recommend Traffic Links process which you last ran and 

any changes you made after running the process. So the first time you open the 

screen it will be empty as you have run no processes. 
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Temporary Records Only 

Running the Recommend Traffic Links process does not create permanent records. 

These Recommended Traffic Links are sitting in a temporary table. They become 

actual records in the database only when you have selected the Recommended 

Traffic Links and pressed Save Traffic Links . 

 

 

So if you work on the Recommended Traffic Links, close , 

open it again and return to the screen, you can begin where you 

left off as your work has been preserved in the temporary table. 

 

 

Process All Roads 

When you press  the Recommend Traffic Links dialog will open. 
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There are two options: 

• Process Roads with no Traffic Links 

Any Roads already associated with Traffic Links are ignored. So if you are creating Traffic 

Links in groups, rather than all at once, the list of Recommended Traffic Links will 

shorten each time you run the process. 

• Process all Roads 

Recommended Traffic Links are created for all Roads in the Network whether or not 

Traffic Links have been created for them. You use this when you want to view Traffic 

Links which have been created as well as the ones recommended by . 

 

 

It is not possible to generate Recommended Traffic Links for a select 

range of Roads even if you filter the Roads in the Road list panel 

or select Roads on the Map. You can only filter the list of 

Recommended Traffic Links.  

 
 

Select Recommended Traffic Links 

Each Traffic Link has associated parameters which are used in the creation of Average 

Daily Traffic (ADT) Estimates. 

These vary dependent on the: 

• Road Type 

One of the factors which affects traffic on a Road is the Road Type. For instance, a 

Road which is an access route to a ski field in winter will have a different usage pattern 

from one which is used to access a popular beach in summer. 
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Similarly, Roads used for industry will have different usage patterns from those used as 

main arterial routes for commuters. There are seven default Road Types used for 

 Traffic Count Estimation. See Road Type Selection Process (on page 47). 

• Traffic Growth Group 

A Traffic Growth Group is a group of Traffic Links that are believed to have 

approximately the same level of traffic growth from year to year. 

Each Traffic Link is associated with a Traffic Growth Group. This allows a previous ADT 

Estimate at a site that has not been counted in the current year to be updated using the 

average traffic growth recorded at other similar sites that have been counted in the 

current year. See Growth Group Factors (on page 219). 

• AADT Band 

The Annual Average Daily Traffic (AADT) count is a figure to describe traffic levels 

for a Treatment Length.  

Traffic Links are grouped dependent on whether they have a High, Medium or Low AADT 

Band. See ADT and AADT in  (on page 37). 

 

 

When you save Recommended Traffic Links you assign Road Type, 

Traffic Growth Group and AADT Band values in bulk. So it makes sense 

to filter the Recommended Traffic Links before you save them. 

 

Filter the Recommended Traffic Links 

How you filter the Recommended Traffic Links to group Roads with the same Road 

Type, Traffic Growth Group and AADT Band will depend on your Road Network and 

your knowledge of the same. 

Obvious filter parameters are the Pavement Use, Urban/Rural and Hierarchy options. 
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Select the Recommended Traffic Links 

You select all the filtered and grouped Recommended Traffic Links by pressing .  

Then when you close the Recommended Traffic Links screen you will be returned to 

the Map and the recommended Traffic Links will be displayed. 

You can then work your way through the highlighted Roads. 

 

 

 

Save Traffic Links 

Best practice is to create Traffic Links in bulk at the Recommended Traffic Links screen. 

You do this by selecting the check boxes adjacent to the Recommended Traffic Links 

and then pressing the Save Traffic Links button. This opens the Bulk Set Traffic Link 

Fields screen. 

You select the values which match the characteristics of the Traffic Links, press OK 

and the Traffic Links are created. 

Now that these Traffic Links have changed from being Recommended to actual 

Traffic Links they will disappear from the list. 

Process All Roads 

If you run the Recommend Traffic Links process again after selecting Process all 

Roads,  will generate a Recommended Traffic Link for each of the Traffic Links 

you have created. 

You will be alerted to the fact that a Traffic Link exists as the Already Exists check box 

will be selected. 
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How RAMM Recommends Traffic Links 

 analyses Carriageway Sections one Road at a time to recommend Traffic 

Links. 

Step Action Comments 

1 Select and sort data  selects all Carriageway table records and 

sorts them into Road and Start Displacement order.  

2 Round Average Daily Traffic 

(ADT) Estimate 

 rounds each existing Carriageway ADT 

Estimate record in turn to the nearest 100 vehicles. 

3 Select first available record  then selects the first available record. 

4 Create Traffic Link record  creates a Traffic Link record and associates the 

currently selected Carriageway Section to it. It names 

the Traffic Link after the selected Carriageway Section. 

5 Select Carriageway Section  selects the next available Carriageway 

Section. 

6 Compare rounded ADT 

values 

 compares the rounded ADT value of the 

selected Carriageway Section with that of the first 

Carriageway Section associated with the Traffic Link. 

7 Is the ADT value within 

plus or minus 10% 

 goes to step 8 if the rounded ADT value of 

the selected Carriageway Section is within plus or 

minus 10% of the Carriageway Section associated 

with the Traffic Link. Otherwise it goes to step 10. 

8 Check Road  checks whether the Road of the selected 

Carriageway Section is the same as the Road of the 
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Step Action Comments 

Carriageway Section associated with the Traffic Link. 

9 Are the Road values the 

same 

If the Road of the selected Carriageway Section and 

the one associated with the Traffic Link are the same, 

 associates the selected one to the Traffic Link 

and goes back to step 5. Otherwise it goes to step 10. 

10 Complete Traffic Link  completes and saves the Traffic Link. 

11 Check next Carriageway 

Section 

 checks whether another Carriageway Section 

not associated with a Traffic Link is available. 

12 Is there another Carriageway 

Section 

If there is another Carriageway Section which is not 

associated with a Traffic Link,  goes to step 3, 

otherwise the process is complete. 

 

 

Generating Recommended Traffic Links 

Introduction 

You create Traffic Links by combining Carriageway Sections. These are the building 

blocks of  Traffic Count Estimation. You can manually create your own Traffic 

Links for your database. However, it is more efficient to accept the  

Recommended Traffic Links which are contiguous Carriageway Sections from the 

same Road that have the same Average Daily Traffic (ADT) Estimate value, plus 

or minus 10%. 

Before you do this you need to have: 

• set Traffic Count Estimation parameters. You do this in  at the 

Parameter screen. See Setting Traffic Counting Parameters (on page 67). 

• the correct Staff Permissions. You grant these at the Staff Permissions screen. See Data 

Maintenance Staff Permissions (on page 287). 

• logged in to . 

Menu Path 

Follow the menu path (press Show Map ) > (press Traffic Management Mode ) > 

(press Show Traffic Data for all Roads ) to open the Map with the Traffic 

Management tool bars, buttons and information available. 
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►  Genera t ing  Recom mended  Tra f f i c  L inks  

 

 

To do this you follow these steps: 

 

 

You should familiarise yourself with the Traffic Management 

Mode Map features before performing this procedure. See Map 

Features for Traffic Count Estimation (on page 176). 

1 Follow the Map menu path View > Recommended Traffic Links. 

A screen will open showing that the process of creating the Recommended Traffic Links 

Layer for the Map is running. When complete, the screen will close and the 

Recommended Traffic Links will be displayed on the Map. 

2 Does  display? 

Yes then go to step 6. 

No then go to step 3. 

3 Press the Panel Sizer to open the Map Legend. 

 

 

 

4 Select and clear the display options as in the graphic above. 
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5  Press the Panel Sizer to close the Map Legend. 

6 Press . 

The Recommended Traffic Links screen will open. What you see will depend on your 

previous actions. If you have yet to run the Recommend Traffic Links process, there will 

be no Recommended Traffic Links listed. If you have previously run the Recommend 

Traffic Links process with Process Roads with no Traffic Links selected, then any Roads 

which have already been made into Traffic Links are ignored in the process and will not 

be listed. 

If you have previously run the Recommend Traffic Links process with Process all Roads 

selected, then the list will include Recommended Traffic Links for all Roads in the 

Network, whether or not Traffic Links have been created for the Road. 

 

 

7 Press . 

The Recommend Traffic Links dialog will open. 
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8 Select Process Roads with no Traffic Links. 

If you have run the process previously, there will be a warning on the screen advising 

you of this and asking if you really want to run the process again. 

9 Press . 

The process will run. If this is the first time you have run the Recommend Traffic Links 

process, a screen will open to display the process as it runs. A list of Recommended 

Traffic Links for all Roads which have not already been made into Traffic Links will 

display. 

10 Go to Saving Recommended Traffic Links (on page 90). 

 

Saving Recommended Traffic Links 

Introduction 

Once you have created the Recommended Traffic Links, you group and then save 

them. Each Traffic Link must have a Road Type, a Traffic Growth Group and an AADT 

Band. So you are best to group all Roads with matching parameters and save them 

in bulk. 

Before you do this you need to have: 

• run the Recommended Traffic Link Generation process at the Recommended Traffic 

Links screen. See Generating Recommended Traffic Links (on page 87). 

• the correct Staff Permissions. You grant these at the Staff Permissions screen. See Data 

Maintenance Staff Permissions (on page 287). 

Menu Path 

Follow the menu path (press Show Map ) > (press Traffic Management Mode ) > 

(press Show Traffic Data for all Roads ) > View > Recommended Traffic Links > (press 

) to open the Recommended Traffic Links screen with a list of 

Recommended Traffic Links. 
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Saving Recommended Traffic Links 

 

 

To do this you follow these steps: 

1 Press . 

The Filter Dialog for Traffic Management will open. 

 

 

2 What you do next will depend on your own Network and your knowledge of the same. 

You filter the Recommended Traffic Links to group Roads with the same Road Type, 

Traffic Growth Group and AADT Band. See Road Type Selection Process (on page 47). 

Obvious filter parameters are the Pavement Use, Urban/Rural and Hierarchy options. 
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3 Press . 

The Filter Dialog will close and you will be returned to the Recommended Traffic Links 

screen. Only the Recommended Traffic Links for Roads which matched your filter 

criteria will be listed. 

4 Press . 

All the Recommended Traffic Links will be selected. 

5 Press . 

The Bulk Set Traffic Link Fields screen will open. 

 

 

6 Select the appropriate values from the Road Type, Traffic Growth Group and AADT Band 

drop-down lists. 

7 Press . 

The Bulk Set Traffic Link Fields screen will close and you will be returned to the 

Recommended Traffic Links screen. The Recommended Traffic Links which you have 

just saved will no longer be listed. 

8 Are there Recommended Traffic Links listed in the display? 

Yes then go to step 2. 

No then go to step 9. 

9 Close the screen in the normal manner. 

You will be returned to the Map where the newly created Traffic Links will display. 
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Running the Recommend Traffic Links process does not create 

permanent records. These Recommended Traffic Links are sitting in 

a temporary table. They become actual records in the database 

only when you have selected the Recommended Traffic Links and 

pressed Save Traffic Links . 
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Count Sites in  are the Locations at which Traffic Counts will occur. They are 

positioned on a Traffic Link. 

You should create Count Sites after you have created your Traffic Links but before you 

have begun associating Traffic Links with each other. Best practice is to let  

recommend these Count Sites for you and then to accept the recommendations 

which best suit your Network and Traffic Count Estimation goals. 

You use Sample Groups to group Count Sites. Sample Groups group Count Sites with the 

same count frequency. You count traffic on high volume Roads more often than 

on low traffic volume Roads. So you assign a Sample Group to each Count Site based 

on how often it needs to be counted, whether this is every year, every second year 

or once every five years. 

You use Growth Groups to group Count Sites which have the same growth profiles. A 

Traffic Growth Group is a group of Traffic Links that are believed to have 

approximately the same level of traffic growth from year to year. They are used in 

the update Average Daily Traffic (ADT) Estimates process.  averages the 

actual Traffic Counts for Count Sites on Traffic Links in the Traffic Growth Group, 

ignoring any greater than one and one half standard deviations above or below the 

mean growth for the group. Having found the average annual traffic growth, 

 applies this factor to previous ADT Estimates where there has been no 

count in the current year. 

In  Th is  Chap ter  

View Recommended Count Sites on the Map ........................... 96 

Select Recommended Count Sites.............................................. 99 

Generating Recommended Count Sites ................................... 104 

Saving Recommended Count Sites .......................................... 107 

 
 

Count Site Creation 
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View Recommended Count Sites on the Map 

Once you have created your Traffic Links you create your Count Sites. You could 

perform this task manually. It is much more efficient to use  to recommend 

Count Sites. It recommends them based on the sites of historical reads and a 

randomised process. See How  Recommends Count Sites (on page 102). 

Best practice is for you to let  recommend the Count Sites and for you to 

accept in bulk the Count Sites which represent the percentage of Network Vehicle 

Kilometres Travelled (VKT) which you set at the Parameter screen in 

. You can give them a default Sample Group and fine tune them later. 

The Map in RAMM 

To view the recommended Count Sites on the Map, you: 

• press  to open the Map in  

• then press  to turn on Traffic Management Mode. This makes the required tool 

bars and buttons available.  

• then press  to make the Traffic Management information display on the Map. 

Recommended Count Sites 

You follow the menu path View > Recommended Count Sites. The first time you do 

this a Warning screen will open advising that as the Recommend Count Sites 

process uses Intersections, your Intersection records need to be up-to-date. If they 

are not, you need to generate and correct your Intersection records before you 

view the recommended Count Sites. 

 

 

If your Intersection records are up-to-date you press Yes to close the Warning and 

to open a screen showing the process to generate a Layer on the Map of Count Sites 

recommended by . When the process is completed, the Recommended 

Count Sites, if any, will display in the Map. More options will become available at 

the Map Legend. 
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The first time you create the Map Layer, there will be no Recommended Count 

Sites. These will not appear until you have run the Recommend Count Sites process 

at the Recommended Count Sites screen or from within . 

You can carry out the Recommended Count Sites process in  or in 

 using the Map. For more information on the process in  

see Run Recommended Count Sites Process (on page 227). 

 

 

You create Count Sites for only those Roads whose traffic you are 

going to count. So you have no need to create Count Sites for Roads 

you do not own. 

 

 

View a List of Recommended Count Sites 

Once you have created the Map Layer of Recommended Count Sites the View/Create 

Count Sites button  becomes available. You press this button to 

open the Recommended Count Sites screen and run the Recommend Count Sites 

process. You can then group and save the Recommended Count Sites in bulk. 

 

 

 highlights the Recommended Count Sites which represent 

the Network Coverage  % of VKT value you set at the Parameter screen in 

 when you set Traffic Counting parameters. 
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Temporary Records Only 

When you run the Recommend Count Sites process at this screen, you are not 

creating permanent records. These Recommended Count Sites are sitting in a 

temporary table. They become actual records in the database only when you have 

selected the Recommended Count Sites and pressed . 

 

Count Sites List 

The list of Recommended Count Sites will be the same as when you last closed the 

screen. So it will reflect the Recommend Count Sites process which you last ran and 

will include any changes you made after running the process. So the first time you 

open the screen it will be empty as you have run no processes. 

This means that if you work on the Recommended Count Sites, close , open 

it again and return to the screen, you can begin where you left off as your work has 

been preserved in the temporary table. 

Existing Count Sites 

When you run the Recommend Count Sites process, existing Count Sites, if any, will 

be listed. They will be readily identifiable as the Already Exists check box will be 

selected and the record will be highlighted in grey. 
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It is not possible to generate Recommended Count Sites for a select 

range of Roads even if you filter the Roads in the Road list panel 

or select Roads on the Map. You can only filter the list of 

Recommended Count Sites.  

 

 

Select Recommended Count Sites 

You will not want to count the traffic on every Road in your Network. 

It is most efficient to channel your Traffic Count Estimation resources to those Traffic 

Links which carry most of the traffic. 

Network Coverage 

When you set the Traffic Counting parameters at the Parameter screen in 

 you set a Network Coverage  % of VKT value. 

 

 

Count Sites and Network Coverage 

 highlights the Recommended Count Sites which represent the value you set 

at the Network Coverage  % of VKT field at the Parameter screen in . 

You press Select Top % of VKT  to select these highlighted Count Sites. 
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Sample Group 

Sample Groups group Count Sites with the same count frequency. You count traffic 

on high volume Roads more often than on low traffic volume Roads. So you 

assign a Sample Group to each Count Site based on how often it needs to be counted, 

whether this is every year, every second year or once every five years.  

Each Count Site must have an associated Sample Group parameter which is used to 

determine when a Traffic Count will next be scheduled at the Count Site. See Traffic 

Count Schedule (on page 149). 

 

 

When you save Recommended Count Sites you assign Sample Group 

values in bulk. So you can filter and group the Recommended 

Count Sites which require the same Sample Group value before you 

save them. 

You can also just give all the Count Sites a temporary Sample Group 

value and correct this as part of a future process. See Updating 

Count Site Sample Group Values (on page 122). 

Filter the Recommended Count Sites 

If you decide to filter the Recommended Count Sites to group Roads with the same 

Sample Group value, your filter parameters will depend on your Road Network and 

your knowledge of the same. 

The obvious filter parameter is the VKT. 

Select the Recommended Count Sites 

You can select all the filtered and grouped Recommended Count Sites by pressing 

. Then when you close the Recommended Traffic Links screen you will be returned 

to the Map and the recommended Count Sites will be displayed. 
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If you export and sum VKT values to check the  % VKT 

calculations there may appear to be errors even though the 

highlighted list is accurate. 

When  recommends two Count Sites on one Traffic Link to 

account for multiple historical counts, the VKT value is listed 

twice. VKT for child Traffic Links associated with a parent Traffic Link 

will not appear in the list because  will not recommend 

Count Sites for them. The VKT of Carriageway Sections which are 

not in a Traffic Link will still be part of the calculation but not in the 

list. 

 
 

Save Count Sites 

Best practice is to select Count Sites in bulk at the Recommended Count Sites screen. 

You do this by selecting the check boxes adjacent to the Recommended Count Sites 

and then pressing . This opens the Bulk Set Traffic Link Fields screen. 

Bulk Set Count Site Fields 

 

 

You select the values which match the characteristics of the Count Sites, press OK 

and the Count Sites are created. 

You must select a Sample Group for the Count Sites. You have the option of selecting 

Load Method and defining a Site Reference if this is useful to you. 
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When you save Recommended Count Sites you assign Sample Group 

values in bulk. So you can filter and group the Recommended 

Count Sites which require the same Sample Group value before you 

save them. 

You can also just give all the Count Sites a temporary Sample Group 

value and correct this as part of a future process. See Updating 

Count Site Sample Group Values (on page 122). 

Run Recommended Count Sites Process Again  

If you run the Recommend Count Sites process again,  will generate a 

Recommended Count Site for each of the Count Sites you have created. You will be 

alerted to the fact that a Count Site exists as the Already Exists check box will be 

selected. They will also be highlighted in grey. 

 

How RAMM Recommends Count Sites 

There are two ways that  selects a Location for a Count Site.  

Firstly it looks at the historical record of Traffic Counts and recommends that these 

Locations become Count Sites. 

Then, it randomly picks a Location somewhere along a Traffic Link which has no 

associated Traffic Link. 

Associated Traffic Links 

When you set up your Traffic Link associations you do so in a series of hierarchical 

Parent/Child relationships so that when you perform a Traffic Count on the 

uppermost of the Parent Traffic Links the reading will filter down to all the 

subsidiary Traffic Links as per the percentages defined. 

The Traffic Link which is at the top of the hierarchical relationships of the Parent 

Traffic Links will have no Related To values. This is because it does not have an 

Average Daily Traffic (ADT) Estimate calculated as a percentage of another Traffic 

Link. So it needs to have its traffic counted. 
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Recommended Count Site Process 

Recommended Count Sites are determined by analysing the Traffic Links using the 

following steps. 

1 Select Traffic Links 

Select all the Traffic Links where there is no associated Traffic Link. These are the ones 

where there is to be a count performed. 

2 Sort Traffic Links 

Sort these records into Road and Start Displacement order. 

3 Read First Record 

Read the first Traffic Link from the sorted list. 

4 Short Traffic Link 

If the Traffic Link is 400m or less in length propose a Count Site half way along. 

Check to ensure that the proposed site is not within 100m of an Intersection. If so then 

move it. Take the calculated Location and round it to the nearest 10m. 

5 Long Traffic Link 

If the Traffic Link is more than 400m in length then randomly select a Location 

somewhere between the start and the finish. 

Check to ensure that the proposed site is not within 100m of an Intersection. If so then 

move it. Take the calculated Location and round it to the nearest 10m. 

6 Next Traffic Link 

Select the next Traffic Link record and go to step 4. 

7 No More Traffic Links 

If there are no more Traffic Link Records then go to Step 8. 

8 Traffic Count Sites from Actual Counts 

Select all the records of actual Counts from the Traffic table. For each Road and 

Carriageway Section, count the number of Counts which have taken place, irrespective 

of when, and determine the average Location. Round the average Location to the 

nearest 10m and propose this as the Location of the Count Site. Repeat this step for all 

Roads and Carriageway Sections. 
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If you export and sum VKT values to check the  % VKT 

calculations there may appear to be errors even though the 

highlighted list is accurate. 

When  recommends two Count Sites on one Traffic Link to 

account for multiple historical counts, the VKT value is listed 

twice. VKT for child Traffic Links associated with a parent Traffic Link 

will not appear in the list because  will not recommend 

Count Sites for them. The VKT of Carriageway Sections which are 

not in a Traffic Link will still be part of the calculation but not in the 

list. 

 
 

Generating Recommended Count Sites 

Introduction 

You create Count Sites so that Traffic Counts can best be positioned and scheduled. 

You could manually create Count Sites for your database. However, it is more 

efficient to accept the  Recommended Count Sites. These are based on 

historical counts or a random Location on Traffic Links which have never been 

counted. If you have followed best practice, this will be every Traffic Link as you will 

not have associated Traffic Links with each other. 

Before you do this you need to have: 

• created the Traffic Links You do this at the Recommended Traffic Links screen. See 

Traffic Link Creation (on page 79). 

• the correct Staff Permissions. You grant these at the Staff Permissions screen. See Data 

Maintenance Staff Permissions (on page 287). 

• logged in to . 

Menu Path 

Follow the menu path (press Show Map ) > (press Traffic Management Mode ) > 

(press Show Traffic Data for all Roads ) to open the Map with the Traffic 

Management tool bars, buttons and information available. 
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►  Genera t ing  Recom mended  Coun t  S i tes  

 

 

To do this you follow these steps: 

1 Follow the Map menu path View > Recommended Count Sites. 

A screen will open showing that the process of creating the Recommended Count Sites 

Layer for the Map is running. 

When this process is complete, the screen will close and the Recommended Count Sites 

will be displayed on the Map. 

2 Does  display? 

Yes then go to step 6. 

No then go to step 3. 

3 Press the Panel Sizer to open the Map Legend. 

 

 

4 Select and clear the display options as in the graphic above. 

5  Press the Panel Sizer to close the Map Legend. 
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6 Press . 

The Recommended Count Sites screen will open. What you see will depend on your 

previous actions. 

If you have yet to run the Recommend Count Sites process, there will be no 

Recommended Count Sites listed. 

If you have previously run the Recommend Count Sites process then the list will 

include Recommended Count Sites for all Traffic Links in the Network with no 

associated Traffic Link and for all points at which historical Counts have been taken. 

Where a Count Site exists, it will be highlighted in grey. 

 

 

7 Press . 

If you have run the process previously, a Warning screen will open advising you of this 

and asking if you really want to run the process again. Press Yes to run the process. 

If this is the first time you have run the Recommend Count Sites process, a screen will 

open to display the process as it runs. A list of Recommended Count Sites for all Traffic 

Links in the Network with no associated Traffic Link and for all points at which 

historical Counts have been taken will display. 

Where a Count Site exists, it will be highlighted in grey. 

8 Go to Saving Recommended Count Sites (on page 107). 
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Saving Recommended Count Sites 

Introduction 

Once you have created the Recommended Count Sites, you select those which 

represent the value you set at the Network Coverage  % of VKT field at the Parameter 

screen in .  highlights these for you. You then save them 

to create Count Sites so that you can schedule Traffic Counts for the most important 

Roads in your Network. 

Before you do this you need to have: 

• run the Recommended Count Site process. You do this at the Recommended Count 

Sites screen. See Generating Recommended Count Sites (on page 104). 

• the correct Staff Permissions. You grant these at the Staff Permissions screen. See Data 

Maintenance Staff Permissions (on page 287). 

Menu Path 

Follow the menu path (press Show Map ) > (press Traffic Management Mode ) > 

(press Show Traffic Data for all Roads ) > View > Recommended Traffic Links > (press 

) to open the Recommended Count Sites screen with a list of 

Recommended Count Sites. 

►  Sav ing  Recommend ed  Coun t  S i tes  
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Each Count Site must have an associated Sample Group parameter 

which is used to determine when a Traffic Count will next be 

scheduled at the Count Site. Best Practice is to give all the Count Sites 

a default Sample Group value and to change this if required during a 

later process. See Updating Count Site Sample Group Values (on page 

122). 

 

To do this you follow these steps: 

1 Press Select Top % of VKT . 

The Recommended Count Sites which represent the value you set at the Network 

Coverage  % of VKT field at the Parameter screen in , will be 

selected. These are highlighted in green. 

2 Press . 

The Bulk Set Count Sites Fields screen will open. 

 

 

3 Select a default value from the Sample Group drop-down list. 

4 Select a value from the Load Method drop-down list if this information is useful to you. 

5 Type the Site Reference code in the Site Reference field if you use Site References. 

6 Press . 

The Bulk Set Count Sites screen will close and you will be returned to the 

Recommended Count Sites screen. The Recommended Count Sites which you have just 

saved will be greyed out to show that they are now existing Count Sites. 

7 Close the screen in the normal manner. 

You will be returned to the Map where the newly created Count Sites will display. 
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When you run the Recommend Count Sites process at this screen, 

you are not creating permanent records. These Recommended 

Count Sites are sitting in a temporary table. They become actual 

records in the database only when you have selected the 

Recommended Count Sites and pressed the Save Count Sites button. 

So you can run the Recommended Count Sites process over and 

over without causing problems. 

 

 





 

  

C H A P T E R  1 2  

When you set your initial Traffic Count Estimation parameters, you defined the 

percentage of your Network Vehicle Kilometres Travelled (VKT) which you 

intend to count.  helps you place Count Sites on the Traffic Links which carry 

this percentage of your Network traffic. 

So when you come to associate Traffic Links with each other, you can see clearly the 

Roads you want to count as they now have Count Sites on them. The Roads you do 

not want to count will not have a Count Site. 

Every Traffic Link which does not have a Count Site must be associated with another 

Traffic Link from which it receives traffic. You associate the Traffic Links which are not 

being counted with those which will be counted. 

You do this at the Map where you can see the relationship between contiguous 

Roads. There is a special tool which makes it simple to relate one Traffic Link to 

another Traffic Link. 

In  Th is  Chap ter  

Traffic Link Association ............................................................ 112 

Associating Traffic Links ........................................................... 119 

Updating Count Site Sample Group Values ............................ 122 

Refresh the Traffic Counting Map ........................................... 124 

Reduce Estimate Records .......................................................... 125 

 
 

Associate Traffic Links by Count Site 
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Traffic Link Association 

When you have created your Traffic Links and Count Sites you can then associate the 

links with each other to reflect the manner in which the Roads in the Network are 

related to one another. You can set the Average Daily Traffic (ADT) Estimate of 

one Traffic Link to be estimated at a percentage of the original Traffic Link. This 

enhances the effectiveness of Traffic Counts. 

Relate a Traffic Link to Another Traffic Link 

You use the Relate a Traffic Link to Another Traffic Link button  to associate Traffic 

Links. 

First you select the secondary Traffic Link. This is the one with the lesser traffic 

volume. Its ADT will be Estimated as a percentage of the primary Traffic Link 

You then select the primary Traffic Link. This is the one with the greater traffic 

volume which gives traffic to the secondary Traffic Link. 

 

 

The primary Traffic Link will then appear briefly before the Traffic Link Detail screen 

opens. You then check the details. 

The details of the Traffic Link you selected first will default into the upper General 

section. You can change these details if necessary. These should be the details for 

the secondary Traffic Link which will be defined as having an ADT as a percentage of 

the ADT of the primary Traffic Link. 
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In the graphic above, there are no Traffic and Loading data such, as 

ADT, for the secondary Traffic Link. This is because the data have not 

yet been set. Even if the Traffic Link to which it is being related has 

an actual ADT, no ADT will be set for the secondary Traffic Link. This 

will not occur until a Status Check has been run. See Run Status 

Check (on page 129). 

 

The name of the Traffic Link you selected second will default into the lower Related 

To section. 

  will have calculated a default percentage of the traffic from the primary 

Traffic Link which is expected to flow into the secondary Traffic Link. This will default 

into the Take ADT as % field. You can edit this figure if required. To do this you 

type a value in the Take ADT as   % field. This defines the percentage of the ADT 

of the primary Traffic Link which is expected on the secondary Traffic Link. 

 

 

If you are using the Relate a Traffic Link to Another Traffic Link process and 

you inadvertently click on the Map in error, you may experience 

unexpected behaviour such as a screen not appearing. If this 

happens, look under the Window menu option. If the Traffic Link 

Detail screen is listed, select it. You should then see what you are 

expected to do next. 
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Parent Child Link Percentage Calculation 

When you are associating Traffic Links,  defaults a suggested percentage ADT 

value for the traffic the child link will take from the parent link. 

The Default ADT % Calculation 

When associating Traffic Links at the Map in , You first select a dependent or 

child Traffic Link. This is the link which takes traffic from the other. You then select 

the parent link. This is the Traffic Link which gives traffic to the other. 

 

 

 then defaults a suggested percentage ADT value for the traffic the child 

link will take from the parent link. It calculates this by selecting all the 

Carriageway Sections which comprise both Traffic Links. The average ADT is then 

calculated for both the parent and the child links. A default % value is then added 

to the Take ADT as field.  calculates this value as (average ADT of child link) 

/ (average ADT of parent link) * 100. 

Users can overwrite this default value. 

In the graphic above the dependent or child link is Athena Drive. The parent or 

traffic-giving link is Trias Rd. 
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Child Link with Higher ADT Than the Parent Link 

If you attempt to associate a child or traffic-receiving Traffic Link with a parent or 

traffic-giving Traffic Link which has a lower ADT,  advises you by displaying 

a percentage figure of over 100% to show that the traffic will actually be flowing the 

other way. 

High ADT and Low VKT 

When you are generating recommended Count Sites this is usually done on the 

basis of a percentage of the network VKT. In rare situations you may want to place 

a Count Site on a Traffic Link with a small VKT. 

A child Traffic Link associated with this as a parent link would potentially have a 

higher ADT than the parent Traffic Link. This would not generally be logical as it 

would mean the traffic-receiving child Traffic Link would have greater traffic than 

the traffic-giving parent. 

So the ADT % would be greater than 100%. 

While you can enter a value greater than 100%, it is not advisable to do so. So 

 displays a value of greater than 100% to warn you against doing this in 

error. 
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Circular Link Warning 

You need to ensure that Traffic Links you create are not associated with themselves 

through circular linking.  warns you when you are about to do this. 

Warning 

When you are associating one Traffic Link (the primary) with another (the 

secondary),  checks that the association does not create a closed loop. It 

does this by looking for a Traffic Link associated with the secondary link. If it finds 

an associated link, it checks that it is not the primary Traffic Link. It repeats this 

check until it finds a Traffic Link with no other associated link. 

If  discovers that an associated link is the primary link the following 

warning is displayed. 

This association will form a closed loop. Please choose another Traffic Link to which to 
associate this one. 

 

 

 

Deselect Traffic Link 

You can break the association between two Traffic Links when working at the Map in 

. 

Associated Carriageway Sections and Traffic Links 

When you are setting up and maintaining Traffic Count Estimation at the Map in 

 you might make an error of judgement and associate a Carriageway 

Section incorrectly to a Traffic Link. Another error could be incorrectly associating 

two Traffic Links. 

To dissociate a Carriageway section from a Traffic Link you highlight the 

Carriageway and right-click for the menu options. 

To dissociate a Traffic Link from another you highlight the Traffic Link and right-click 

for the menu options. 
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Fixed Count Traffic Links 

You can define Traffic Links which do not need to be counted and can be left for 

manual ADT Estimate review. 

Set ADT and Leave It 

You probably have cul-de-sacs, short rural roads and others for which you would 

prefer to set the ADT and leave it. Traffic Links comprised solely of such roads 

would not be counted. They would be excluded from most of the Traffic Count 

Estimation processes and ignored until you decided to manually update them. 

They would be affected only by increases or decreases based on their Growth Group. 
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Set the Colour 

You set a colour for the Fixed Count Traffic Links which will differentiate them from 

other Traffic Links. 

Fixed Traffic Link Option 

You select the Fixed Count option to determine that a Traffic Link is not to be 

counted. 

 

 

 

Colour Format Traffic Links 

You can colour Traffic Links to distinguish between parent links, child links, those 

which have yet to be associated with another Traffic Link, and those links which have 

a fixed ADT and should not be counted. 

Parent, Child, Orphan and Fixed Count Colours 

When you are setting up and maintaining Traffic Count Estimation at the Map in 

 you can set up your Map Legend to differentiate Traffic Links and show the 

status of each. 
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This will assist in the initial process of linking all the Traffic Links in your Network. 

You use colour as a visual clue to display those Traffic Links which still require 

association. 

If you set colours for Traffic Links which are associated with another Traffic Link, or 

whose Count is fixed, then the remaining Traffic Links will be the ones with which 

you still have to deal. 

 

 

 

Associating Traffic Links 

Introduction 

When you have defined your Traffic Links on which you want to count traffic and 

the Count Sites where you want to perform the Traffic Counts you can then relate 

subsidiary, or secondary, Traffic Links to the traffic-contributing, or primary, Traffic 

Link. 

Before you do this you need to have: 

• created the Traffic Links. You do this at the Recommended Traffic Links screen. See 

Traffic Link Creation (on page 79). 

• created the Count Sites . You do this at the Recommended Count Sites screen. See 

Count Site Creation (on page 95). 

• the correct Staff Permissions. You grant these at the Staff Permissions screen. See Data 

Maintenance Staff Permissions (on page 287). 
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Menu Path 

Follow the menu path (press Show Map ) > (press Traffic Management Mode ) > 

(press Show Traffic Data for all Roads ) > (locate primary Traffic Link) to 

open the Map with traffic management data displayed for the primary Traffic Link. In 

the graphic below, the primary Traffic Link is Hugh Green Drive on the left of the 

screen. It has a Count Site. 

►  Assoc ia t i ng  T ra f f i c  L inks  

 

 

To do this you follow these steps: 

1 Press Relate a Traffic Link to Another Traffic Link . 

The tool to relate Traffic Links is enabled. The message Select the Traffic Link which 

takes traffic from another Link appears at the base of the Map. An Information screen will 

open advising you how to use the tool if this is the first time you have pressed the 

button. 

 

 

2 Read the information. 

3 Select Don't show this message again. 

4 Press . 

The Information screen will close and you will be returned to the Map. Next time you 

press  the Information screen will not appear. 
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5 Use the mouse pointer to select the secondary Traffic Link. This is the one which will 

receive traffic from the primary Traffic Link. 

The Traffic Link will become highlighted. The message Select the Traffic Link which 

gives traffic to the first Link will appear at the base of the Map. 

 

 

6 Use the mouse pointer to select the primary Traffic Link. This is the one which will 

give traffic to the secondary Traffic Link. 

The Traffic Link Detail screen will open. The details for the secondary Traffic Link will 

have defaulted into the upper General section. The name of the primary Traffic Link will 

have defaulted into the lower Related To section. 

 

 

7 Look at the AADT Estimate Band, Road Type and Growth Group values in the General 

section. Update them if necessary. 

8 Type in the Take ADT as   % field, the percentage of traffic of the primary Traffic Link 

you expect to flow along the secondary Traffic Link. 

9 Press . 

Your changes will be saved. 

10 Close the Traffic Link Detail screen in the normal manner. 

You will be returned to the Map where you can relate another Traffic Link. 

11 Have you checked the Sample Group value of the Count Site for the primary Traffic 

Link? 

Yes then go to step 13. 

No then go to step 12. 
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12 Check the Sample Group value of any Count Site. See Updating Count Site Sample 

Group Values (on page 122). 

13 Are there any remaining secondary Traffic Links to be related to a primary Traffic Link? 

Yes then go to step 5. 

No then go to step 14. 

14 Close the Map in the normal manner. 

 

Updating Count Site Sample Group Values 

Introduction 

Sample Groups group Count Sites with the same count frequency. You count traffic 

on high volume Roads more often than on low traffic volume Roads. So you 

assign a Sample Group to each Count Site based on how often it needs to be counted, 

whether this is every year, every second year or once every five years. The logical 

and efficient time to decide to which Sample Group Count Sites should belong, is 

when you are relating Traffic Links at the Map. That is why when you created your 

Count Sites you gave them all a default value at the Sample Group field. 

Before you do this you need to have: 

• created the Traffic Links. You do this at the Recommended Traffic Links screen. See 

Traffic Link Creation (on page 79). 

• created the Count Sites. You do this at the Recommended Count Sites screen. See Count 

Site Creation (on page 95). 

• performed steps 1 to 12 of the Relating Traffic Links procedure. You do this at the 

Traffic Link Detail screen. See Associating Traffic Links (on page 119).  

• the correct Staff Permissions. You grant these at the Staff Permissions screen. See Data 

Maintenance Staff Permissions (on page 287). 

Menu Path 

Follow the menu path (perform the Relating Traffic Links procedure to step 12) to open 

the Map with the Count Site that you wish to check displayed. In the graphic below, 

the Count Site is on Hugh Green Drive on the left of the screen. 
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►  Upda t ing  Coun t  S i te  Samp le  Group  Va lues  

 

 

To do this you follow these steps: 

1 Press Relate a Traffic Link to Another Traffic Link . 

The tool to relate Traffic Links is disabled. 

2 Press the Panel Sizer. 

The Map Legend will open. 

 

 

3 Make sure that the Traffic Links display is turned off and that the Count Sites display is 

turned on. Otherwise it will be very difficult to select the Count Site. 

4 Press the Panel Sizer. 

The Map Legend will close. 

5 Use the mouse pointer to select the Count Site. 

6 Right-click to bring up the options. 

 

 

7 Press Show Count Site Detail. 

The Count Site Detail screen will open with the details of the Count Site defaulted. 
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8 Is the Sample Group value correct? 

Yes then go to step 12. 

No then go to step 9. 

9 Press . 

The fields become available. 

10 Select the appropriate value from the Sample Group drop-down list. 

11 Press . 

Your changes are saved. 

12 Close the Count Site Detail screen in the normal manner. 

You will be returned to the Map. 

13 Is there another Count Site whose Sample Group value you want to check? 

Yes then go to step 5. 

No then go to step 14. 

14 Press the Panel Sizer. 

The Map Legend will open. 

15 Make sure that the Traffic Links display is turned on and that the Count Sites display is 

turned on. 

16 Press the Panel Sizer. 

The Map Legend will close. 

17 Press Relate a Traffic Link to Another Traffic Link . 

The tool to relate Traffic Links is enabled. 

18 Return to step 13 of the Associating Traffic Links procedure. See Associating Traffic 

Links (on page 119). 

 

Refresh the Traffic Counting Map 

When you are creating and maintaining your Traffic Count Estimation Assets at the 

Map in  you can refresh the Map so that you can more easily view the 

changes you have made. 

 

 

See Your Changes 

When you are creating and maintaining Traffic Count Estimation at the Map in  

you may want to see your changes reflected in the Map. You see this whenever the 

Map is refreshed. If the Map auto refresh function is not updating often enough, 

you can press Refresh to view your updates. 
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Reduce Estimate Records 

A large number of Estimate records are created when you are setting up Traffic 

Count Estimation. You can now reduce that number by having  overwrite 

records when sensible. 

 

 

Status Check Option 

When the Traffic Count Estimation process is run in Status Check, the final step is to 

create Estimate records for each Carriageway Section. If you do not wish to create 

large numbers of Estimates you can choose to overwrite the existing record rather 

than to create new ones. 
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You specify, in the Existing Carriageway Traffic and Loading records section, that if the 

age of the records is equal to or less than a particular number of days old, they are 

overwritten. 
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When you have created your Traffic Links, Count Sites and related your Traffic Links to 

each other, you will want to schedule your Traffic Counts. 

You should validate your data before you schedule your Traffic Counts. First you 

check for Carriageway Sections which are not part of a Traffic Link. 

Once you have found any unlinked Carriageway Sections and either made them 

into a Traffic Link or joined them to an existing Traffic Link you can run Status Check. 

This updates the database to take into account any Traffic Counts and Estimates 

entered since the most recent Status Check. It then updates the Average Daily 

Traffic (ADT) Estimates taking into account the new readings and the other 

factors. So all Traffic Links should then have an ADT. 

So as a final sanity check you run a report to locate Traffic Links with no Average 

ADT value. 

 

 

In  Th is  Chap ter  

Unlinked Carriageways ............................................................. 128 

Run Status Check ...................................................................... 129 

Traffic Links with No Average ADT ........................................ 129 

 
 

Data and Status Checks 
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Unlinked Carriageways 

It is possible that some Carriageway Sections will not have been associated with a 

Traffic Link. An Average Daily Traffic (ADT) Estimate value would not be calculated 

for these Carriageway Sections unless this is corrected. 

You find these unlinked Carriageways by running the Unlinked Carriageways 

report. You do this through the Map. You can also run it from . 

See Unlinked Carriageways (on page 241). 

Unlinked Carriageways Map Layer 

When you follow the menu path View > Unlinked Carriageways  creates a Layer 

for the Map which distinguishes Carriageways with no Traffic Link defined. The 

Carriageways are obvious. 

 

 

How to Fix the Problem 

If there are a large number of items to fix, the most efficient method is to run the 

Recommended Traffic Links process again. You do this at the Recommended Traffic 

Links screen. See View a List of Recommended Traffic Links (on page 81).  

If there are only a few Carriageways, it is probably faster to use the Map. You press 

 and add the Traffic Links in the standard manner. See Associate a Carriageway 

Section with a Traffic Link (on page 188). 

 

 

In order to run the Unlinked Carriageways report a user must 

have at least Enquiry Permission for Road Name and Carriageway. 
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Run Status Check 

Once you have found any unlinked Carriageway Sections and either made them 

into a Traffic Link or joined them to an existing Traffic Link you can run Status Check. 

This updates the database to take into account any Traffic Counts and Estimates 

entered since the most recent Status Check. It then updates the Average Daily 

Traffic (ADT) Estimates taking into account the new readings and the other 

factors. So all Traffic Links should then have an ADT. 

Status Check 

You can run the Status Check from the Map in . See Update Traffic Counts 

and Estimates (on page 204). 

You can also run the Status Check from . See Update Traffic 

Counts and Estimates (on page 230). 

 

 

 

Traffic Links with No Average ADT 

When you have run Status Check, there may be errors reported in the resulting 

Traffic Latest Errors report. See Traffic Latest Errors Report (on page 297). 
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You should locate the Traffic Links, identify and fix the problems which are causing 

the errors. You can easily identify some of the Traffic Links with problems by 

running the Traffic Links with no ADT report. You can run this report from 

within . See Traffic Links with No ADT (on page 241). 

 

 

See the Traffic Links on the Map 

You follow the menu path View > Traffic Links with no ADT. A Layer will then be 

created so that you can more easily find the Traffic Links with errors. 

When you have located the Traffic Links with errors and fixed them the Layer should 

disappear. If not, there must be more Traffic Links to fix. 
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Prior to implementing  Traffic Count Estimation, each Road Controlling 

Authority (RCA) will have had its own traffic counting programme. The 

implementation of  Traffic Count Estimation is an opportunity for each RCA to 

consider improvements which they can make in the selection of the sites where 

Traffic Counts should take place and how often traffic should be counted on each 

Road, if at all. 

The following sections include recommendations for a potentially more efficient 

traffic counting programme that: 

• targets those Roads that contribute most to Network traffic 

• retains the investment in historical monitoring 

• provides a means for monitoring the volume of vehicle traffic on the Network. 

 

 

There is no standard traffic counting programme which will suit 

all RCAs. How you design your programme will depend on your 

budget and your particular Network of Roads. 

It is the principles outlined in this chapter which are important. 

The individual details of each aspect of the recommended 

programme will not suit all RCAs. 

 

In  Th is  Chap ter  

Rotational Monitoring Sites ...................................................... 132 

Core Monitoring Sites .............................................................. 134 

Other Monitoring Sites ............................................................. 146 

 
 

Select Sites and Develop a Programme 
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Rotational Monitoring Sites 

If you are unable to count all your major Traffic Links every year, you use Rotational 

Traffic Counts to provide more frequent traffic monitoring on those Traffic Links that 

carry the greatest proportion of total Network travel. 

 

 

Background 

In an ideal world, Road Network planning and performance monitoring would be 

based on detailed knowledge of the traffic conditions on every link in the Road 

Network. However, monitoring the traffic volumes on every Road in the 

Network would be an inefficient use of resources as the majority of travel 

undertaken on a Road Network is concentrated on a relatively small selection of 

Roads.   

Typically the top 20% of Traffic Links, when sorted in descending order according to 

the total Vehicle Kilometres Travelled (VKT), carry between 80% and 95% of the 

total travel undertaken on the Network and between 60% and 90% of traffic 

crashes occur on these links. 

These Roads are therefore important to the community and the Road Controlling 

Authority (RCA). Having reliable traffic Estimates on these key links is very 

important. Depending on just how many key Traffic Links there are, a decision can 

be made to: 

• count all these links annually, or 

• divide the set into two groups which are counted in alternate years. 

While the former is obviously preferable, to maintain a similar investment in 

traffic counting some RCAs will need to adopt the latter approach, hence the name 

Rotational Monitoring. 

If the latter option is selected, it is important to ensure the links that make up any 

particular group are roughly distributed over the Network. While it may be more 

efficient to split the groups geographically, it is generally better to look for a more 

even distribution. 
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Sample Selection 

Selecting the sample of Rotational Monitoring sites is a relatively simple exercise. 

Simply filter the Traffic Link table to identify those Traffic Links that, when 

ordered by Vehicle Kilometres Travelled (VKT), account for 80% of the total 

Network travel. 

Having selected the total sample it, may well be worthwhile investigating which 

links already have established Count Sites and the extent of that traffic counting 

history. 

This can be done using the initial Recommended Count Sites screen. See View a List 

of Recommended Count Sites (on page 97). It can be further refined using the Map. 

See Saving Recommended Count Sites (on page 107). 

Review Core Monitoring Requirements 

It may also pay to review the requirements for selecting the Core Monitoring sites, 

outlined below, as this will assist in developing a programme that makes 

maximum use of the historical traffic count data, without introducing bias. 

Count Programme 

Having identified which of the top Rotational Sample sites are to be used as Core 

Monitoring sites the remaining Rotational Sites can be allocated to a programme. 

As a general guide the programme should be aiming to ensure that around 15% to 

20% of the Network traffic links are counted annually. This equates to roughly 

10% to 15% of the  Carriageway Sections. 

Rotational Monitoring Sites 

Based on these percentages, the annual traffic survey programme of 15% to 20% of 

Traffic Links would cover 3% to 6% Core Monitoring sites and around 10% to 14% 

Rotational Monitoring sites. In many cases it will be necessary to split the 

Rotational Monitoring sites into two groups, this can be done by simply allocating 

each consecutive site to one of four groups (A,B,C,D) and then combine groups A 

and D to form the first years and B and C to form the second. This is not as 

rigorous as ordering on a random number but should work to ensure that the 

groups of sites are not geographically biased, which would impact on the update 

process described below. This process can be done manually or visually in the Map 

or by exporting the Count Sites to Excel, completing the exercise and updating 

results in . 
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Core Monitoring Sites 

Best practice is to have a group of Core Monitoring Count Sites which are counted 

annually. 

Budget and other constraints may preclude a Road Controlling Authority (RCA) 

from restricting its sites to a core annual group. 

In that case they will need to institute groups of Rotational Monitoring Count Sites. 

See Rotational Monitoring Sites (on page 132). 

Purpose  

The Core Monitoring sites are a selection of sites that will be surveyed annually, in 

order to provide an Estimate of total annual Vehicle Kilometres Travelled (VKT) 

on the Network. 

They will cover those Traffic Links that contribute most to total Network travel and 

are placed on the Roads with highest traffic volumes. 

Background 

The general approach, as outlined in Appendix A, is to calculate the total Vehicle 

Kilometres Travelled (VKT) that occurs on those Traffic Links that form the Core 

Monitoring Sites. 

You then scale this up by the ratio of the total Network length to the length of the 

Traffic Links that form the sample of Core Monitoring Sites, to obtain an Estimate 

of the total Network VKT. 

 

 

The Core Monitoring Sites are selected by ordering the Traffic Links 

in decreasing order of ADT Estimate, but the Rotational 

Monitoring Sites are ordered in terms of VKT. This is calculated 

as length in kilometres multiplied by AADT. 
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Sample Specifications and Framework 

The sample specifications for each Network are provided in Appendix B. 

They involve selecting the required sample as a stratified random sample based on 

the distribution of ADT values over the Network. 

Sample Size 

The sample size for the Core Monitoring sites has been set to be 95%. 

You can be confident that the true volume of travel lies within plus or minus 10% 

of the Estimate, and typically involves between 3% and 6% of the total number of 

Traffic Links. 

A more precise Estimate can be obtained by drawing a larger sample. However, to 

halve the precision - moving toward plus or minus 5% - generally requires 

approximately four times the sample. 

Sample Framework 

The sampling framework involves allocating all Traffic Links into one of five bands; 

• Band 1 contains the links with the top 10% of ADTs, 

• Band 2 contains the next 10% of links ordered by ADT (80% to 90%), 

• Band 3 contains the next 20% of links ordered by ADT (60% to 80%), 

• Band 4 contains the next 20% of links ordered by ADT (40% to 60%), 

• Band 5 contains the remaining 40% of links ordered by ADT (0% to 40%), 

In the table below, the sample requirements for three RCAs have been set out. 

The graph below shows how the sample is distributed for a typical RCA. 

Sample Requirements for Different Levels of Precision 

Band District Council X City Council Y District Council Z 

1 90 - 100% 27 24 24 

2 80 - 90 % 6 6 5 

3 60 - 80% 8 5 4 

4 40 - 60% 3 1 5 

5 <40% 2 1 1 

Total 46 37 39 
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Allocation of Traffic Links to ADT Bands for Drawing Core Sample (District Council X) 
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The Core Monitoring sample required to Estimate total VKT on the District 

Council X Road Network would involve drawing: 

• 2 traffic links from those in band 5 

• 3 traffic links from those in band 4 

• 8 traffic links from those in band 3 

• 6 traffic links from those in band 2 

• 27 traffic links from those in band 1 

This provides the most efficient sample, the one that provides the desired 

precision for the smallest number of sites. 

While it may be possible to identify existing traffic monitoring sites, and any new 

sites that form part of the Rotational Monitoring, that will fall into the various 

bands, it is important to ensure that these Core Monitoring sites are selected 

randomly and in most RCAs, the existing traffic monitoring sites are biased toward 

the higher volume Roads or those with higher levels of traffic growth. 

In order to minimise the impact of such bias, but at the same time making the 

most of the existing traffic counting history, the following process should be used 

to select the Core Monitoring sites. 
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Select the Sample with a Spreadsheet 

The first step is to export all the Traffic Links to a spreadsheet, together with their 

updated Estimates of ADT. You then order the Traffic Links in terms of the 

descending value of ADT. 

 

Road 
ID 

Road Name Link 
Start 
(m) 

Link 
End 
(m) 

Link 
Length 
(m) 

RAMM 
Estimate 
(ADT) 

7001 OMAHU ROAD  (7001) 1273 1653 380 20000 

6134 ST AUBYN STREET 

EAST  (6134) 

0 208 208 20000 

7001 OMAHU ROAD  (7001) 641 1273 632 19000 

8027 HAVELOCK ROAD  

(8027) 

480 1163 683 18000 

8027 HAVELOCK ROAD  

(8027) 

1163 1584 421 18000 

6071 HERETAUNGA STREET 

WEST  (6071) 

718 911 193 18000 

      

8008 CROSSES ROAD  (8008) 90 1312 1222 4850 

3028 MIDDLE ROAD  (3028) 464 798 334 4700 

3052 TE AUTE ROAD  (3052) 443 832 389 4500 

6118 NELSON STREET 

NORTH  (6118) 

677 1071 394 4500 

6040 GROVE ROAD  (6040) 1131 1416 285 4500 

      

5051 IONA ROAD  (5051) 0 114 114 2100 

6045 HASTINGS STREET 

NORTH  (6045) 

364 480 116 2100 
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Road 
ID 

Road Name Link 
Start 
(m) 

Link 
End 
(m) 

Link 
Length 
(m) 

RAMM 
Estimate 
(ADT) 

8053 RUAHA ROAD  (8053) 1054 2771 1717 2000 

9011 CLIFTON ROAD  (9011) 432 1979 1547 2000 

2056 TAIHAPE ROAD  (2056) 0 870 870 2000 

      

5056 KEIRUN ROAD  (5056) 0 265 265 571 

7086 TARBET STREET  (7086) 0 331 331 570 

7036 WALTON WAY  (7036) 180 460 280 570 

2056 TAIHAPE ROAD  (2056) 8720 12778 4058 550 

9042 LAWN ROAD  (9042) 3952 5475 1523 550 

      

1058 WAITARA ROAD  (1058) 2076 4068 1992 170 

1058 WAITARA ROAD  (1058) 0 2076 2076 170 

1058 WAITARA ROAD  (1058) 4068 4168 100 170 

2011 DARTMOOR ROAD  

(2011) 

9764 15980 6216 169 

2049 ROTOWHENUA ROAD  

(2049) 

0 830 830 168 

      

1001 AROPAO ROAD (1001) 12225 1334 1109 5 

1026 MOKAMO ROAD (1026) 11896 12492 596 5 

4025 POPORANGI ROAD 

(4025) 

4243 4978 735 5 

1026 MOKAMO ROAD (1026) 11557 11896 339 5 
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Add Number to the Spreadsheet 

You then add an additional field called Number. You use this to number the Traffic 

Links starting at 1. Do not use a formula. Add the number as a hard value to each 

site. 

 

Road 
ID 

Road Name Link 
Start 
(m) 

Link 
End 
(m) 

Link 
Length 
(m) 

RAMM 
Estimate 
(ADT) 

No 

7001 OMAHU ROAD  (7001) 1273 1653 380 20000 1 

6134 ST AUBYN STREET 

EAST  (6134) 

0 208 208 20000 2 

7001 OMAHU ROAD  (7001) 641 1273 632 19000 3 

8027 HAVELOCK ROAD  

(8027) 

480 1163 683 18000 4 

8027 HAVELOCK ROAD  

(8027) 

1163 1584 421 18000 5 

6071 HERETAUNGA STREET 

WEST  (6071) 

718 911 193 18000 6 

       

8008 CROSSES ROAD  (8008) 90 1312 1222 4850 216 

3028 MIDDLE ROAD  (3028) 464 798 334 4700 217 

3052 TE AUTE ROAD  (3052) 443 832 389 4500 218 

6118 NELSON STREET 

NORTH  (6118) 

677 1071 394 4500 219 

6040 GROVE ROAD  (6040) 1131 1416 285 4500 220 

       

5051 IONA ROAD  (5051) 0 114 114 2100 433 

6045 HASTINGS STREET 

NORTH  (6045) 

364 480 116 2100 434 
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Road 
ID 

Road Name Link 
Start 
(m) 

Link 
End 
(m) 

Link 
Length 
(m) 

RAMM 
Estimate 
(ADT) 

No 

8053 RUAHA ROAD  (8053) 1054 2771 1717 2000 435 

9011 CLIFTON ROAD  (9011) 432 1979 1547 2000 436 

2056 TAIHAPE ROAD  (2056) 0 870 870 2000 437 

       

5056 KEIRUN ROAD  (5056) 0 265 265 571 868 

7086 TARBET STREET  (7086) 0 331 331 570 869 

7036 WALTON WAY  (7036) 180 460 280 570 870 

2056 TAIHAPE ROAD  (2056) 8720 12778 4058 550 871 

9042 LAWN ROAD  (9042) 3952 5475 1523 550 872 

       

1058 WAITARA ROAD  (1058) 2076 4068 1992 170 1302 

1058 WAITARA ROAD  (1058) 0 2076 2076 170 1303 

1058 WAITARA ROAD  (1058) 4068 4168 100 170 1304 

2011 DARTMOOR ROAD  

(2011) 

9764 15980 6216 169 1305 

2049 ROTOWHENUA ROAD  

(2049) 

0 830 830 168 1306 

       

1001 AROPAOA ROAD (1001) 12225 1334 1109 5 2170 

1026 MOKAMO ROAD (1026) 11896 12492 596 5 2171 

4025 POPORANGI ROAD 

(4025) 

4243 4978 735 5 2172 

1026 MOKAMO ROAD (1026) 11557 11896 339 5 2173 
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Add Percentage to the Spreadsheet 

You then add a second column named Percentage. Calculate this as Number/total 

number of Traffic Links. 

 

Road 
ID 

Road Name Link 
Start 
(m) 

Link 
End 
(m) 

Link 
Length 
(m) 

RAMM 
Estimate 
(ADT) 

No % 

7001 OMAHU ROAD  (7001) 1273 1653 380 20000 1 0.0% 

6134 ST AUBYN STREET 

EAST  (6134) 

0 208 208 20000 2 0.1% 

7001 OMAHU ROAD  (7001) 641 1273 632 19000 3 0.1% 

8027 HAVELOCK ROAD  

(8027) 

480 1163 683 18000 4 0.2% 

8027 HAVELOCK ROAD  

(8027) 

1163 1584 421 18000 5 0.2% 

6071 HERETAUNGA STREET 

WEST  (6071) 

718 911 193 18000 6 0.3% 

        

8008 CROSSES ROAD  (8008) 90 1312 1222 4850 216 9.9% 

3028 MIDDLE ROAD  (3028) 464 798 334 4700 217 10.0% 

3052 TE AUTE ROAD  (3052) 443 832 389 4500 218 10.0% 

6118 NELSON STREET 

NORTH  (6118) 

677 1071 394 4500 219 10.1% 

6040 GROVE ROAD  (6040) 1131 1416 285 4500 220 10.1% 

        

5051 IONA ROAD  (5051) 0 114 114 2100 433 19.9% 

6045 HASTINGS STREET 

NORTH  (6045) 

364 480 116 2100 434 20.0% 

8053 RUAHA ROAD  (8053) 1054 2771 1717 2000 435 20.0% 
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Road 
ID 

Road Name Link 
Start 
(m) 

Link 
End 
(m) 

Link 
Length 
(m) 

RAMM 
Estimate 
(ADT) 

No % 

9011 CLIFTON ROAD  (9011) 432 1979 1547 2000 436 20.1% 

2056 TAIHAPE ROAD  (2056) 0 870 870 2000 437 20.1% 

        

5056 KEIRUN ROAD  (5056) 0 265 265 571 868 39.9% 

7086 TARBET STREET  (7086) 0 331 331 570 869 40.0% 

7036 WALTON WAY  (7036) 180 460 280 570 870 40.0% 

2056 TAIHAPE ROAD  (2056) 8720 12778 4058 550 871 40.1% 

9042 LAWN ROAD  (9042) 3952 5475 1523 550 872 40.1% 

        

1058 WAITARA ROAD  (1058) 2076 4068 1992 170 1302 59.9% 

1058 WAITARA ROAD  (1058) 0 2076 2076 170 1303 60.0% 

1058 WAITARA ROAD  (1058) 4068 4168 100 170 1304 60.0% 

2011 DARTMOOR ROAD  

(2011) 

9764 15980 6216 169 1305 60.1% 

2049 ROTOWHENUA ROAD  

(2049) 

0 830 830 168 1306 60.1% 

        

1001 AROPAO ROAD (1001) 12225 1334 1109 5 2170 99.9% 

1026 MOKAMO ROAD (1026) 11896 12492 596 5 2171 99.9% 

4025 POPORANGI ROAD 

(4025) 

4243 4978 735 5 2172 100.0

% 

1026 MOKAMO ROAD (1026) 11557 11896 339 5 2173 100.0

% 
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Add AADT Band to the Spreadsheet 

Add a third column named AADT Band. Insert the following formulae: 

= if (J2<=0.1, 1, if (J2<=0.2, 2, if (J2<=0.4, 3, if (J2<=0.6, 4, 5)))) 

where J2 = the column in which the value percentage is contained. 

This will identify the AADT Band in which the Traffic Link resides. 

 

Road 
ID 

Road Name Link 
Start 
(m) 

Link 
End 
(m) 

Link 
Length 
(m) 

RAMM 
Estimate 
(ADT) 

No % AADT
Band 

7001 OMAHU ROAD  (7001) 1273 1653 380 20000 1 0.0% 1 

6134 ST AUBYN STREET 

EAST  (6134) 

0 208 208 20000 2 0.1% 1 

7001 OMAHU ROAD  (7001) 641 1273 632 19000 3 0.1% 1 

8027 HAVELOCK ROAD  

(8027) 

480 1163 683 18000 4 0.2% 1 

8027 HAVELOCK ROAD  

(8027) 

1163 1584 421 18000 5 0.2% 1 

6071 HERETAUNGA STREET 

WEST  (6071) 

718 911 193 18000 6 0.3% 1 

         

8008 CROSSES ROAD  (8008) 90 1312 1222 4850 216 9.9% 1 

3028 MIDDLE ROAD  (3028) 464 798 334 4700 217 10.0% 1 

3052 TE AUTE ROAD  (3052) 443 832 389 4500 218 10.0% 2 

6118 NELSON STREET 

NORTH  (6118) 

677 1071 394 4500 219 10.1% 2 

6040 GROVE ROAD  (6040) 1131 1416 285 4500 220 10.1% 2 

         

5051 IONA ROAD  (5051) 0 114 114 2100 433 19.9% 2 
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Road 
ID 

Road Name Link 
Start 
(m) 

Link 
End 
(m) 

Link 
Length 
(m) 

RAMM 
Estimate 
(ADT) 

No % AADT
Band 

6045 HASTINGS STREET 

NORTH  (6045) 

364 480 116 2100 434 20.0% 2 

8053 RUAHA ROAD  (8053) 1054 2771 1717 2000 435 20.0% 3 

9011 CLIFTON ROAD  (9011) 432 1979 1547 2000 436 20.1% 3 

2056 TAIHAPE ROAD  (2056) 0 870 870 2000 437 20.1% 3 

         

5056 KEIRUN ROAD  (5056) 0 265 265 571 868 39.9% 3 

7086 TARBET STREET  (7086) 0 331 331 570 869 40.0% 3 

7036 WALTON WAY  (7036) 180 460 280 570 870 40.0% 4 

2056 TAIHAPE ROAD  (2056) 8720 12778 4058 550 871 40.1% 4 

9042 LAWN ROAD  (9042) 3952 5475 1523 550 872 40.1% 4 

         

1058 WAITARA ROAD  (1058) 2076 4068 1992 170 1302 59.9% 4 

1058 WAITARA ROAD  (1058) 0 2076 2076 170 1303 60.0% 4 

1058 WAITARA ROAD  (1058) 4068 4168 100 170 1304 60.0% 5 

2011 DARTMOOR ROAD  

(2011) 

9764 15980 6216 169 1305 60.1% 5 

2049 ROTOWH ROAD  (2049) 0 830 830 168 1306 60.1% 5 

         

1001 AROPAO ROAD (1001) 12225 1334 1109 5 2170 99.9% 5 

1026 MOKAMO ROAD (1026) 11896 12492 596 5 2171 99.9% 5 

4025 POPORA ROAD (4025) 4243 4978 735 5 2172 100.0

% 

5 

1026 MOKAMO ROAD (1026) 11557 11896 339 5 2173 100.0

% 

5 
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Randomise and Select 

You then insert another column and name it Random. You apply the formulae = 

rand ( ) for each record. This will assign a random order to each record. The value 

of rand ( ) will change following any action in the spreadsheet. Once the values are 

assigned, you copy the column containing rand ( ) and using Paste Special Values 

paste a fixed set of random numbers back in to the spreadsheet. You then reorder 

the records according to their random order. 

You then start from the top of the spreadsheet, with the records in random order, 

select the first Traffic Links in each AADT Band to fill your sample requirements. 

Potential Issues 

This provides a random selected sample of Traffic Links to fill the sample. However, 

there are two possible problems: 

• the sampling frame assumes each link is essentially independent of every other link. 

This may not be true if two of the Traffic Links lie on the same Road or in a corridor 

that may be considered to carry the same traffic. 

• this random selection does not make the maximum use of the historical Traffic Counts. 

Potential Solution 

You can solve the first problem by substituting one of the first draft Core 

Monitoring sites with another site that has the same or a very similar traffic 

volume.  In this context similar would mean a site with a traffic volume of plus or 

minus 10% of the one being replaced. 

However, care should be taken to ensure that all substituted sites do not have 

higher (or lower) traffic volumes. The easiest way to do this is to ensure that the 

sum of the new AADT values for the revised list is similar, such as within 

approximately plus or minus 5% of the sum of the AADT values from the initial 

list. It should be as close as possible. 

 

 

While this process may appear cumbersome, users are required to 

perform this process only once. 

 

The selected Traffic Links from the Core Monitoring can then be identified in 

. 
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Other Monitoring Sites 

The above framework of Rotational Monitoring and Core Monitoring and sites 

has been designed to ensure the key monitoring and data needs are met. However, 

there are other Locations and Traffic Links for which the Road Controlling 

Authority (RCA) may want to monitor traffic. These could be Locations: 

• of historical interest or historical monitoring 

• where future physical works are programmed 

• that provide data for the development and calibration of traffic models, or 

• of general community interest. 

It is possible to identify these sites in  and allocate these sites a monitoring 

frequency. 

It is also possible to extend the Rotational Monitoring Framework to include the 

next level down, and define sites for the next level down in terms of contribution 

to VKT such as the next 20% to 40%. 

So if you take as an example, an RCA that undertook around 300 Traffic Counts per 

year on a Network of 2171 Carriageway Sections, then developing a Traffic Link 

model would reduce the sample population, the total number of links to 1417. 

The core sample monitored each year would 

be  

142 Traffic Counts counted every second year 

A Rotational Sample of 20% would be 283 

links or   

47 annual Traffic Counts 

A Second Tier of Rotational Sample of 30% 

spread over five years  

85 Traffic Counts in each of five years 

Total 274 Traffic Counts each year. 

A total of 274 Traffic Counts per year would ensure that 50% of the Network would 

be counted over a five year period, still leaving around 26 Traffic Counts per year 

available for one-off studies. 

You can use the Recommended Count Sites screen to identify the traffic counting 

regime at each site and select all the Count Sites which are not included in the 

programme. These can be deleted or programmed as an Ad Hoc or second tier 

rotational for future Counts. 

You use the Counting Schedule screen to list Count Sites which should be 

scheduled for counting within a set period. You can then create Dispatches in 

 so the Traffic Count Contractor knows the future count 

schedule. 
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Fine Tune Season Profile Road Type Associations 

While the current procedure for seasonal adjustment of short duration periodic 

Traffic Counts is based on allocation of each Traffic Link to one of the seven typical 

seasonal traffic profiles, a traffic monitoring programme may be constructed to 

include additional Traffic Counts to be undertaken at particular locations throughout 

the year. For example an RCA might undertake a weekly Traffic Count on a 

particular Road in each of the four seasons, six bimonthly counts or even count 

one week in each of the twelve months. These seasonal counts may assist the RCA 

to establish just which Season Profile (Road Type)is the most appropriate or even to 

develop an alternative more applicable Season Profile. 
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Once the Traffic Count Estimation set up has been completed, it is time to schedule 

the Traffic Counts. 

Traffic Counts are scheduled based on the Sample Group of the Count Sites combined 

with the date of the most recent count entered into . For instance, if a Count 

Site were in the Core Monitoring - Annual group,  would take the date of the 

most recent count and schedule another for twelve months later. 

When you have the list of Scheduled Traffic Counts, you can create Dispatches in 

 for a selected Contract. This will allow the Traffic Count 

Contractor to see what counts are required over the schedule period. 

 

 

In  Th is  Chap ter  

View Scheduled Traffic Counts on the Map ............................ 150 

View a List of Scheduled Traffic Counts .................................. 151 

Overdue Counts ........................................................................ 153 

Traffic Count Dispatches .......................................................... 153 

Asset Selection and Dispatch Creation ..................................... 154 

 
 

Traffic Count Schedule 
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View Scheduled Traffic Counts on the Map 

 can recommend scheduled Traffic Counts for you. 

Best practice is for you to let  recommend the Traffic Counts and for you to 

create Dispatches in bulk to make sure that the Traffic Counts are carried out. You 

can carry out the Recommended Traffic Counts process in  or in 

 using the Map. For more information on the process in  

see Run Recommended Count Sites Process (on page 227). 

The Map in RAMM 

To view the recommended Traffic Counts on the Map, you: 

• press  to open the Map in  

• then press  to turn on Traffic Management Mode. This makes the required tool 

bars and buttons available.  

• then press  to make the Traffic Management information display on the Map. 

Scheduled Traffic Counts 

You follow the menu path View > Scheduled Traffic Counts to start the process to 

generate a Layer on the Map of scheduled Traffic Counts recommended by . 

The Counting Schedule screen will open. You generate the scheduled Traffic Counts 

which you can then view on the Map. 

The Scheduled Traffic Counts option will become available at the Map Legend. 
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View a List of Scheduled Traffic Counts 

Once you have followed the menu path View > Create/View Scheduled Traffic Counts 

and created the Map Layer of Scheduled Traffic Counts the View/Create Traffic Links 

button  becomes available. You press this button to open the 

Counting Schedule screen. 

You run the Generate Scheduled Traffic Counts process at this screen. You can then 

create Dispatches for the Traffic Counts. The first time you run this process the 

 button will be available. Once you have pressed the button to run 

the process it changes to . 

Temporary Records Only 

When you run the Generate Scheduled Traffic Counts process at this screen, you are 

not creating permanent records. You are just running a report. So these scheduled 

Traffic Counts exist only in the report. They are not actual records in the database. It 

is the Dispatches you create as part of the Generate Scheduled Traffic Counts process 

which are recorded in the database. So it is possible to run the Generate Scheduled 

Traffic Counts process over and over. 

What Will You See in the List? 

When you first open the screen in a  session, the list of scheduled Traffic 

Counts will be empty. Once you have run the Generate Scheduled Traffic Counts 

process, the Scheduled Traffic Counts will be listed. 

If you close the screen and then open it again in the same  session, the list 

will be the same as when you last closed the screen. So it will reflect the Generate 

Scheduled Traffic Counts process which you last ran and will include any changes 

you made after running the process. 

If you close  and then open another  session, the first time you open 

the Counting Schedule screen it will be empty as you have run no processes during 

the session. After you have run the process you will see the generated list. 

Overdue Counts 

When you first run the Generate Scheduled Traffic Counts process it is likely that 

there will be Count Sites which are overdue for counting. You use the Overdue 

Counts option to manage this. See Overdue Counts (on page 153). See Overdue 

Counts Initial Selection (on page 236). 
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Date Range 

You run the Generate Scheduled Traffic Counts process for a specific date range. 

The default is from today's date to six months from now. 

Report Order 

You have the option of ordering the list by Road and Displacement order or by Count 

Due Date order. 

 

 

 

 

You may want to generate Scheduled Traffic Counts for a select range 

of Roads. This is not possible. Whether you filter the Roads in the 

Road list panel or select a number of Roads on the Map, when you 

run the Generate Scheduled Traffic Counts process,  processes 

all Roads in the Network. 

You can group Scheduled Traffic Counts by Sample Group at the Counting 

Schedule screen and you can make specific selections at the Asset 

Selection panel of the Create Dispatches screen. 
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Overdue Counts 

The first time you run the Counting Schedule report at the Counting Schedule 

screen it is likely that you will have converted to Count Sites, some historical sites at 

which counts took place. 

You will have assigned them to a Sample Group at the time of conversion. 

Potential Problem 

If, for example, the last count occurred at an historical site two years ago and you 

placed the resulting Count Site in the Core Monitoring - Annual Sample Group then if you 

run the Counting Schedule report for the default today's date to six months hence, 

 will not list the Count Site and you might not count a Road 

which needs it. 

That is because the Count Site is not due for counting. It is overdue. In this 

situation you use the Overdue Counts option. See Overdue Counts Initial Selection 

(on page 236). 

 

Traffic Count Dispatches 

When you have generated the scheduled Traffic Counts you can create Dispatches 

for them. These will be listed in . The Contractor who will 

perform the Traffic Counts can then see the future work load. 

 

 

Unless you have set up a valid Contract for Asset Type Traffic Count 

in , you will not be able to create Dispatches at 

the Create Dispatches screen. See Asset Selection and Dispatch 

Creation (on page 154). 

You will need the correct Staff Permissions for the Contract in 

 to be able to add and assign Dispatches. See 

Dispatch Creation Permissions (on page 291). 

 

When you are satisfied that you have the optimum list of scheduled Traffic Counts 

you press . This opens the Create Dispatches screen with a list of 

scheduled Traffic Counts for which you can create Dispatches. 
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Asset Selection and Dispatch Creation 

If you use different Count Durations, you will, no doubt have some way of 

prescribing this in the Dispatch. So you will want to select all the scheduled Traffic 

Counts with the same Count Duration at this screen before creating the Dispatches in 

bulk. 

 

 

Dispatch Creation 

You create the Dispatches in bulk. 
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You need to take care when creating Dispatches for scheduled 

Traffic Counts. 

If you have previously run the Generate Scheduled Traffic Counts 

process for the same date range and created Dispatches from the 

results, the scheduled Traffic Counts will be generated again unless 

the Traffic Counts have taken place and been entered into . 

So you need to set up your own internal systems to prevent the 

creation of more than one Dispatch for the same Traffic Counts. 
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Best practice is to perform the majority of Traffic Count Estimation set up and 

maintenance activities in . The Carriageway, Count Site, Traffic and Loading and 

Traffic Link Detail and Grid screens used to maintain Traffic Count Estimation items are 

available only from . 

 

 

In  Th is  Chap ter  

Carriageway ............................................................................... 158 

Count Site ................................................................................. 159 

Traffic and Loading ................................................................... 161 

Traffic Link................................................................................ 170 

Treatment Length Maintenance ............................................... 173 

Treatment Selection .................................................................. 173 

Traffic Count Estimation and RAMM 
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Carriageway 

You press  to open the Carriageway Detail screen with the details of the 

Carriageway Section selected in the adjacent Roads list panel displayed. You can 

associate a Carriageway Section with a Traffic Link at the Traffic Link tab. 

 

 

You select the Traffic Link from the Traffic Link drop-down list. The details of the 

Traffic Link will default into the ADT, Road Type and Growth Group fields. You maintain 

these values at the Traffic Link Detail screen. See Traffic Link (on page 170). 

If there is a Count Site within the Start and End of the Traffic Link which contains the 

Carriageway Section being viewed, Count Site, Road, Location, Sample Group 

Description and Count Frequency will default. You maintain these values at the Traffic 

Count Detail screen. See Count Site (on page 159). 

 

 

 Traffic Count Estimation options and functions are available 

only if you selected Yes at the Use Traffic Counting System drop-down 

list on the Traffic Counting tab of the Parameter screen in 

. 

See Setting Traffic Counting Parameters (on page 67). 
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Users will need the correct Staff Permissions to maintain data at 

the Carriageway screens. They will need at least Update Permission 

for Maintain Road Name & Carriageway Data in the Road Name & Carriageway 

Section of Core RAMM under Maintenance. See Data Maintenance Staff 

Permissions (on page 287). 

 

 
 

 

Count Site 

The Count Site Detail screen is available in . 

You press  to open the screen. If you have selected a Road in the adjacent 

Roads list panel, the details of the Count Site, if any, of the Carriageway Section 

closest to the start of the Road will be displayed. If you have selected a 

Carriageway Section, the details of the Count Site on the Carriageway Section will 

default. 

You use the Count Site screen to add and maintain Count Site records. 
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Road and Description 

When you add a Count Site you first select the Road from the adjacent Roads list 

panel. The name of the Road then defaults at the Road drop-down list and at the 

Description field. The Road drop-down list disappears when the record is saved. 

Location 

You must define the number of metres from the start of the Road at which the 

Count Site is to be located. Please note that at the adjacent Roads list panel you can 

select the Road itself or any of the Carriageway Sections.  will still add the 

Location measured from the start of the Road, not the Carriageway Section. 

 

 

You should avoid siting Count Sites closer than 100 m from an 

Intersection. 

 

Sample Group 

Sample Groups group Count Sites with the same count frequency. You count traffic 

on high volume Roads more often than on low traffic volume Roads. So you 

assign a Sample Group to each Count Site based on how often it needs to be counted, 

whether this is every year, every second year or once every five years. Even though 

the Sample Group field is not highlighted as Mandatory, you cannot add a Count Site 

record at this screen without selecting a value from the drop-down list. 

Count Site Source 

When you add a Count Site record at this screen the Source is obviously Manual. If 

you are viewing or maintaining existing records, the Source could be based on an 

Historical Site or one randomly chosen by . 

Loading Method 

You have the option of selecting the Loading Method type from the Loading Method 

drop-down list. These are for your information only and serve no functional 

purpose in . 

Site Reference 

You may have an existing Count Site identification system which you wish to retain. 

If so you add your own identifier into the Site Reference field. 
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Map Coordinates 

When you add a Count Site record at this screen, no Map Coordinates will default. 

When you add a Count Site record at the Map, the coordinates will default. 

You can add GPS Organisation, Method and Date records if you have them. These are 

for your information only and serve no functional purpose in . 

 

 

 Traffic Count Estimation options and functions are available 

only if you selected Yes at the Use Traffic Counting System drop-down 

list on the Traffic Counting tab of the Parameter screen in 

. 

See Setting Traffic Counting Parameters (on page 67). 

Staff Permissions for Count Site Data 

 

Users will need the correct Staff Permissions to maintain data at 

the Count Site screens. They will need at least Update Permission for 

Maintain Survey Data for Traffic Estimates and Counts in the Miscellaneous 

section under Maintenance. See Data Maintenance Staff Permissions 

(on page 287). 

 

 
 

Traffic and Loading 

You press  to open the Traffic and Loading screen. This screen displays General, 

Count, and Location details as well as Details of ADT and Loading. 

The information at this screen is usually populated by importing a Count data file. 

You can also manually add update and delete the data at this screen. See: 

• General (on page 162) 

This tab groups the Survey and General data for the Road and Carriageway Section. 

• Count (on page 163) 

This tab groups the information pertaining to the Count but not the ADT. 
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• Location (on page 164) 

This tab groups the Map coordinates by default or the GPS details for the Road and 

Carriageway Section if you have added them. 

• Detail (on page 165) 

This tab displays the ADT and Loading data for the Road and Carriageway Section. 

 

 

Users will need the correct Staff Permissions to maintain data at 

the Loading screens. They will need at least Update Permission for 

Maintain Survey Data for Traffic Loading in the Miscellaneous section under 

Maintenance. See Data Maintenance Staff Permissions (on page 

287). 

 
 

 

General 

You press  to open the Traffic and Loading Detail screen at the General tab. 

The details of the most recent Traffic Count, if any, on the first Carriageway Section 

of the Road selected in the adjacent Roads list panel, will be displayed. If you have 

selected a Carriageway Section, the details of the most recent Traffic Count on it will 

default. 

Normally, Traffic Counts are added by importing a data file but you can add or 

update Traffic Count data for a Carriageway Section at the Traffic and Loading Detail 

screen. 
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You add Survey and General details. 

 

 

 

Users need correct Staff Permissions to maintain data at the Traffic 

screens - Update Permission for Maintain Survey Data for Traffic Estimates 

and Counts in the Miscellaneous section under Maintenance. See Data 

Maintenance Staff Permissions (on page 287). 

 
 

 

Count 

You press  to open the Traffic and Loading Detail screen at the Count tab. 

The details of the most recent Traffic Count, if any, on the first Carriageway Section 

of the Road selected in the adjacent Roads list panel, will be displayed. If you have 

selected a Carriageway Section, the details of the most recent Traffic Count on it will 

default. 

Normally, Traffic Counts are added by importing a data file but you can add or 

update Traffic Count data for a Carriageway Section at the Traffic and Loading Detail 

screen. 

You select the Road, Carriageway and Count Site values. 

If there is no available Count Site, you press the adjacent  to open the Count Site 

Detail screen to add one.  



 

1 6 4  T r a f f i c  C o u n t  E s t i m a t i o n  
 

You add Direction, Count Date, Count Duration and Time of Day values. Day of Week, Week 

Number and Season values will default based on the Count Date. 

You specify that the status of the count data is derived from an Estimate at the 

Count Status drop-down list. 

 

 

 

Users need correct Staff Permissions to maintain data at the Traffic 

screens - Update Permission for Maintain Survey Data for Traffic Estimates 

and Counts in the Miscellaneous section under Maintenance. See Data 

Maintenance Staff Permissions (on page 287). 

 

 

 

Location 

Traffic and Loading data is related to a specific point on a Carriageway Section. 

The position of a Count Site is normally expressed as a displacement from the start 

of a Carriageway. 

If you prefer to locate your Traffic and Loading data using GPS Coordinates, you 

do this at the Location tab of the Traffic and Loading screen. 
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Detail 

You press  and then the Detail tab to open the Traffic and Loading Detail screen 

with the details displayed of the Loading settings for the Road and Carriageway 

Section selected in the adjacent Roads list panel. You can manually enter Count and 

Loading data.  

Count 

Although you can manually enter Count data, this data is more normally sourced 

from Traffic Count data import files. See Traffic and Loading Data Import (on page 

249). 

Loading 

The Heavies Percent and ESA/vehicle values default to the Traffic Link screen. See Traffic 

Link (on page 170). You update Loading information when you run Status Check. 

You can do this from the Map, see Update Traffic Counts and Estimates (on page 

204), or from . See Update Traffic Counts and Estimates (on page 

230). 

The data fields that you will see will depend on your database type. Australian 

loading classes vary from those in New Zealand. Similarly, State Highway Loading 

classes vary from those used by Territorial Local Authorities (TLAs). 
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Users will need the correct Staff Permissions to maintain data at 

the Loading screens. They will need at least Update Permission for 

Maintain Survey Data for Traffic Loading in the Miscellaneous section under 

Maintenance. See Data Maintenance Staff Permissions (on page 

287). 

 
 

 

Default Loading 

When you perform a Status Check to update Traffic and Loading Latest values, 

some Carriageway Sections will have no Traffic and Loading data to update. 

 uses default values for these Carriageway Sections. 
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Default Loading Screen 

You set up four Default Loading value sets at the Default Loading screen in 

.  selects the optimum Default Loading value set depending on the 

combination of Hierarchy and Urban/Rural values for the Carriageway Section. 

Database Type 

Your Database Type determines the Loading value set that you see. The graphic 

below displays the standard set for NZLocalAuthority. 

 

 

 

Financial Year 

You define the Financial Year for the Latest Default Loading and the Treatment 

Length Annual Summary. 
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Financial Year for Latest Traffic Loading 

The Default Loading value set includes a requirement to select the Financial Year 

for the Latest. 

 

 

Treatment Length Annual Condition Summary 

The Financial year is required for the Treatment Length Annual Condition 

summary. 

 

 

 

Survey Methods, Site Types and Loading Methods 

The method or equipment used to take a Traffic Count survey is referred to in 

 as the Survey Method, the Site Type and the Loading Method. Your 

circumstances will determine which labels are used in your database. 

Survey Method 

You can add and maintain Survey Method codes for Count Sites. These are for your 

information only and serve no function within . 

You do this at the Survey Method screen in . You follow the menu 

path Projects > Traffic Counting > Survey Method. The Survey Method screen is a standard 

 Lookup screen. 
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Site Type 

Traffic Counts taken on the New Zealand State Highway Network are assigned a Site 

Type code. This is the equivalent of a Count Survey Method code. This code 

describes the method or equipment used to take the Traffic Count survey. 

 

 

For NZ State Highway databases the Survey Method screen is 

renamed the Site Type screen to better align it with the user 

requirements 

 

Loading Method 

Values created at the Survey Method screen or the Site Type screen are available for 

selection from the Loading Method drop-down list in the General section of the 

General tab of the Count Site screen. 

 

 

Load Method 

Values created at the Survey Method screen or the Site Type screen are available for 

selection from the Load Method drop-down list in the Count section of the General 

tab of the Traffic and Loading screen. 
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. 

 

 

Traffic Link 

The Traffic Link Detail and Grid screens are available in . You press  to 

open the screen. If you have selected a Road in the adjacent Roads list panel, the 

details of the Traffic Link for the Road or Carriageway Section will be displayed. 

You use this screen to view and maintain Traffic Link data. However, it is 

recommended that if you are adding a Traffic Link you do this at the Map. See 

Recommended Traffic Links and the Map (on page 197). 

General Tab 

The main Traffic Link details are available at the General tab. 

Description 

The Traffic Link Description will be the name of the Road concatenated with the Start 

and End points of the link. An example of this could be SUNSET ROAD 0 to 243 m. If 

the Traffic Link is comprised of one or more Roads, the Traffic Link Description will be 

the names of the Roads concatenated as in the graphic below. 

AADT Estimate Band 

The AADT Estimate Band of Low, Medium or High is used for adjusting factors used to 

update ADT Estimates. 
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Road Type 

The Road Type value is used for adjusting factors used to update ADT Estimates. 

Please note that the names used for the seven default Road Types are descriptive 

although not definitive. You should study the graphs available at the following link 

to understand the traffic flow projections and associate these with Roads in your 

Network based on your knowledge and experience, rather than a strict application 

based on the Descriptions of the Road Types. See Road Type Group Graphs (on page 

211). There is also a useful flowchart to follow when deciding the correct Road 

Type for a Traffic Link. See Road Type Selection Process (on page 47). 

Growth Group 

A Traffic Growth Group is a group of Traffic Links that are believed to have 

approximately the same level of traffic growth from year to year. They are used in 

the update ADT Estimates process. There are six default Traffic Growth Groups with 

Growth 1 having the least expected growth and Growth 6 having the most. 

Related To 

If the Traffic Link does not have a Count Site, it needs to be associated with a Count Site 

through a related Traffic Link from which it gains traffic. This way ADT Estimates 

can be calculated for the Traffic Link with no Count Site. You select the Traffic Link 

which gives traffic at the Traffic Link drop-down list. You then specify, in the Take 

ADT as   % field, the expected percentage of traffic from the donor Traffic Link. 

 

 

Carriageways Tab 

There is a listing of the Carriageway Sections which comprise the Traffic Link at the 

Carriageways tab of the Traffic Links Detail screen.  
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Count Sites Tab 

The Count Sites, if any, on the Road will be listed at the Count Sites tab. 

 

 

 

 Traffic Count Estimation options and functions are available 

only if you selected Yes at the Use Traffic Counting System drop-down 

list on the Traffic Counting tab of the Parameter screen in 

. 

See Setting Traffic Counting Parameters (on page 67). 

Staff Permissions for Traffic Data 

 

Users will need the correct Staff Permissions to maintain data at 

the Traffic screens. They will need at least Update Permission for 

Maintain Survey Data for Traffic Estimates and Counts in the Miscellaneous 

section under Maintenance. See Data Maintenance Staff Permissions 

(on page 287). 
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Treatment Length Maintenance 

Traffic and Loading data for a Treatment Length is now available in the Traffic and 

Loading section on the General tab of the Treatment Length Detail screen. 

 

 

 

Treatment Selection 

Traffic and Loading data for a Treatment Selection is now available in the Traffic 

and Loading section on the General tab of the Treatment Selection Detail screen. 
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C H A P T E R  1 7  

You use the Map in  to manage almost every aspect of Traffic Count Estimation. 

You use it to create Traffic Links and Count Sites. You can use it to associate 

Carriageway Sections to Traffic Links and to associate one Traffic Link to another. You 

can show or hide Traffic data for all Roads. You use the Map to view 

Recommended Traffic Links, Recommended Count Sites and Scheduled Traffic Counts. 

See Map Features for Traffic Count Estimation (on page 176). 

 

 

In  Th is  Chap ter  

Map Features for Traffic Count Estimation ............................. 176 

Tool Bar..................................................................................... 177 

View Options............................................................................. 193 

Lookup Maintenance ................................................................ 202 

Action Option ........................................................................... 203 

Legend ....................................................................................... 207 

 
 

Traffic Count Estimation and the Map 
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Map Features for Traffic Count Estimation 

The Map in  has been optimised for Traffic Count Estimation. In particular you 

will want to familiarise yourself with the following features: 

• Tool Bar (on page 177) 

You use the Map tool bar to access all the functions and views required to manage 

 Traffic Count Estimation. 

 

 

• View Options (on page 193) 

When you are managing Traffic Count Estimation you will want specific data displayed 

on the Map depending on the task you are performing. You will want to see any 

Carriageways which are not associated with a Traffic Link, Traffic Links with no ADT 

value as well as other missing data. 

 

 

• Lookup Maintenance (on page 202) 

The relevance and accuracy of a Traffic Count is affected by a number of factors. The 

Road Type, the Count Duration of 3 Hours, 24 Hours or 7 Days, the Day of the Week on 

which the Count was taken, the Week Number, Region and Season all affect the value 

of the Traffic Count.  has preset values to adjust the raw data. In the unusual 

circumstance that these values are not accurate enough for your situation, you can edit 

the appropriate Lookups. 

 

 

• Action Option (on page 203) 

When you need the most up-to-date Average Daily Traffic (ADT) Estimate data you 

can perform a Status Check at the Map by running the Set most recent flags for Traffic 

and Loading Data process. This updates the database to take into account any Traffic 

Counts, Estimates and Loading data entered since the most recent Status Check. It then 

updates the Estimates taking into account the new readings and the other factors. It also 

creates the Traffic Latest Errors report. 
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• Legend (on page 207) 

The Map Legend has options specific to  Traffic Count Estimation. These have 

been optimised for the creation and maintenance of Traffic Links and Count Sites. 

 

 

 

Tool Bar 

You use the Map tool bar to access all the functions and views required to manage 

 Traffic Count Estimation. 

When you are managing  Traffic Count Estimation there are specific buttons 

and menu options which you will need. However, most of the time when you use 

the Map in  you will not need them and so you may want to hide them. 

Map Screen Tool Bar - Traffic Management Mode Hidden 

The default is to have Traffic Counting buttons hidden. 

 

 

Map Screen Tool Bar - Traffic Management Mode Buttons and Menus Revealed 

When you are working with Traffic Count Estimation you need to press the Traffic 

Management Mode button to reveal the menus and buttons. 
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Traffic Management Buttons 

•  Traffic Management Mode 

See above. 

•  Add a Traffic Link 

See Traffic Links (on page 179). 

•  Add a Count Site 

See Count Sites (on page 182). 

•  Add a Traffic Count 

See Traffic Counts (on page 184). 

•  Relate a Traffic Link to Another Traffic Link 

See Relate Traffic Links (on page 185). 

•  Associate a Carriageway Section to a Traffic Link 

See Associate a Carriageway Section with a Traffic Link (on page 188). 

•  Show Traffic Data for All Roads 

See Show Traffic Data for All Roads (on page 189). 

•  Refresh Traffic Counting System Data 

See Refresh the Traffic Counting Map (on page 124). 

Traffic Management Menu Options 

• View 

 

See View Options (on page 193). 

• Maintenance 

 

See Lookup Maintenance (on page 202). 

• Action 

 

See Action Option (on page 203). 
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In order to change the Map into Traffic Management Mode, a user 

must have at least Enquiry Permission for Traffic Estimates and Counts. 

See Data Maintenance Staff Permissions (on page 287). 

 

 

 

Traffic Links 

You create Traffic Links by combining Carriageway Sections. These are the building 

blocks of  Traffic Count Estimation. When using the Map you press the Add a 

Traffic Link button and then select the ones you want to link to form the Traffic Link. 

 

 

The Map as it Appears Before the Add a Traffic Link Button is Pressed 

When you first open the Map the Roads and their names are displayed. 

 

 

The Map as it Appears After the Add a Traffic Link Button Has Been Pressed 

Once you press the Add a Traffic Link button, the Carriageway Sections display. 
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Selecting Carriageway Sections for a Traffic Link 

Once you have decided which Carriageway Sections will comprise the Traffic Link 

you press the Add a Traffic Link button and select the first Carriageway Section 

which is highlighted in green. You then hold down the CTRL key on your 

keyboard and select the other Carriageway Sections in turn. 

  

 

If you select a Carriageway Section in error, you can hold down 

the SHIFT button on your keyboard and select the Carriageway 

Section again. It will then become deselected. 

If you make a complete hash of things, just click in the Map on an 

area which is not on a Carriageway Section and all the 

Carriageway Sections will become deselected. 
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When you are setting up Traffic Count Estimation, best practice is to let 

 recommend Traffic Links. So when you come to use the Add 

Traffic Link button, all Carriageway Sections will be part of a Traffic 

Link, unlike the graphic above. The button has been used before 

 has recommended the Traffic Links to make the screen shot 

easier to understand. 

 

You then press  Save Record to save your changes. The Traffic Link Detail screen 

then opens so that you can define the required details for the Traffic Link. 

 

 

 

 

 

The Traffic Links available from the Traffic Link drop-down list are 

determined by the Carriageway Sections associated with the 

Roads in the adjacent Roads list panel. You filter the Roads to limit 

the Traffic Links only to those relevant to the area on which you are 

working. 
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 names the Traffic Link using an ascending alphabetical listing 

of the Roads which contain the linked Carriageway Sections. 

 

Carriageways Tab 

There is a listing of the Carriageway Sections which comprise the Traffic Link at the 

Carriageways tab of the Traffic Links Detail screen. 

 

 

 

Count Sites 

You create Count Sites on your Traffic Links. Any actual Counts taken then apply to 

all Carriageway sections in the Traffic Link. A percentage of the actual count will also 

apply to any Carriageway sections of Traffic Links associated with the Traffic Link on 

which the Count Site is situated. When using the Map you press the Add a Count Site 

button and then position the mouse pointer over the Traffic Link where you want it 

sited. Obviously, you can do this only after you have in added your Traffic Links. 

 

 

The Map as it Appears When the Add a Count Site Button is Pressed 

When you first press the Add a Count Site button the cursor turns into a 

double-cross. 

You place the centre of the mouse pointer over the point Location on the Road 

where you want to position the Count Site. 



 

 C h a p t e r  1 7   –   T r a f f i c  C o u n t  E s t i m a t i o n  a n d  t h e  M a p  1 8 3   

 

 

Count Sites appear on the Map as blue circles with holes in the centre. 

Count Site Detail Screen 

When you press  Save Record, the Count Site Detail screen opens so that you can 

add details useful for the Count Site. 

The Sample Group shows how often a Traffic Count is to be taken at the site. See 

Sample Group (on page 221). 

The Source shows how the Count Site was created, whether: 

• Historical 

in which case it is a Count Site based on the point Location at which Counts were taken 

prior to the introduction of  Traffic Count Estimation, 

• Manual 

in which case it has been added manually as in this process, 

• Random and Random (Short Traffic Link) 

in which case it has been added automatically by  during the Recommended 

Count Sites process. See How  Recommends Count Sites (on page 102). 
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Map Coordinates 

When a Count Site is added, the Easting and Northing values from the Map will default. 

You also have the option to add GPS source information. The GPS Organisation, 

GPS Method and GPS Date values should be added only if they are useful to your 

organisation. Otherwise you should leave the fields blank. 

 

Traffic Counts 

When you have taken an actual Traffic Count, you convert the raw count data to an 

Average Daily Traffic (ADT) and enter this value into . You can do this at 

the Map at the Count Site on which the count was taken.  

To do this you open the Map so that you can see the Count Site at which the count 

was taken. 

You then press Add a Traffic Count and position the mouse pointer over the Count 

Site. 

Obviously, you can do this only after you have added your Count Sites. 

 

 

The Map as it Appears When Add a Traffic Count is Pressed 

When you press the Add a Traffic Count Site button the cursor turns into a 

double-cross. 

You place the centre of the mouse pointer over the Count Site Location on the Road 

where you took the count. 
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When you click over the Count Site the Traffic and Loading Detail screen will open. 

You then add the details of the Traffic Count. See Traffic and Loading (on page 161). 

The ADT value and the date of the Traffic Count are held against the Carriageway 

Section. 

See Carriageway (on page 158). 

 

 

These values are used for the generation of ADT Estimates when you perform a 

Status Check. 

See Update Traffic Counts and Estimates (on page 204). 

 

 

 

Relate Traffic Links 

When you have created your Traffic Links and Count Sites you can then associate the 

links with each other to reflect the manner in which the Roads in the Network are 

related to one another. You can set the Average Daily Traffic (ADT) Estimate of 

one Traffic Link to be estimated at a percentage of the original Traffic Link. This 

enhances the effectiveness of Traffic Counts.  
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When you want to relate one Traffic Link to another the most convenient method is 

to use the Map to add the information. 

You open the Map so that you can see both the Traffic Links.  

 

 

When you first press the Relate a Traffic Link to Another Traffic Link button an 

information screen will open.  

When you have read the message you can select the Don't show this message again 

option to prevent the screen opening next time you press the button. 

 

 

You then: 

1 select the secondary Traffic Link. This is the one with the lesser traffic volume. Its ADT 

will be estimated as a percentage of the primary Traffic Link 

2 select the primary Traffic Link. This is the one with the greater traffic volume which 

gives traffic to the secondary Traffic Link. 

 

 

The primary Traffic Link will then appear briefly before the Traffic Link Detail screen 

opens for you to check the details and set the ADT percentage.  will 

calculate a default ADT percentage. You can change this. 
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If you are using the Relate a Traffic Link to Another Traffic Link process and 

a screen you are expecting does not appear, or some other 

unexpected behaviour occurs, this may be because you have 

inadvertently clicked on the Map in error. 

If this happens, look under the Window menu option and if the 

Traffic Link Detail screen is listed, select it. 

You should then see what you are expected to do next. 

 

 

 

General Section 

The details of the Traffic Link you selected first will default into the upper General 

section. You can change these details if necessary. 

These should be the details for the secondary Traffic Link which will be defined as 

having an ADT as a percentage of the ADT of the primary Traffic Link. 

 

 

In the graphic above, there is no ADT value in the Traffic and Loading 

panel. This means it has not yet been set. 

Even if the Traffic Link to which it is being related has an actual 

ADT, no ADT will be set for the secondary Traffic Link until a 

Status Check has been run. See Update Traffic Counts and Estimates 

(on page 204). 
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Related To Section 

The name of the Traffic Link you selected second will default into the lower Related 

To section. 

 will calculate a default value for the Take ADT as   % field. You can 

overwrite this if required. 

This defines the percentage of the ADT of the primary Traffic Link which is 

expected on the secondary Traffic Link. 

 

 

When you relate one Traffic Link to another, you select the Traffic Link 

with less traffic as the secondary. This is then defined as having an 

ADT which is a percentage of the ADT of the primary Traffic Link. 

There is nothing to prevent you from defining a percentage of 

over 100% for the secondary Traffic Link. 

However, it would not make much sense as it is the Traffic Links 

with the higher traffic volumes which you should be counting. 

 

 

 

Associate a Carriageway Section with a Traffic Link 

You can associate a selected Carriageway Section with a contiguous Traffic Link at 

the Map. The Carriageway Section then becomes a part of the Traffic Link and shares 

its characteristics. When you have set up Traffic Links in your Network you use the 

Associate a Carriageway Section with a Traffic Link button to fine tune them. 

 

 

 

 

If you follow the menu path View > Unlinked Carriageways the 

Carriageway Sections which need to be linked become obvious 

 

The Map with the Associate a Carriageway Section with a Traffic Link Button Pressed 

Once you have pressed the Associate a Carriageway Section with a Traffic Link button, 

the Carriageway Sections and the Traffic Links display. Carriageway Sections not 

associated with Traffic Links stand out in a darker blue than the Traffic Links. 
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You select the Carriageway Section you want to attach to an existing contiguous 

Traffic Link and then select the Traffic Link. 

 

 

If you want to associate Carriageway Sections with existing Traffic 

Links which are not contiguous, you do this at the Carriageways tab 

of the Traffic Link Detail screen. 

 

 

Show Traffic Data for All Roads 

When you are managing Traffic Count Estimation you will want at least some Traffic 

data displayed on the Map. At other times you will want it hidden. 

The data you want to view on the Map when managing Traffic Count Estimation will 

depend on the task you are performing. You press the Show Traffic Data for All Roads 

button to display Traffic data on the Map. 

 

 

If all the available information is displayed on the Map it can become cluttered as in 

the graphic below.  

You use the Map Legend to determine the level of detail displayed. See Legend (on 

page 207). 
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Right-click for Details 

When the Show Traffic Data for All Roads button has been pressed to display Traffic 

Links, Carriageway Sections, or Count Sites a user is to be able to right-click on one 

of the objects and bring up the relevant Detail screen or in some cases add a 

Dispatch. 

Count Site 

 

 

When you select a Count Site and right-click you have three options: 

• Show Count Site Detail 

This opens the Count Site Detail screen with the details for the Count Site defaulted. 

You would use this option to view or edit the Count Site. 

• Add Traffic Count 

This opens the Traffic and Loading Detail screen with the Road, Carriageway and Count 

Site details defaulted. You press the four tabs in turn and add the Count details. 

• Create Dispatch 

This opens the Create Dispatch screen. This option will be available only if you have 

run the Counting Schedule report and a count has been scheduled at the Count Site. 

Carriageway Section 

 

 

When you select a Carriageway Section and right-click you have two options: 
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• Show Carriageway Detail 

This opens the Carriageway Detail screen at the General tab with the details for the 

Carriageway defaulted.  

You would use this option to view or edit the Carriageway details. The Use details 

which specify the Pavement Use Category code which shows the estimated ADT range, 

would be useful information if you were intending to attach the Carriageway Section 

to a Traffic Link.  

• Show Traffic Link Detail 

This opens the Traffic Link Detail screen at the General tab with the details for the 

Traffic Link defaulted.  

You can press the Carriageway tab to view a listing of the Carriageways which comprise 

the Traffic Link. You would use this option to decide whether to attach the Carriageway 

Section to the Traffic Link. 

This option is available only if the Carriageway Section and the Traffic Link are 

contiguous. 

Traffic Link 

 

 

When you select a Traffic Link and right-click you have two options: 

• Show Carriageway Detail 

This opens the Carriageway Detail screen at the General tab with the details defaulted 

for the first Carriageway Section of the Road you clicked which forms part of the 

Traffic Link. 

If you want to view or edit the details of a different Carriageway Section (the one on 

which you clicked for instance), you use the  and  arrows to navigate to the one 

you want. You would use this option to view or edit the Carriageway details. 

The Use details which specify the Pavement Use Category code which shows the 

estimated ADT range, would be useful information if you were intending to remove 

the Carriageway Section from the Traffic Link. 

• Show Traffic Link Detail 

This opens the Traffic Link Detail screen at the General tab with the details for the 

Traffic Link defaulted.  

You can press the Carriageway tab to view a listing of the Carriageways which comprise 

the Traffic Link. You would use this option to decide to view or edit the Traffic Link 

details. 

Latest Count 
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When you select a Latest Count and right-click you have two options: 

• Show Traffic Count Detail 

This opens the Traffic Detail screen with the details of the count defaulted. You would 

use this option to view or edit the Latest Count details. 

• Create Dispatch 

This opens the Create Dispatch screen. This option will be available only if you have 

run the Counting Schedule report and a count has been scheduled at the Count Site. 

 

 

If you want to select a Latest Count, you need to have opened the 

Map Legend and toggled Traffic Links so that they do not display. 

Otherwise when you try to select the Latest Count you will be 

able to select only the nearest Traffic Link. 

 

 

Refresh the Traffic Counting Map 

When you are creating and maintaining your Traffic Count Estimation Assets at the 

Map in  you can refresh the Map so that you can more easily view the 

changes you have made. 

 

 

See Your Changes 

When you are creating and maintaining Traffic Count Estimation at the Map in  

you may want to see your changes reflected in the Map. You see this whenever the 

Map is refreshed. If the Map auto refresh function is not updating often enough, 

you can press Refresh to view your updates. 
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View Options 

When you are managing Traffic Count Estimation you will want specific data displayed 

on the Map depending on the task you are performing. You will want to see any 

Carriageways which are not associated with a Traffic Link, Traffic Links with no ADT 

value as well as other missing data. 

Show All Roads 

This option has the same effect as pressing  Show Traffic Data for All Roads. 

See Show Traffic Data for All Roads (on page 189). 

Unlinked Carriageways 

This option is a sanity check you perform after you have set up all your Traffic Links. 

At this stage, there should be no Carriageway Sections which have not been 

associated with a Traffic Link. You select this option to see if you have missed any 

Carriageway Sections. The Map will display all Carriageway Sections which have 

not been associated with a Traffic Link. You can also use this when maintaining 

Traffic Count Estimation after set up to see if a Carriageway has been added to the 

Network without being associated with a Traffic Link. 

See Unlinked Carriageways (on page 128). 

Traffic Links with no ADT 

This option is a sanity check you perform after having set up all the Traffic Links and 

then run a Status Check to generate Latest Counts. Once you have done this, all 

Traffic Links should have an ADT. The only Traffic Links with no ADT will be those 

which are neither associated with a Traffic Link which does have an ADT nor have 

had their own reading taken. This option highlights these Traffic Links. 

See Traffic Links with No Average ADT (on page 129). 
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Missing Data > Count Sites > Sample Group 

When you are first setting up  Traffic Count Estimation, there may be legacy 

data for Count Sites which does not include a Sample Group value. Count Sites you 

set up after turning on Traffic Count Estimation cannot be saved without a Sample 

Group value. You use this menu option to display Count Sites with no Sample Group 

value. 

When you open the Count Site Detail screen to edit the Count Sites displayed you 

will not be able to save the record unless it has a Sample Group value. 

See Sample Group Data (on page 74). 

 

 

Missing Data > Latest Traffic Counts > Time of Day and Duration 

When you are first setting up  Traffic Count Estimation, there may be legacy 

data for Traffic Counts which does not include a Time of Day or Count Duration value. 

Traffic Counts you set up after turning on Traffic Count Estimation cannot be saved 

without a Time of Day or Count Duration value. You use this menu option to display 

Traffic Counts with no Time of Day or Count Duration value. 

See Count Duration Data (on page 70) and Time of Day Data (on page 72). 

When you open the Traffic Detail screen to edit the Traffic Counts displayed you will 

not be able to save the record unless it has a Time of Day and Count Duration value. 
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Unlinked Carriageways 

It is possible that some Carriageway Sections will not have been associated with a 

Traffic Link. An Average Daily Traffic (ADT) Estimate value would not be calculated 

for these Carriageway Sections unless this is corrected. 

You find these unlinked Carriageways by running the Unlinked Carriageways 

report. You do this through the Map. You can also run it from . 

See Unlinked Carriageways (on page 241). 

Unlinked Carriageways Map Layer 

When you follow the menu path View > Unlinked Carriageways  creates a Layer 

for the Map which distinguishes Carriageways with no Traffic Link defined. The 

Carriageways are obvious. 

 

 

How to Fix the Problem 

If there are a large number of items to fix, the most efficient method is to run the 

Recommended Traffic Links process again. You do this at the Recommended Traffic 

Links screen. See View a List of Recommended Traffic Links (on page 81).  

If there are only a few Carriageways, it is probably faster to use the Map. You press 

 and add the Traffic Links in the standard manner. See Associate a Carriageway 

Section with a Traffic Link (on page 188). 

 

 

In order to run the Unlinked Carriageways report a user must 

have at least Enquiry Permission for Road Name and Carriageway. 
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Traffic Links with No Average ADT 

When you have run Status Check, there may be errors reported in the resulting 

Traffic Latest Errors report. See Traffic Latest Errors Report (on page 297). 

 

 

You should locate the Traffic Links, identify and fix the problems which are causing 

the errors. You can easily identify some of the Traffic Links with problems by 

running the Traffic Links with no ADT report. You can run this report from 

within . See Traffic Links with No ADT (on page 241). 

 

 

See the Traffic Links on the Map 

You follow the menu path View > Traffic Links with no ADT. A Layer will then be 

created so that you can more easily find the Traffic Links with errors. 

When you have located the Traffic Links with errors and fixed them the Layer should 

disappear. If not, there must be more Traffic Links to fix. 
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Recommended Traffic Links and the Map 

You can manually create your own Traffic Links for your database. However, it is 

more efficient to accept the  Recommended Traffic Links which are 

contiguous Carriageway Sections from the same Road that have the same Average 

Daily Traffic (ADT) Estimate value, plus or minus 10%. 

 

 

Do not start the Recommended Traffic Links process until the Update 

Traffic Counts and Estimates process is complete and any problems 

with your legacy data are fixed. Otherwise you will be making 

your decisions based on outdated ADT Estimate and Latest 

Count data. See Update Traffic Counts and Estimates (on page 230). 

 

You follow the menu path View > Recommended Traffic Links to generate a Layer on 

the Map of Traffic Links recommended by . A screen will show the progress in 

the Layer generation. The recommended Traffic Links will then display in the Map. 

More options will become available at the Map Legend. 

 

 

View/Create Traffic Links Button 

When the View > Recommended Traffic Links process is completed,  

becomes available. You press it to open the Recommended Traffic Links screen. See 

View a List of Recommended Traffic Links (on page 81). 
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Once the Recommended Traffic Links have been created, you relate them to each 

other. You do this through the Map to deal with the Traffic Links individually. If you 

want to accept the recommended Traffic Links in bulk, you should press the 

View/Create Traffic Links button and use the Recommended Traffic Links screen. 

You may find that you need to press the View/Create Traffic Links button and that it 

has disappeared even though the View > Recommended Traffic Links menu option is 

selected. In this situation you open the Map Legend and select the Recommended 

Traffic option. The button will then reappear. 

 

 

 

 

 

It is not possible to generate Recommended Traffic Links for a select 

range of Roads even if you filter the Roads in the Road list panel 

or select Roads on the Map. You can only filter the list of 

Recommended Traffic Links.  

Selected Recommended Traffic Links 

When you open the Recommended Traffic Links screen you can filter the Roads to 

limit the list to Roads in a particular area with similar ADT band. Then when you 

close the screen you will be returned to the Map and the recommended Traffic Links 

will be displayed. You can then work your way through the highlighted Roads. 
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Recommended Count Sites and the Map 

When you have created your Traffic Links you then create Count Sites on them. 

Although you could start from scratch when creating Count Sites for your database, 

it is more efficient to let  recommend them for you. If you accept the 

recommendations, you can edit them later. 

 

 

You should start the Recommended Count Sites process after you 

have completed the Recommended Traffic Links process and before 

you begin the process of associating Traffic Links. Once you have 

added the Recommended Count Sites the associating Traffic Links 

process is more obvious and logical. See Traffic Link Association (on 

page 112). 

 

 will add a Count Site to all Traffic Links with no associated Traffic Link. 

 

 

When you set up your Traffic Link associations you do so in a series of hierarchical 

Parent/Child relationships so that when you perform a Traffic Count on the 

uppermost of the Parent Traffic Links the reading will filter down to all the 

subsidiary Traffic Links as per the percentages defined. 

The Traffic Link which is at the top of the hierarchical relationships of the Parent 

Traffic Links will have no Related To values. This is because it does not have an 

Average Daily Traffic (ADT) Estimate calculated as a percentage of another Traffic 

Link. So it needs to have its traffic counted. 

 

 

When you set the Traffic Counting parameters at the Parameter screen 

in  you set a Network Coverage  % of VKT value. 

 highlights the Recommended Count Sites which represent 

the value you set. So even though initially  will 

recommend a Count Site for each Traffic Link you can clearly see the 

Count Sites which you will want to create.  

 



 

2 0 0  T r a f f i c  C o u n t  E s t i m a t i o n  
 

You follow the menu path View > Recommended Count Sites to start the process to 

generate a Layer on the Map of Count Sites recommended by . A screen will 

open showing the progress in the Layer generation. When the process is 

completed, the Recommended Count Sites will display in the Map. More options 

will become available at the Map Legend. 

 

 

View/Create Count Sites Button 

 

 

When the View > Recommended Count Sites process is completed the View/Create Count 

Sites button becomes available. You press this button to open the Recommended 

Count Sites screen. See View a List of Recommended Count Sites (on page 97). 

Once the recommended Count Sites have been created, you need to decide which 

ones to accept. You do this through the Map if you are going to deal with the Count 

Sites individually. If you want to accept the recommended Count Sites in bulk, you 

should press the View/Create Count Sites button and use the Recommended Count Sites 

screen. 

You may find that you need to press the View/Create Count Sites button and that it 

has disappeared even though the View > Recommended Count Sites menu option is 

selected. In this situation you open the Map Legend and select the Recommended 

Count Sites option. The button will then reappear. 
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You may want to generate recommended Count Sites for a select 

range of Roads. This is not possible. Whether you filter the Roads 

in the Road list panel or select a number of Roads on the Map, 

when you follow the menu path View > Recommended Count Sites 

 processes all Roads in the database with no Count Sites. 

You can however, filter the Roads at the Recommended Count Sites 

screen to limit the selected recommended Count Sites displayed on 

the Map. 

 

Selected Recommended Count Sites 

When you open the Recommended Count Sites screen you can filter the Roads to 

limit the list to Roads in a particular geographical area. Then when you close the 

screen you will be returned to the Map and the recommended Traffic Links will be 

displayed. 

You can then work your way through the recommended Count Sites. 

 

 

 

 

View Scheduled Traffic Counts on the Map 

 can recommend scheduled Traffic Counts for you. 

Best practice is for you to let  recommend the Traffic Counts and for you to 

create Dispatches in bulk to make sure that the Traffic Counts are carried out. You 

can carry out the Recommended Traffic Counts process in  or in 

 using the Map. For more information on the process in  

see Run Recommended Count Sites Process (on page 227). 
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The Map in RAMM 

To view the recommended Traffic Counts on the Map, you: 

• press  to open the Map in  

• then press  to turn on Traffic Management Mode. This makes the required tool 

bars and buttons available.  

• then press  to make the Traffic Management information display on the Map. 

Scheduled Traffic Counts 

You follow the menu path View > Scheduled Traffic Counts to start the process to 

generate a Layer on the Map of scheduled Traffic Counts recommended by . 

The Counting Schedule screen will open. You generate the scheduled Traffic Counts 

which you can then view on the Map. 

The Scheduled Traffic Counts option will become available at the Map Legend. 

 

 

 

Lookup Maintenance 

The relevance and accuracy of a Traffic Count is affected by a number of factors. The 

Road Type, the Count Duration of 3 Hours, 24 Hours or 7 Days, the Day of the Week on 

which the Count was taken, the Week Number, Region and Season all affect the value 

of the Traffic Count.  has preset values to adjust the raw data. In the unusual 

circumstance that these values are not accurate enough for your situation, you can 

edit the appropriate Lookups. 
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Lookups 

You can maintain the Traffic Count Estimation Lookups from the Map. The 

maintenance screens are available from the Maintenance menu option. 

The same options are available in . 

See Road Types and Correction Factors (on page 210), Growth Group Factors (on 

page 219) and Sample Group (on page 221). 

 

 

You should take great care before changing default values. Unless 

you understand the model at the highest level and can relate it to 

the Roads in your Network, you should use the default values. 

Lookup Maintenance 

If you do make changes to Lookups such as the seven default Road Types, you 

should remember that their names are descriptive although not definitive. 

You should study the graphs at the following link to understand the traffic flow 

projections and associate these with Roads in your Network based on your 

knowledge and experience, rather than a strict application based on the 

Descriptions of the Road Types. 

See Road Type Group Graphs (on page 211). 

 

Action Option 

When you need the most up-to-date Average Daily Traffic (ADT) Estimate data 

you can run the Update Traffic Estimates process from the Action menu of the Map. 

You run the process to generate ADT Estimates for all Carriageway Sections and 

to set them as Latest values. This process also generates Loading Estimates for all 

Carriageway Sections taking into account the new readings and other factors. 

See Update Traffic Counts and Estimates (on page 204). 

This performs a Status Check for the Set most recent flags for Traffic and Loading data 

option. 

This updates the database to take into account any Traffic Counts and Estimates 

entered since the most recent Status Check. It then updates the ADT Estimates 

taking into account the new readings and the other factors. 
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When to Update Loading Counts and Estimates 

Best practice is to run the Status Check process prior to setting up  Traffic 

Count Estimation so that you are using the latest data. Standard practice is then not to 

run the Update Traffic Estimates process until you have set up  Traffic Count 

Estimation. 

You then run it after you have run the Update Traffic Counts and Estimates process to 

produce the Traffic Latest Errors report as a data sanity check. 

You would typically run the process once a year after you have imported the file 

with the Traffic Counts and Loading data. 

 

 

You can run this process at the Status Check screen in 

. See Update Traffic Counts and Estimates (on page 230). 

 

 

Update Traffic Counts and Estimates 

When you need the most up-to-date Average Daily Traffic (ADT) Estimate data 

you can perform a Status Check at the Map by running the Set most recent flags for 

Traffic and Loading Data process. This updates the database to take into account any 

Traffic Counts, Estimates and Loading data entered since the most recent Status 

Check. It then updates the Estimates taking into account the new readings and the 

other factors. It also creates the Traffic Latest Errors report. See Traffic Latest 

Errors Report (on page 297). 

Menu Path 

You follow the menu path Action > Update Traffic Estimates to run a Status Check to 

update the Traffic Counts and Estimates. 
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When to Update Traffic Counts and Estimates 

Best practice is to run the Status Check process prior to setting up  Traffic 

Count Estimation so that you are using the latest data. Standard practice is then not to 

run the Update Traffic Counts and Estimates process until you have set up  

Traffic Count Estimation. 

You then run it to produce the Traffic Latest Errors report as a data sanity check. 

You would typically run the process once a year after you have imported the file 

with the Traffic Counts. 

 

 

 

 

 

Reduce Estimate Records 

A large number of Estimate records are created when you are setting up Traffic 

Count Estimation. You can now reduce that number by having  overwrite 

records when sensible. 
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Status Check Option 

When the Traffic Count Estimation process is run in Status Check, the final step is to 

create Estimate records for each Carriageway Section. If you do not wish to create 

large numbers of Estimates you can choose to overwrite the existing record rather 

than to create new ones. 

You specify, in the Existing Carriageway Traffic and Loading records section, that if the 

age of the records is equal to or less than a particular number of days old, they are 

overwritten. 
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Legend 

The Map Legend has options specific to  Traffic Count Estimation. These have 

been optimised for the creation and maintenance of Traffic Links and Count Sites. 

View > Recommended Traffic Links 

When you follow the menu path View > Recommended Traffic Links  runs a 

process to create Recommended Traffic Links. It places the results in a temporary 

table. These Recommended Traffic Links display on the Map. You use the Legend to 

understand what you see. 

 

 

You can turn Traffic Links, Latest Counts, Count Sites and Carriageway Sections on or off. 

The  button becomes available. You press this to open the 

Recommended Traffic Links screen. See View a List of Recommended Traffic Links (on 

page 81). 

At this screen you are presented with the complete list of Recommended Traffic 

Links. You can filter the list to work on discrete areas of the Network. If you select 

the Recommended Traffic Links on which you want to work, these will display as in 

the Legend below and those not selected will be differentiated as in the Legend 

above. 

View > Recommended Count Sites 

When you follow the menu path View > Recommended Count Sites  runs a 

process to create Recommended Count Sites. It places the results in a temporary 

table. These Recommended Count Sites display on the Map. You use the Legend to 

understand what you see. 
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You can turn Scheduled Traffic Counts, Traffic Links, Latest Counts, Count Sites and 

Carriageway Sections on or off. 

The  button becomes available. You press this to open the 

Recommended Count Sites screen. See View a List of Recommended Count Sites (on 

page 97). 

At this screen you are presented with the complete list of Recommended Count 

Sites. You can filter the list to work on discrete areas of the Network. If you select 

the Recommended Count Sites on which you want to work, these will display as in 

the Legend above and those not selected will be differentiated as in the Legend 

above. 

You can also see Recommended Count Sites which were based on an existing Count 

Site 

For general information on the Map see the Mapping chapter of the Using RAMM 

guide. 
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Users who prefer to use screen-based processes can perform all the Traffic Count 

Estimation activities from within  rather than using the Map from 

within . Some actions, such as associating Traffic Links will always be easier 

from the Map as you can see the contiguous Traffic Links. 

Best practice is to perform the majority of Traffic Count Estimation set up and 

maintenance activities in  using the Map. See Traffic Count Estimation and the 

Map (on page 175). 
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Traffic Count Estimation and RAMM Manager 
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Where Are the RAMM Manager Functions? 

All the Traffic Count Estimation functions are available from the menu path Projects > 

Traffic Counting. This includes the reports and the Lookup maintenance screens. 

Where a New Zealand State Highway database is used the menu path will be 

Projects > TMS. 

 

 

 

Road Types and Correction Factors 

When a Traffic Count is performed on a Road, you enter the Average Daily Traffic 

(ADT) into . These data are updated when Status Check is run. The ADTs 

are corrected by a variety of factors to create ADT Estimates. The Correction 

Factors vary dependent on the Road Type. 

There are seven default Road Types used for  Traffic Count Estimation. Default 

factor profiles exist for: 

• Urban Arterial/Commuter 

• Urban Commercial 

• Urban Industrial 

• Urban/Rural Boundary 

• Rural 

• Summer Recreational 

• Winter Recreational. 

 

 

You should take great care before changing default values. Unless 

you understand the model at the highest level and can relate it to 

the Roads in your Network, you should use the default values. 
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Road Type Group Graphs 

The names used for the seven default Road Types are descriptive, not definitive. 

You should study the graphs below to understand the traffic flow projections and 

associate these with Roads in your Network based on your knowledge and 

experience, rather than a strict application based on the Road Types Descriptions. 

Urban Road Types Graph 

 

 

Rural and Seasonal Road Types Graph 
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Correction Factors Screen 

You use this screen to view and maintain the information recorded in the Road 

Type table. 

 

 

You should take great care before changing default values. Unless 

you understand the model at the highest level and can relate it to 

the Roads in your Network, you should use the default values. 

You access the screen in  by following the menu path Projects > 

Traffic Counting > Correction Factors. 

You access the screen in  by opening the Map, pressing Traffic Management 

Mode  and following the menu path Maintenance > Correction Factors. 

 

 

Correction Factors 

For each Road Type value there are default Correction Factors. 

If you have sufficient data and experience with your Network traffic flows you can 

define your own values to replace the defaults: 

• Part Day 

You define these at the Part Day tab. 

See Part Day Factors (on page 213). 
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• Week Day 

You define these at the Week Day tab. 

See Week Day Factors (on page 214). 

• Week Number 

You define these at the Week Number tab. 

See Week Number Factors (on page 215). 

• Region 

You define these at the Region tab. 

See Region Factors (on page 216). 

• Season Profile 

You define these at the Season Profile tab. 

See Season Profile Factors (on page 217). 

Default Road Types 

The seven default Road Type values are available at the Road Type drop-down list on 

the General tab of the Traffic Links maintenance screen. This is a mandatory field. 

You use the Road Type selection flowchart to assist in the selection of the correct 

Road Type for a Traffic Link. See Road Type Selection Process (on page 47). 

 

 

 

Part Day Factors 

You use the Part Day tab of the Road Type and Multiplication Factors screen to view and 

maintain the information recorded in the Part Day Factor table. 

Estimates generated by  on the basis of a Traffic Count of 3 Hour duration will 

differ dependent on whether they were taken in the morning or in the afternoon. 

So  Traffic Count Estimation uses different factors in calculations to take this 

into account. Of course, these values will vary by Road Type. 
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The Morning and Afternoon factors vary depending on the Road Type selected in the 

(unnamed) Road Type list panel. 

 

 

You should take great care before changing default values. Unless 

you understand the model at the highest level and can relate it to 

the Roads in your Network, you should use the default values. 

Traffic Screen 

Time of Day values are used at the Traffic screen in . You select a Time of Day 

value at the drop-down list only if the Count Duration is 3 Hours. 

 

 

 

Week Day Factors 

You use the Week Day tab of the Road Type and Multiplication Factors screen to view 

and maintain the information recorded in the Week Day Factor table. Estimates 

generated by  on the basis of a Traffic Count of 3 Hour or 24 Hour duration will 

differ dependent on the day of the week on which they were performed. So 

 Traffic Count Estimation uses different factors in calculations to take this into 

account. Of course, these values will vary by Road Type. 
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The Week Day factors vary depending on the Road Type selected in the (unnamed) 

Road Type list panel. 

 

 

You should take great care before changing default values. Unless 

you understand the model at the highest level and can relate it to 

the Roads in your Network, you should use the default values. 

Traffic Screen 

When the Count Date value is selected from the drop-down list,  calculates 

the day of the week on which the Traffic Count has taken place. The appropriate 

Week Day values are then used in  calculations.  

 

 

 

Week Number Factors 

You use the Week Number tab of the Correction Factors screen to view and maintain 

the information recorded in the Week Number Factor table. Estimates 

generated by  on the basis of a Traffic Count of 3 Hour, 24 Hour or 7 Day 

duration will differ dependent on the week of the year in which they were 

performed. So  Traffic Count Estimation uses different factors in calculations to 

take this into account. 
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Week Number factors vary depending on the Road Type selected in the (unnamed) 

Road Type list panel. There are fifty three Week Number values for each of the three 

AADT Estimate Bands. 365 and 366 (the number of days in a normal and leap year) 

cannot be divided equally by 7 (the number of days in a week). So there will 

always be a short week at the end of every year. The week 53 value is always the 

same as the value for week number 1. 

 

 

You should take great care before changing default values. Unless 

you understand the model at the highest level and can relate it to 

the Roads in your Network, you should use the default values. 

 calculates the Week Number values from the Count Date at the Traffic screen. 

 

 

 

Region Factors 

You use the Region tab of the Correction Factors screen to view and maintain the 

information recorded in the Region Factor table. 

Estimates generated by  on the basis of a Traffic Count will differ dependent 

on the Region in which they were performed. So  Traffic Count Estimation 

uses different factors in calculations to take this into account. Of course, these 

values will vary by Road Type. 
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The Region factors vary depending on the country of operation and the Road Type 

selected in the (unnamed) Road Type list panel. At the time of publication, all 

Region factors have been set at 1. 

 

 

You should take great care before changing default values. Unless 

you understand the model at the highest level and can relate it to 

the Roads in your Network, you should use the default values. 

Parameter Screen 

You set your Region at the Parameter screen in  when you first set 

up Traffic Count Estimation. The correct Region factors are then used in all Traffic Count 

Estimation Estimate calculations. See Traffic Counting Parameters (on page 62). 

 

 

 

Season Profile Factors 

Traffic volumes on particular Traffic Links vary throughout the year. This seasonal 

variation depends on the function of the Traffic Link. For example, a Road to a 

popular beach is likely to be used more in the summer months than in the winter. 

Conversely a Road servicing an industrial area will typically carry less traffic during 

the weekend and over the Christmas to New Year period. So the traffic counted in 

a particular week may not accurately represent the Average Daily Traffic (ADT). 
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An analysis of the seasonal variation in traffic volumes for different Roads suggests 

that there are at least seven very different Season Profiles. These typical profiles 

provide seasonal adjustment factors that can be applied to the Traffic Count 

undertaken in a particular week to provide a better Estimate of the ADT. Selection 

of the most appropriate profile for a particular Traffic Link should be based on a 

comparison of the predefined Season Profiles and the actual seasonal profile of the 

Traffic Link. You should use the Road Type selection process flow diagram to assist in 

making this decision. See Road Type Selection Process (on page 47). However, 

when using this diagram, it is important to remember that the questions and 

answers relate to the Season Profile of the traffic on the Road, not to the type of 

Road or its allocation in a Road hierarchy. 

While the current procedure for seasonal adjustment of short duration periodic 

Traffic Counts is based on allocation of each Traffic Link to one of the seven typical 

traffic Season Profiles, a traffic monitoring programme may be constructed to 

include additional Traffic Counts to be undertaken at particular locations throughout 

the year. For example a Road Controlling Authority (RCA) might undertake a 

weekly Traffic Count on a particular Road in each of the four seasons, six bimonthly 

counts or even count one week in each of the twelve months. These seasonal 

counts may assist the Authority to establish just which Season Profile is the most 

appropriate or even to develop an alternative more applicable Season Profile. 

Season Profile Tab 

You use the Season Profile Day tab of the Correction Factors screen to view and 

maintain the information recorded in the Season Profile Factor table. 

Estimates generated by  on the basis of a Traffic Count will differ dependent 

on the Season during which they were performed. So  Traffic Count Estimation 

requires different factors in calculations to take this into account. Of course, these 

values will vary by Road Type. 

 

 

Season Profile factors vary depending on the Road Type selected in the (unnamed) 

Road Type list panel. Default Multiplication Factors have been defined for Season and 

AADT Estimate combinations for each of the four currently defined Regions.   
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You should take great care before changing default values. Unless 

you understand the model at the highest level and can relate it to 

the Roads in your Network, you should use the default values. 

When the Count Date value is selected from the drop-down list,  calculates 

the day of the week, number of the week of the year and the Season in which the 

Traffic Count has taken place. The appropriate Season Profile values are then used in 

Traffic Count Estimation Estimate calculations.  

 

 

 

Growth Group Factors 

You use the Traffic Growth Group screen to view and maintain the information 

recorded in the Growth Group table. 

A Traffic Growth Group is a group of Traffic Links that are believed to have 

approximately the same level of traffic growth from year to year. They are used in 

the update Average Daily Traffic (ADT) Estimates process.  averages the 

actual Traffic Counts for Count Sites on Traffic Links in the Traffic Growth Group, 

ignoring any greater than one and one half standard deviations above or below the 

mean growth for the group. Having found the average annual traffic growth, 

 applies this factor to previous ADT Estimates where there has been no 

count in the current year. 

Daily Traffic Growth Calculation 

You can associate a Traffic Link with a Traffic Growth Group at the Map in  but if 

you want to see the results of the Daily Traffic Growth Calculation you do this in 

 at the Traffic Growth Group screen. 

You access the screen in  by following the menu path Projects > 

Traffic Counting > Growth Group. 
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There are six default Traffic Growth Groups with Growth 1 having the least 

expected growth and Growth 6 having the most. Each Traffic Link is allocated to a 

Traffic Growth Group. When you are creating Traffic Links it is sensible to group them 

by Traffic Growth Group. See Saving Recommended Traffic Links (on page 90). 

 

 

This allows a previous ADT Estimate at a site that has not been counted in the 

current year to be updated using the average traffic growth recorded at other 

similar sites that have been counted in the current year. 

The same mechanism ensures that all Estimates are updated to the current date. 

 

 

When calculating the traffic growth for a Traffic Growth Group,  

finds all the actual Traffic Counts for Count Sites on Traffic Links in the 

Traffic Growth Group. 

It then averages the growth factors for all these Traffic Counts except 

that it ignores any which are greater than one and one half 

standard deviations above or below the mean growth for the 

group. 
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Sample Group 

You use the Traffic Sample Group screen to view and maintain the information 

recorded in the Sample Group table. 

Sample Groups group Count Sites with the same count frequency. You count traffic 

on high volume Roads more often than on low traffic volume Roads. So you 

assign a Sample Group to each Count Site based on how often it needs to be counted, 

whether this is every year, every second year or once every five years. 

You access the screen in  by following the menu path Projects > 

Traffic Counting > Sample Group. 

 

 

There are nine default Sample Groups with self-explanatory Descriptions. You can 

add your own, setting the Count Frequency in years to match your business 

requirements. 

Each Count Site is allocated to a Sample Group. This identifies how often traffic is to 

be counted at the site. When you are creating Traffic Links it is sensible to give them 

a default Sample Group and then to select the actual Sample Group when you are 

associating Traffic Links. See Updating Count Site Sample Group Values (on page 122). 

Count Site Screen 
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Traffic Counting Header 

When you import Traffic and Loading Count data, you use a Traffic Counting Header 

to group and identify the Counts. For State Highway databases this is called a 

Survey Header. 

Traffic Counting Headers are defined and maintained at the Traffic Counting Header 

screen. This is available in  from the menu path Projects > Traffic 

Counting > Traffic Counting Header. 

 

 

Traffic and Loading Import 

The Traffic and Loading Import screen is available from the File Import menu path of the 

Traffic Counting Header screen. If you use this to access the Traffic and Loading Import 

screen, the data imported is associated with the selected Traffic Counting Header. 

 

 

TMS Import Process 

If you are using the TMS (Traffic Management System) import function then any 

Traffic Counting Headers (called Survey Headers) you use must exist in all your 

 databases. If it does not yet exist across all databases you use  copy 

functions to copy the new header to the databases. 
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Recommend Traffic Links 

You use the Recommended Traffic Links screen to run the process to have  

recommend Traffic Links. You then use it to save the Traffic Links in bulk, grouped by 

Road Type, Traffic Growth Group and AADT Band. 

Traffic Links are combinations of sequential  Carriageway Sections that are 

considered to carry the same volume of traffic over the entire length of the link. 

You access the screen in  by following the menu path Projects > 

Traffic Counting > Recommend Traffic Links. 
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Process All Roads 

When you press  the Recommend Traffic Links dialog will open. 

 

 

There are two options: 

• Process Roads with no Traffic Links 

This is the default. Any Roads which have already been made into Traffic Links are 

ignored in the process. So if you are creating Traffic Links in groups, rather than all at 

once, the list of Recommended Traffic Links will shorten each time you run the process. 

• Process all Roads 

This creates Recommended Traffic Links for all Roads in the Network. It does this for 

each Road, whether or not Traffic Links have been created for the Road. You would use 

this when you wanted to view Traffic Links which you have already created as well as 

the ones recommended by . You can see in the graphic above that Aberdeen 

Road and Acacia Road have already been made into Traffic Links. 

Temporary Records Only 

Running the Recommend Traffic Links process does not create permanent records. 

These Recommended Traffic Links are sitting in a temporary table. They become 

actual records in the database only when you have selected the Recommended 

Traffic Links and pressed Save Traffic Links . 

Recommended Traffic Links Process 

 selects all the records from the Carriageway table. It then 

sorts them into Road and Start Displacement order.  then takes 

the Traffic ADT Estimate from each Carriageway record in turn and rounds it to 

the nearest 100 vehicles. It uses this information to recommend Traffic Links. 

See How  Recommends Traffic Links (on page 86). 
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Accept Recommended Traffic Links 

Best practice is to create Traffic Links in bulk at the Recommended Traffic Links screen. 

You do this by selecting the check boxes adjacent to the Recommended Traffic Links 

and then pressing the Save Traffic Links button. This opens the Bulk Set Traffic Link 

Fields screen. 

 

 

You select the values which match the characteristics of the Traffic Links, press OK 

and the Traffic Links are created. Each Traffic Link has associated parameters which are 

used in the creation of Estimates. These depend on the Road Type, Traffic Growth 

Group and AADT Band. 

Road Type 

The Road Type is one of the factors which affect traffic volumes on a Road. For 

instance, a Road which is an access route to a ski field in winter will have a 

different usage pattern from one which is used to access a popular beach in 

summer. Similarly, Roads used for industry will have different usage patterns from 

those used as main arterial routes for commuters. You use the Road Type selection 

flowchart to assist in the selection of the correct Road Type for a Traffic Link. See 

Road Type Selection Process (on page 47). 

There are seven default Road Types used for  Traffic Count Estimation. 

Traffic Growth Group 

A Traffic Growth Group is a group of Traffic Links that are believed to have 

approximately the same level of traffic growth from year to year. They are used in 

the update Average Daily Traffic (ADT) Estimates process.  averages the 

actual Traffic Counts for Count Sites on Traffic Links in the Traffic Growth Group, 

ignoring any greater than one and one half standard deviations above or below the 

mean growth for the group. Having found the average annual traffic growth, 

 applies this factor to previous ADT Estimates where there has been no 

count in the current year. 
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AADT band 

The Annual Average Daily Traffic (AADT) count is a figure to describe traffic 

levels for the length of a Network. 

Traffic Links are grouped dependent on whether they have a High, Medium or Low 

AADT Band. 

 

 

When you save Recommended Traffic Links you assign Road Type, 

Traffic Growth Group and AADT Band values in bulk. So it makes sense 

to filter the Recommended Traffic Links before you save them. 

 

Filter the Recommended Traffic Links 

How you filter the Recommended Traffic Links to group Roads with the same Road 

Type, Traffic Growth Group and AADT Band will depend on your Road Network and 

your knowledge of the same. 

Obvious filter parameters are the Pavement Use, Urban/Rural and Hierarchy options. 

 

 

 

Recommend Count Sites 

Count Sites in  are the Locations at which Traffic Counts will occur. They are 

positioned on a Traffic Link. 

You use the Recommended Count Sites screen to run the process to have  

recommend Count Sites. 
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You then use it to save the Count Sites in bulk. 

Default Sample Group Value 

Best practice when you save the Count Sites is to give them all a default Sample 

Group value. 

You then allocate the correct value when associating Traffic Links. 

See Updating Count Site Sample Group Values (on page 122). 

You access the screen in  by following the menu path Projects > 

Traffic Counting > Recommend Count Sites. 

 

 

 

Run Recommended Count Sites Process 

You press  to run the Recommend Count Sites process. There are 

two ways that  selects a Location for a Count Site.  Firstly it looks at the 

historical record of Traffic Counts and recommends that these Locations become 

Count Sites. Then, it randomly picks a Location somewhere along a Traffic Link 

which has no associated Traffic Link. See How  Recommends Count Sites (on 

page 102). 
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Temporary Records Only 

When you run the Recommend Count Sites process at this screen, you are not 

creating permanent records. These Recommended Count Sites are sitting in a 

temporary table. They become actual records in the database only when you have 

selected the Recommended Count Sites and pressed . 

What Will You See in the List? 

The list of Recommended Count Sites will be the same as when you last closed the 

screen. So it will reflect the Recommend Count Sites process which you last ran and 

will include any changes you made after running the process. So the first time you 

open the screen it will be empty as you have run no processes. 

This means that if you work on the Recommended Count Sites, close , open 

it again and return to the screen, you can begin where you left off as your work has 

been preserved in the temporary table. 

Existing Count Sites 

When you run the Recommend Count Sites process, existing Count Sites, if any, will 

be listed. They will be readily identifiable as the Already Exists check box will be 

selected and the record will be highlighted in grey. 

 

 

Accept Recommended Count Sites 

 lists the Recommended Count Sites in descending order of 

Vehicle Kilometres Travelled (VKT). You select the Recommended Count Sites 

which you want to accept and then save them. 

A percentage of the Recommended Count Sites will be highlighted. This will be the 

group of Count Sites which represent the percentage of your Network Vehicle 

Kilometres Travelled (VKT) which you set when you first defined the initial Traffic 

Count Estimation parameters at the Parameter screen in . The 

percentage is the value which you typed at the Network Coverage  % of VKT field. 
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You press Select Top % of VKT  to select these highlighted Count Sites. 

 

 

Sample Group 

Sample Groups group Count Sites with the same count frequency. You count traffic 

on high volume Roads more often than on low traffic volume Roads. So you 

assign a Sample Group to each Count Site based on how often it needs to be counted, 

whether this is every year, every second year or once every five years. 

Each Count Site must have an associated Sample Group parameter which is used to 

determine when a Traffic Count will next be scheduled at the Count Site. So when 

you accept one or more Recommended Count Sites you must assign them a Sample 

Group. 

 

 

When you save Recommended Count Sites you assign Sample Group 

values in bulk. So you can filter and group the Recommended 

Count Sites which require the same Sample Group value before you 

save them. 

You can also just give all the Count Sites a temporary Sample Group 

value and correct this as part of a future process. See Updating 

Count Site Sample Group Values (on page 122). 

 

Filter the Recommended Count Sites 

If you decide to filter the Recommended Count Sites to group Roads with the same 

Sample Group value, your filter parameters will depend on your Road Network and 

your knowledge of the same. The obvious filter parameter is the VKT. 
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Select the Recommended Count Sites 

You can select all the filtered and grouped Recommended Count Sites by pressing 

. Then when you close the Recommended Traffic Links screen you will be returned 

to the Map and the recommended Count Sites will be displayed. 

Best practice is to select Count Sites in bulk at the Recommended Count Sites screen. 

You do this by selecting the check boxes adjacent to the Recommended Count Sites 

and then pressing Save Count Sites . This opens the Bulk Set Traffic 

Link Fields screen. 

Bulk Set Count Site Fields 

 

 

You select the value which match the characteristics of the Count Sites, press OK and 

the Count Sites are created. 

 

Update Traffic Counts and Estimates 

When you need the most up-to-date Average Daily Traffic (ADT) Estimate data 

you can perform a Status Check for the Set most recent flags for Traffic and Loading Data 

option. 

This updates the database to take into account any Traffic Counts and Estimates 

entered since the most recent Status Check. It then updates the ADT Estimates 

taking into account the new readings and the other factors. It also creates the 

Traffic Latest Errors report. See Traffic Latest Errors Report (on page 297). 

Menu Path 

You follow the menu path Processes > Status Check. This opens the Status Check 

screen. You then select the Set most recent flags for Traffic and Loading data option to 

run a Status Check to update the Traffic Counts and Estimates. 
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Options 

When you press , the Traffic Latest Task Options dialog opens. 

 

 

You then have three option sections: 

• Traffic Latest Selection (on page 232) 

• Auto Update Pavement Use (on page 232) 

• Existing Carriageway Traffic and Loading Records (on page 234). 

When to Update Traffic Counts and Estimates 

You would typically run the Status Check process once a year after you have 

imported the file with the Traffic Counts. 
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Prior to activating Traffic Count Estimation you should run the Status 

Check Set most recent flags for Traffic and Loading Data option. Then when 

you are setting up Traffic Links and other items you will be using the 

most up-to-date ADT Estimate data.  

Then when you have completed Traffic Count Estimation set up you 

Update Traffic Counts and Estimates to update the database to take into 

account any Traffic Counts and Estimates entered since the most 

recent Status Check. It then updates the ADT Estimates taking 

into account the new readings and the other factors. 

 

 
 

Traffic Latest Selection 

In the Latest Traffic Selection section you have the option to have Status Check 

process All Traffic Records or Only Traffic Records that are out of date. If you accept the 

latter default option, you will save processing time. 

 

Auto Update Pavement Use 

You then make your selection in the Auto Update Pavement Use section to determine 

if  will update the Carriageway Section Pavement Use values or if you will do 

this yourself. 

What is Pavement Use? 

In the Pavement section at the General tab of the Carriageway Detail screen there is a 

(Pavement) Use field as below. 

 

 

The Pavement Use for a Carriageway Section is one of seven Average Daily Traffic 

(ADT) bands. These are the range in which the expected ADT will fall. The value 

in the Use field is likely to be an Estimate and, if this is the first time you have run 

Set most recent flags for Traffic and Loading data Status check, since setting up Traffic 

Count Estimation, it may be some time since the value was updated. 
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So there is potential for this value to change for a large number of Carriageway 

Sections. 

Automatically Update Carriageway Pavement Use 

If you are confident that your calculations and assumptions were correct when 

setting up Traffic Count Estimation, and in particular, when you associated Traffic Links, 

you should accept the default Automatically update carriageway pavement use from the 

Latest Estimate option. 

Warn When Pavement Use Differs 

If you want to be able to check that your calculations and assumptions were 

correct when setting up Traffic Count Estimation, and in particular, when you 

associated Traffic Links, you should select Print a warning when pavement use differs from 

the Latest Estimate. 

That way you can use the resulting report to check the reason why a Latest 

Estimate would be different from the range in which the ADT was expected to 

fall. 

Traffic Latest Errors Report 

The Traffic Latest Errors report becomes available when you have run Status 

Check. It lists errors such as where no Estimate has been created or duplicate 

readings have occurred. 

If you selected Print a warning when pavement use differs from the Latest Estimate at the 

Traffic Latest Task Options dialog, the report will also list where the Latest Estimate 

differed from the Pavement Use. 

This results in the errors displayed below such as Pavement Use (7) conflicts with ADT 

(1377). 
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Existing Carriageway Traffic and Loading Records 

In the Existing Carriageway Traffic and Loading records section you determine whether 

 will overwrite existing records rather than creating new ones and storing 

the previous ones. 

Multiple Records 

When you are setting up Traffic Count Estimation you will probably run Status Check 

several times in quick succession. This will create a large number of Latest records. 

There is probably no reason to keep these. 

You can select the Overwrite recent records option. Any Latest records younger than 

the number of days in the Leave records older than   days field will then be 

overwritten and discarded during the Status Check process. 

This has the advantage of not adding unwanted records to your database. 

 

Counting Schedules 

Once the Traffic Count Estimation set up has been completed, it is time to schedule 

the Traffic Counts. 

Traffic Counts are scheduled based on the Sample Group of the Count Sites combined 

with the date of the most recent count entered into . For instance, if a Count 

Site were in the Core Monitoring - Annual group,  would take the date of the 

most recent count and schedule another for twelve months later. 

When you have the list of Scheduled Traffic Counts, you can create Dispatches in 

 for a selected Contract. This will allow the Traffic Count 

Contractor to see what counts are required over the schedule period. 

 

 

Counting Schedule Screen 

You follow the menu path Projects > Traffic Counting > Counting Schedule to open the 

Counting Schedule screen. 
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You select a date range and press  to run the report. 

The button then changes to  as in the graphic below. 

 

 

 

Temporary Records Only 

When you run the Generate Scheduled Traffic Counts process at this screen, you are 

not creating permanent records. You are just running a report. So these scheduled 

Traffic Counts exist only in the report. They are not actual records in the database. It 

is the Dispatches you create as part of the Generate Scheduled Traffic Counts process 

which are recorded in the database. So it is possible to run the Generate Scheduled 

Traffic Counts process over and over. 

 

 

You may want to generate Scheduled Traffic Counts for a select range 

of Roads. This is not possible. Whether you filter the Roads in the 

Road list panel or select a number of Roads on the Map, when you 

run the Generate Scheduled Traffic Counts process,  processes 

all Roads in the Network. 

You can group Scheduled Traffic Counts by Sample Group at the Counting 

Schedule screen and you can make specific selections at the Asset 

Selection panel of the Create Dispatches screen. 
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Overdue Counts 

The first time you run the Counting Schedule report at the Counting Schedule 

screen it is likely that you will have converted to Count Sites, some historical sites at 

which counts took place. 

You will have assigned them to a Sample Group at the time of conversion. 

Potential Problem 

If, for example, the last count occurred at an historical site two years ago and you 

placed the resulting Count Site in the Core Monitoring - Annual Sample Group then if you 

run the Counting Schedule report for the default today's date to six months hence, 

 will not list the Count Site and you might not count a Road 

which needs it. 

That is because the Count Site is not due for counting. It is overdue. In this 

situation you use the Overdue Counts option. See Overdue Counts Initial Selection 

(on page 236). 

 

Overdue Counts Initial Selection 

When you first run the Counting Schedule report at the Counting Schedule screen, 

what you should do and what you will see will depend on your circumstances. 

Before you proceed you need to know how the Overdue Counts option operates. 

 

 

When you select a date range at the Start End and End Date drop-down calendars, 

the resulting list will contain only those Traffic Counts which are scheduled for the 

period. It will not include Traffic Counts which were scheduled earlier or later than 

the dates selected. So the first time you run this report you may want to select the 

Overdue Counts option and accept the default date range. 

When you press  you will be presented with two grouped lists of 

Scheduled Counts. There will be those Due within Period and those Overdue before 

Period. 
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You could then check each of those in the Overdue before Period group and filter out 

those which you do not want to count before creating Dispatches for them. 

Overdue Counts Option - Normal Selection 

When you have your Traffic Count programme running well, you should have no 

reason to select the Overdue Counts option as all the required counts should been 

made. 

You would select the option only in order to check that the Traffic Count 

programme is up to date. 

 

Traffic Count Dispatches 

When you have generated the scheduled Traffic Counts you can create Dispatches 

for them. These will be listed in . The Contractor who will 

perform the Traffic Counts can then see the future work load. 

 

 

Unless you have set up a valid Contract for Asset Type Traffic Count 

in , you will not be able to create Dispatches at 

the Create Dispatches screen. See Asset Selection and Dispatch 

Creation (on page 154). 

You will need the correct Staff Permissions for the Contract in 

 to be able to add and assign Dispatches. See 

Dispatch Creation Permissions (on page 291). 

 

When you are satisfied that you have the optimum list of scheduled Traffic Counts 

you press . This opens the Create Dispatches screen with a list of 

scheduled Traffic Counts for which you can create Dispatches. 
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Sanity Check Reports 

Some traffic records which existed prior to the set up and use of  Traffic 

Count Estimation will be missing the data required to enable it to work properly. 

There are three  reports which you use to check your data and to 

perform sanity or completeness checks on the Traffic Link information: 

• Missing Data Report 

This lists Count Sites with no Sample Group and Latest Traffic Counts with no Time of 

Day and Count Duration values. See Missing Data (on page 238). 

• Unlinked Carriageways Report 

This locates and lists Carriageways which do not form part of a Traffic Link. See 

Unlinked Carriageways (on page 241). 

• Traffic Links with no ADT Report 

This lists Traffic Links for which no ADT Estimate exists. There are clearly problems 

with such Traffic Links which you need to fix. See Traffic Links with No ADT (on page 

241). 

 

Missing Data 

You should check your Traffic Link and the Latest Traffic Count data and fix any errors 

before you run the Status Check to generate Latest Estimates. You locate the errors 

by running the Missing Data report. 

Missing Data Report Options 

You can run the report for Count Site Sample Groups, as well as the Time of Day and 

Count Duration values for Latest Traffic Counts. 
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Missing Data Report 

Once you have pressed  the report runs and the Missing Data screen opens. 

In the graphic below there are no reported errors. 

 

 

Fixing the Data 

When you have run the report and have a list of errors you can print out the 

report. You then log in to  and fix the errors. There is no link directly to 

the records from the report. 

 

Missing Sample Group Data 

Sample Groups group Count Sites with the same count frequency. You count traffic 

on high volume Roads more often than on low traffic volume Roads. So you 

assign a Sample Group to each Count Site based on how often it needs to be counted, 

whether this is every year, every second year or once every five years. 

 Traffic Count Estimation uses criteria including the Sample Group of a Count Site 

to fine tune ADTs. If your legacy data does not include Sample Group values, you 

need to add it. 

 

 

 

 

Count Sites do not exist before Traffic Management Mode has been 

turned on. So under normal circumstances there will be no legacy 

Count Sites. If you have added Count Site records using  it 

is possible to create them without Sample Group values. These are 

the only records which would display. 
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Missing Count Duration Data 

The accuracy of a Traffic Count is affected by its duration. The longer the duration 

of the count, the more accurate it is. There are three standard Count Durations in 

 being 3 hours, 24 Hours and 7 Days. 

If your legacy data does not include Count Duration information, you need to add it. 

If the Count Durations are for 3 Hours you will also need to add Time of Day values. 

 

 

 

Missing Time of Day Data 

The time of day affects the volume of traffic which will travel along a Road. Traffic 

Counts taken in the morning are likely to vary from those taken in the afternoon. 

 Traffic Count Estimation uses a Time of Day factor to account for this when a 

Traffic Count is taken, unless it is for 24 hours or for 7 days. 

If your legacy data does not include Time of Day information for Traffic Counts with a 

Count Duration value of 3 Hours, you need to add it. 
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Unlinked Carriageways 

It is possible that some Carriageway Sections will not have been associated with a 

Traffic Link. An Average Daily Traffic (ADT) Estimate value would not be calculated 

for these Carriageway Sections unless this is corrected.  

This situation could occur during the set up of  Traffic Count Estimation if 

Carriageway Sections are inadvertently ignored in the Traffic Link creation process. 

It could also occur if new Carriageway Sections are added to the database but not 

associated with a Traffic Link at the time they are added. 

You follow the menu path Projects > Traffic Counting > Unlinked Carriageways to run the 

Unlinked Carriageways report. 

 

How to Fix the Problems 

If there is a large number of items to fix, the most efficient method is to run the 

Recommended Traffic Links process again. You do this at the Recommended Traffic 

Links screen. See Generating Recommended Traffic Links (on page 87).  

If there are only a few Carriageways, it is probably faster to use the Map. You log in 

to  and open the Map, press  and link the Carriageways to existing Traffic 

Links in the standard manner or create new Traffic Links using the unlinked 

Carriageways. See Associate a Carriageway Section with a Traffic Link (on page 188). 

 

Traffic Links with No ADT 

When you have run Status Check, there may be errors relating to Traffic Links with 

no Average Daily Traffic (ADT) reported in the resulting Traffic Latest Errors 

report. See Traffic Latest Errors Report (on page 297). 

So it may make more sense to run the Traffic Links with no ADT report to find 

the Traffic Links and fix the errors prior to running Status Check. 
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You follow the menu path Projects > Traffic Counting > Traffic Links with No ADT. You 

can then print out the list of Traffic Links. Correcting problems is easiest from the 

Map in . See Map View Options (on page 193). 

 

 

 

Traffic Headers 

When you are importing your Traffic Count data you may want to group it with a 

Traffic Header. If so you first need to create the Traffic Header. 

You do this at the Traffic Counting Header screen in . You follow 

the menu path Projects > Traffic Counting > Traffic Counting Header. 

 

 

This is a standard  maintenance screen. You add and maintain 

Traffic Headers in the standard  manner. 

 

Survey Methods 

You can add and maintain Survey Method codes for Count Sites. These are for your 

information only and serve no function within . 

You do this at the Survey Method screen in . You follow the menu 

path Projects > Traffic Counting > Survey Method. The Survey Method screen is a standard 

 Lookup screen. 
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For NZ State Highway databases the Survey Method screen is 

renamed the Site Type screen to better align it with the user 

requirements 

 

Loading Method 

Values created at the Survey Method screen are available for selection from the 

Loading Method drop-down list in the General section of the General tab of the Traffic 

and Loading screen. 

 

 

Load Method 

Values created at the Survey Method screen are available for selection from the Load 

Method drop-down list in the Count section of the General tab of the Traffic and 

Loading screen. 

. 
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Site Type for NZ State Highways 

For NZ State Highway databases, the Survey Method screen is replaced by the Site 

Type screen. The  menu path becomes Projects > Traffic Counting > 

Site Type. 

The Site Type codes become available at the same screens as the Survey Method 

codes. The fields are renamed Site Type. 

You can add and maintain Site Type codes for Count Sites. These are for your 

information only and serve no function within . 

 

Vehicle Classification 

The Vehicle Classification screen is for the definition and maintenance of Vehicle 

Classification codes. 

 will have preloaded the correct Vehicle Classification codes for your database 

type. So it is unlikely that you will need to add a new Vehicle Classification code or 

redefine an existing one. 

Active and Inactive Codes 

You have the option to make individual codes Active or Inactive. You do this by 

following the menu path Actions > Active. 

Delete Codes 

You can delete those Vehicle Classification codes which you have added yourself. You 

cannot delete  Controlled codes. If you delete your own codes you may 

lose your data. 
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Traffic and Loading Values 

Default Vehicle Classification codes and codes which you create and activate at the 

Vehicle Classification screen become available in the Count and Loading sections on the 

Detail tab of the Traffic and Loading screen. 

 

 

 

Default Loading 

When you perform a Status Check to update Traffic and Loading Latest values, 

some Carriageway Sections will have no Traffic and Loading data to update. 

 uses default values for these Carriageway Sections. 
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Default Loading Screen 

You set up four Default Loading value sets at the Default Loading screen in 

.  selects the optimum Default Loading value set depending on the 

combination of Hierarchy and Urban/Rural values for the Carriageway Section. 

Database Type 

Your Database Type determines the Loading value set that you see. The graphic 

below displays the standard set for NZLocalAuthority. 
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If you use  to manage your Network, you need to be 

aware that there are now some elements which take  Traffic Count Estimation 

into account. 

For more information on  see the relevant chapter of 

the Working with RAMM guide. 

 

 

In  Th is  Chap ter  

Traffic Link Information ........................................................... 248 

 

 

 

Traffic Count Estimation and RAMM Network Manager 
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Traffic Link Information 

If you are editing a Road or Carriageway Section in  it 

is likely that you will not have to make any changes to take into account Traffic 

Count Estimation. 

Edit Carriageway Sections 

For instance,  will reverse any Traffic Links for a Road if 

you reverse it. If you delete a Carriageway Section,  

will make the appropriate changes to the Traffic Link. 

Add Carriageway Sections 

If you are adding a new Carriageway Section, you can associate it with a Traffic Link 

at the Traffic Link tab on the Carriageway tab. 

 

 

 

 

If, as part of the process of adding a new Carriageway Section you 

need to create a new Traffic Link for the Carriageway Section, you 

do not do this in . 

You log in to  and add the new Traffic Link at the Map. 
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When importing Traffic and Loading count data into  you have a 

specialised data file import option. You use this rather than the generic 

 Import File option. 

Most users will follow the menu path in the graphic below. State Highway 

databases use the Traffic Monitoring System (TMS) for their Traffic and Loading 

data. So their menu option is TMS Import rather than Import Counts. 

 

In  Th is  Chap ter  

Traffic and Loading Data File Import Process.......................... 251 

Loading the Data File ................................................................ 253 

Link Data to RAMM Columns ................................................. 255 

Layout File ................................................................................. 262 

Data Validation .......................................................................... 267 

Data Correction and Excel ........................................................ 269 

Duplicate Checks ...................................................................... 273 

Move and Process Data ............................................................. 277 

Traffic and Loading Data Import 
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Traffic and Loading Data File Import Process 

You follow these steps to import your Traffic and Loading data into . 

Step Action Comments 

 

Load your data file. Your Traffic and Loading data needs to be entered 

into  so that Traffic Count Estimation can use it 

to update your Network ADTs. You load the data file 

into the Traffic and Loading Import screen before you 

validate the data and move it to . 

See Loading the Data File (on page 253). 

 

Link your data columns. Once your Traffic and Loading count data is loaded 

into the temporary table you need to link the import 

data file columns with the  database columns. 

See Linking Your Data to the  Columns (on 

page 260). 

 

Save a layout file for future 

use. 

You can create and save a layout file which includes 

the correct column links from your import data to the 

 table columns. Then when you import 

Traffic and Loading data, you import the layout file as 

well to correctly link the columns by default. 

See Saving a Layout File (on page 264). 

 

Validate the data.  validates the Traffic and Loading data which 

you have loaded into the temporary table. It then 

presents you with a list of errors and warnings. 

See Validating Data (on page 267). 

 

Correct the data. You correct your data errors in the Correct Data 

screen or external to  in an Xcel spreadsheet. 

See Data Correction and Excel (on page 269) and 

Data Correction in  (on page 270). 

 

Check for duplicates After data validation, you check whether similarities 

in secondary key values suggest record duplication. 

Duplicate records in a  database distort 

processes and outcomes. Duplication of record 

primary keys is corrected during data validation. 

See Checking for Duplicates (on page 274). 
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Move the data into  

and process it. 

The last step in the process to load Traffic Counts into 

the  database is to move the data into  

and process it. You cannot do this until the data is 

validated and the data errors fixed. 

See Moving and Processing Data (on page 278). 

 

 

Your Data Must Match Your Network Type 

The standard  Import File process has been simplified for the 

import of  Traffic Count Estimation Traffic and Loading data. A File Import 

process specific to Traffic Count Estimation has been designed to expect that there will 

be a single import file which matches a single table in the  database. 

Your Network Type 

There are currently three different  user Network types: 

• NZ Local Authority 

• NZ State Highway 

• WA Local Shire. 

Traffic and Loading data from different Network types is not compatible as each 

has a different Traffic and Loading dataset. The Traffic and Loading data table in 

 is defined dynamically to match the client dataset. 

The Traffic and Loading Import data import process is matched to your database type 

and Network type. 

 

 

 

Import File Types 

The data file you import must be of a type compatible with the  File Import 

process. Data can be imported in: 

• a delimited text file .txt 

This is a text file in which the data is separated by a character called a delimiter. You 

can use any character you like. The comma, pipe and tab are the normal delimiters 
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• an unload file .unl 

This is an Informix binary file created by the UNLOAD command. 

• an unload command file .ucd 

This is an unstructured cell data format. 

 

Loading the Data File 

Introduction 

Your Traffic and Loading data needs to be entered into  so that Traffic Count 

Estimation can use it to update your Network ADTs. You load the data file into the 

Traffic and Loading Import screen before you validate the data and move it to . 

Before you do this you need to have: 

• created the data file from your Traffic and Loading program. This must be in a 

compatible format. See Import File Types (on page 252). 

• created, if required, the layout file for your Traffic and Loading data. This must be in a 

compatible format. See Saving a Layout File (on page 264). 

• logged in to . 

Menu Path 

Follow the menu path Projects > Traffic Counting > Import Counts to open the Traffic and 

Loading Import screen. 

►  Load ing  the  Da t a  F i l e  

 

 

To do this you follow these steps: 

1 Press . 

The Load Dialog - Select the file to load dialog will open. 
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2 Press  adjacent to the File to load field. 

The Select File to Load from dialog will open. 

 

 

3 Navigate to and select the data file to import. 

4 Press . 

The Select File to Load from dialog will close and you will be returned to the Load 

Dialog - Select the file to load dialog. 

5 Do you want to load a layout file? See Saving a Layout File (on page 264). 

Yes then go to step 6. 

No then go to step 9. 

 

6 Press  adjacent to the Optional layout file field. 

The Open dialog will open. 

7 Navigate to and select the layout file to import. 

8 Press . 

The Open dialog will close and you will be returned to the Load Dialog - Select the file 

to load dialog. 
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9 Press . 

The Load Dialog - Specify the field delimiter screen will open. 

 

10 In the Delimiter section, select the delimiter used in the file. 

11 Ensure that the number in the Heading Lines field matches the number of lines used 

by the heading data in your data file. 

12 Press . 

The Load Dialog - Specify the format of dates in load file dialog will open. 

13 In the Import Data Date Format section, select the format for the dates to be used in the 

load file. The example will change dynamically as you make your selections. 

14 Press . 

The Load Dialog - Specify how to interpret the data in load file dialog will open. 

15 You now need to link the columns in your data import file with the  database 

columns. Go to Linking Your Data to the  Columns (on page 260). 

 

Link Data to RAMM Columns 

When you import Traffic and Loading data into  you need to map your 

import data columns to the appropriate  data table columns. 

If your data columns have the same names and data types,  Traffic Loading 

and Import will automatically map the columns. If not, you need to map them 

manually. You do this at the Load Dialog - Specify how to interpret the data in load file 

dialog. 
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Linked Data 

The columns in the data file which has been loaded will be linked to the  

database columns automatically during the load process. You can see which import 

data columns have been linked by the Linked icon which appears adjacent to the 

column name. The location column in the graphic above is the only one which has 

not been linked. 

Data Required 

The columns in the import data file which are highlighted in red, such as the 

road_id column above, may not have null values. 

 

Traffic Counting Header 

When you import Traffic and Loading Count data, you use a Traffic Counting Header 

to group and identify the Counts. For State Highway databases this is called a 

Survey Header. 

Default Traffic Counting Header 

You can access the Traffic and Loading Import screen from either the: 

•  menu path Projects > Traffic Counting > Import Counts. See Loading 

the Data File (on page 253). 

• menu path File > Import from the Traffic Counting Header screen. See Traffic Headers 

(on page 242). 

If you access the Traffic and Loading Import screen from the  menu 

path, there will be no default import data survey_number column linked with the 

destination survey_number column unless you are reimporting your own Count 

data which you had previously exported. 
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If you access the Traffic and Loading Import screen from the Traffic Counting Header 

screen, the import data survey_number column will be linked with the destination 

survey_number column. The default values will be the number of the Survey 

Header which was selected when the screen was opened using the File > Import 

menu path. 

 

 

 

Import Tool Bar 

There is an Import tool bar for linking and unlinking columns and manipulating 

data. The buttons are available only when it is logical for them to be available. 

 

 

Buttons 

The buttons are: 
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•  Unlink All By Name 

Press this button to break all links between the import file columns and the  

columns where the column names are the same. 

 

 

•  Unlink 

Press this button to break the link between a highlighted import file column and the 

highlighted  column. The Linked icon adjacent to the import column will 

disappear. The header cell for the import file will be cleared. 

•  Link 

Press this button to link the highlighted import file column with the highlighted 

 column. 

 

•  Unlink All 

Press this button to break all links between the import file columns and the  

columns whether or not the column names are the same. 

•  Clear Field Value 

Press this button to clear the value in the (unnamed) Importing from File field. This 

prevents data from the selected data import column from being imported from the data 

import file. 

•  Set to Default Value 

Press this button to set all the values in a selected  column to the default values. 

This button is available only when a default value for a highlighted  column 

exists. 

•  Set to the Default for All Unassociated Fields 

Press this button to set all the values in all  columns which both have a default 

value set and are not linked to a data import column. 

 

Unique Record IDs 

Each record which you move into the  database must have a unique ID. 

For Traffic and Loading import data this ID is traffic_loading_id. 
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Import Fresh Data 

When you are importing new count data,  adds the column traffic_loading_id 

to the import table. 

When you are linking your import data columns, you should ensure that 

traffic_loading_id is not linked and that it has a column value of 0 (zero). 

 then will populate this column with unique values when the data is moved 

to . 

 

 

Import Extracted Data 

If you have extracted Traffic and Loading count records from the  database 

and, having manipulated them, wish to reimport them, you need to consider how 

to handle traffic_loading_id. If you: 

• want to keep the unique traffic_loading_id values which you extracted, then you need to 

import the traffic_loading_id column and link it to the  column of the same 

name 

• do not want to keep the unique traffic_loading_id values, then you should not import 

the traffic_loading_id column. You should ensure that traffic_loading_id is not linked and 

that it has a column value of 0 (zero) as if you were importing fresh data. 
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Financial Year for Traffic and Loading 

If the Traffic and Loading data file imported does not include the Financial Year 

for the Traffic and Loading records,  adds this by default. Financial Years 

run from July to June. 

This makes possible the summary of Traffic and Loading for each Financial Year. 

See Financial Year (on page 167). 

 

 

 

Linking Your Data to the RAMM Columns 

Introduction 

Once your Traffic and Loading count data is loaded into the temporary table you 

need to link the import data file columns with the  database columns. 

Before you do this you need to have: 
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• completed steps 1-15 of Loading the Data File. See Loading the Data File (on page 

253). 

Menu Path 

Follow the menu path steps 1-15 of Loading the Data File to open the Load Dialog - 

Specify how to interpret the data in load file dialog. 

►  L ink ing  Your  Da ta  to  t he  RAMM Co lumns  

 

 

To do this you follow these steps: 

1 What you must do depends on whether you are importing fresh Traffic and Loading 

count data or you are importing data which you have previously extracted from the 

 database? 

If then 

you are importing fresh Traffic and Loading 

count data 

go to step 2. 

you are importing Traffic and Loading count 

data which you previously extracted from the 

 database and do not have unique 

traffic_loading_id values 

go to step 2. 

you are importing Traffic and Loading count 

data which you previously extracted from the 

 database and their traffic_loading_id 

values are unique 

the traffic_loading_id import column will be 

linked by default to the  database 

traffic_loading_id column. Accept the default. 

Go to step 6. 

 

2 In the Fields in traffic_loading_import table panel, select traffic_loading_id. 

3 If  traffic_loading_id is linked to a  database column, press  to unlink it. 
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4 Type 0 (zero) in the This column requires a value field. 

5 Select another column name in the Fields in traffic_loading_import table panel. 

The value of 0 (zero) will be set for all traffic_loading_id column fields. When the 

records are moved to the  database,  will create unique record IDs. 

6 Select and highlight an import data column which is not linked to a  database 

column and is not traffic_loading_id. These import columns have no adjacent Linked 

icon. 

7 Select and highlight the  database column into which you want to import the 

column data. 

8 Press . 

A Linked icon will appear adjacent to the data import column name. The name of the 

data import column will appear in the header row above the  database column 

name. The columns are now linked. 

 

 

9 Is there another unlinked data import column (other than traffic_loading_id)? 

Yes then go to step 6. 

No then go to step 10. 

 

10 Check the data in the columns. If there are unlinked columns with no data press  

to fill the columns with default values where appropriate. 

11 You now have the option of saving the import Layout you have created as a layout file. 

Go to Saving a Layout File (on page 264). 

 

Layout File 

When importing a Traffic and Loading count data file you have the opportunity to 

import a layout file at the same time. 

Layout files are .ucl files which map data import file columns to  database 

columns. You import them at the same time as you import your data files so that 

your data columns will be linked to the appropriate  database columns by 

default. You will then not have to link them manually.  

You would do this if the layout of the data import file did not match the columns 

of the  table for the Traffic and Loading data. 
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You create a layout file when you are importing Traffic and Loading data. See 

Loading the Data File (on page 253). 

 

 

 

Create a Layout File 

When you first import a Traffic and Loading file you will have to specify how to 

interpret the data in the load file if your data file did not match the columns of the 

 table. 

You have the option to export the Layout you have created so that when you 

import data files in the future, you do not have to match up the data columns to 

those of the  table. 

You do this during the data import process. See Loading the Data File (on page 

253). 
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Save Layout As 

You use the Save as dialog to save the .ucl layout file. You also have the option to 

save the data with the layout file if this is useful. 

The default folder in which the file will be saved is My Data Sources under My 

Documents. 

 

 

Notes 

Information you write in the Notes field becomes visible on the Load Dialog - Select 

he file to load dialog when the layout file is selected at the Optional layout file field. 

This can be a useful confirmation that the correct layout file has been selected. 

 

 

 

Saving a Layout File 

Introduction 

You can create and save a layout file which includes the correct column links from 

your import data to the  table columns. Then when you import Traffic and 

Loading data, you import the layout file as well to correctly link the columns by 

default. 

Before you do this you need to have: 

• completed steps 1-11 of Linking Your Data to the  Columns. See Linking Your 

Data to the  Columns (on page 260). 
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Menu Path 

Follow the menu path steps 1-11 of Linking Your Data to the  Columns to 

open the Load Dialog - Specify how to interpret the data in load file dialog. 

►  Sav ing  a  Layou t  F i l e  

 

 

To do this you follow these steps: 

1 Do you want to save this import Layout for future imports? 

Yes then go to step 2. 

No then go to step 5. 

 

2 Press . 

The Load Dialog - Save the load file format or load dialog will open. 

 

 

3 View the data import settings. Slide the scroll box to make the values visible if 

necessary. 
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4 Press . 

The Save as dialog will open. 

 

5 Do you want to save the data as well as the import Layout? 

Yes then go to step 6. 

No then go to step 11. 

6 Select the Save data with layout file (*ucd) option. 

The fields in the (unnamed) Details section will become available. 

7 Type the correct details in the Organisation, User Name and Recipient fields. 

8 Type, in the Notes field, any information relevant to a user who might use this layout 

file in future data imports. Information you write in the Notes field becomes visible on 

the Load Dialog - Select the file to load dialog when the layout file is selected at the 

Optional layout file field. This can be a useful confirmation that the correct layout file 

has been selected. See Layout File (on page 262). 

9 Type the name for the file in the File name field. By default the file will be saved in 

your My Data Sources folder. 

If then 

you want the layout file to be saved in your 

My Data Sources folder 

type the file name in the File Name field. 

you want to overwrite another layout file press . Navigate to the file. 

Press . 

you want to store the layout file in a folder 

other than the default 

press  . Navigate to the folder. Type the file 

name in the File Name field. 

Press . 

 

10 Press . 

The Save as dialog will close and you will be returned to the Load Dialog - Save the 

load file format or load dialog. 



 

 C h a p t e r  2 0   –   T r a f f i c  a n d  L o a d i n g  D a t a  I m p o r t  2 6 7   

11 Go to Validating Data (on page 267). 

 

Data Validation 

When you have linked the columns in your Traffic and Loading data import file 

you then load the data into a temporary table. 

 then validates the data. This can take some time. 

Errors and Warnings 

Once validation is complete, you are offered a report listing the data errors and 

warnings explaining the nature of the errors. 

Until you have corrected or removed the erroneous data, you cannot move the 

data from the temporary table into . 

 

 

Validating Data 

Introduction 

 validates the Traffic and Loading data which you have loaded into the 

temporary table. It then presents you with a list of errors and warnings. 

Before you do this you need to have: 

• completed steps 1-11 of Saving a Layout File. See Saving a Layout File (on page 264). 
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Menu Path 

Follow the menu path steps 1-11 of Saving a Layout File to open the Load Dialog - 

Save the load file format or load dialog. 

►  Va l ida t i ng  Da ta  

 

 

To do this you follow these steps: 

1 Press . 

2 Does a Confirmation dialog open? 

Yes then go to step 3. 

No then go to step 4. 

 

 

3 Did you load the temporary table? 

If then 

you loaded the table by having a few false 

starts in the process 

Press . 

The records will be dropped. 

you did not load the temporary table someone else did. This means they are trying 

to load data into the same table as you are. 

You should not proceed until you have found 
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If then 

the person and resolved the matter. 

End of procedure. 

 

4 The Load Dialog screen will display data load progress. 

You will be returned to the Traffic and Loading Import screen. The Validate button will 

be available. 

 

 

5 Press . 

The Validate Import Data for Traffic and Loading progress screen will open while 

 validates the data to be imported. Go and have a cup of coffee. When you are 

finished it is likely that an Information dialog will open announcing the totals for errors 

and warnings. 

6 Press . 

The Data Validation Grid Report screen will open. 

7 Go to Checking for Duplicates (on page 274). 

 

Data Correction and Excel 

You have two options for correcting invalid data. You can: 

• stop the data import process and return to your original data file. You place the data in 

a spreadsheet such as Excel and manipulate the data externally to .  

• fix the data within  at the Correct data for z_1_traffic_loading_import screen. See 

Data Correction in  (on page 270). 

Whichever option you choose, you will need a listing of the errors which require 

correction and the warnings describing the data errors. You do this by exporting 

them to Excel from the Data Validation Grid Report screen. 
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Export to Excel 

The errors and warnings are grouped in the Data Validation Grid Report screen. 

Whether you manipulate the data externally to  in an Excel spreadsheet, or 

fix the data within , you will need this list as a reference. The most 

convenient format to refer to the information is an Excel spreadsheet. 

You press .  will then create an Excel file to be saved in 

your My Data Sources folder in your My Documents library. You then refer to this 

spreadsheet when correcting your data errors in your original data source file. 

You save the spreadsheet which contains the corrected data and convert it to an 

import file. You then import the file using the Traffic and Loading Import screen to 

repeat the data import process. 

 

 

 

Data Correction in RAMM 

You can fix the Traffic and Loading data at the Correct data for 

z_1_traffic_loading_import screen. 
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Errors Only 

All data rows are displayed by default. If you want to see only those rows which 

contain data errors select the Errors only option. 

Correct Carriageways 

 can correct some basic errors in the Carriageway section linking. You press 

. The Correct Carriageway Links dialog will open. You are advised of the 

problem and offered a solution.  

 

 

Correct Roads 

 can correct some basic errors in the Road linking. You press . 

The Correct Road Links dialog will open. You are advised of the problem and offered 

a solution. 
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Correct All Identical Values in a Column 

If you have a column with many incorrect values,  can save you time 

correcting them. For instance, the value Latest in the Latest column below is red 

and so incorrect. If you change one value to Not Latest, save the change, the Confirm 

Record Overwrite dialog will open. You are then offered the option of having all 

other rows with a value of Latest changed to Not Latest. 

If this does not meet you requirements you can elect to be asked on each row. 

 

 

Validate Again 

When you have corrected the import data, you close the Correct data for 

z_1_traffic_loading_import screen and validate the import data again. 

The values which you have corrected will no longer be highlighted in red. If you 

select the Errors Only option, the number of rows of data should reduce each time 

you revalidate the data. 

You do this until no errors are returned. You are then ready to check the data for 

duplicates and send the data to . 
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Duplicate Checks 

When you validate your import data,  checks that there are no duplicate 

primary keys in the records to be imported. There are some situations where the 

similarities in secondary keys suggest that there has been duplication and that 

more than one record will be created if the data is moved to . 

You may want to check for signs of secondary duplication. 

 

 

Choose Columns 

If you press , the Columns to Check for Duplicates dialog opens. 

 

In the Available panel there will be a listing of the columns in your data import file. 

You select the columns you want to check for duplicates and use the arrows , 

, ,  to move the columns to check for duplicates to the Selected panel. 

Duplicate Combinations 

 checks for records which have duplicate values for all the columns 

selected. The Duplicate Records dialog opens displaying the number of duplicate 

records found. 
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You preview the report if duplicates were found. 

 

 

You can then check if the duplication will lead to duplicate records being created 

in . You do this by pressing .  then checks whether any 

records in the data to be loaded are duplicates of records within the existing table. 

If there are records in the import data which are duplicates of existing records, you 

delete them. 

 

Checking for Duplicates 

Introduction 

After data validation, you check whether similarities in secondary key values 

suggest record duplication. Duplicate records in a  database distort 

processes and outcomes. Duplication of record primary keys is corrected during 

data validation. 

Before you do this you need to have: 

• completed steps 1-7 of Validating Data. See Validating Data (on page 267). 

Menu Path 

Follow the menu path steps 1-7 of Validating Data to open the Traffic and Loading 

screen. The Check Duplicates and Move to RAMM buttons will be available. 
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►  Check ing  fo r  Dup l i ca tes  

 

 

To do this you follow these steps: 

1 Press . 

The Columns to Check for Duplicates dialog will open. 

 

2 Use , ,  and  to move from the Available panel to the Selected panel, the 

combination of columns you want to check for duplication. 

3 Press . 

 will check the import data for records for which the values in each of the 

selected columns are identical to another record. The Duplicate Records dialog will 

open indicating if duplicate records were found. 

 

 

4 Were duplicate records found? 

Yes then go to step 5. 

No then go to step 13. 

 

5 Press . 

The Duplicate Report screen will open. 
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6 View the report. 

7 Close the report in the normal manner. 

You will be returned to the Duplicate Records dialog. 

8 Does the data duplication in the report suggest that duplicate records will be created if 

the data is moved to ? 

Yes then go to step 9. 

No then go to step 13. 

 

9 Press . 

 then checks whether any records in the data to be loaded are duplicates of 

records within the existing table. 

10 Are there are duplicates? 

Yes then go to step 11. 

No then go to step 13. 

11 Press . 

The duplicate records are deleted and you will be returned to the Traffic and Loading 

Import screen. 

12 Go to step 14 

13 Press . 

The  Duplicate Records dialog will close and you will be returned to the Traffic and 

Loading Import screen. 

14 Do you want to check another combination of columns for possible duplicate records? 

Yes then go to step 1. 

No then go to step 15. 

 

15 Go to Moving and Processing Data (on page 278). 
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Move and Process Data 

Once your data has been validated, corrected and had any secondary duplication 

removed, the Move to RAMM button becomes available. 

 

 

You can then move the data into  and process it. You move the data into 

 by pressing the Move to RAMM button. An Information screen will open with 

the message that the data has been successfully moved across to its  table. 

 

 

Incorrect Sequences 

If your Traffic Loading ID sequence is incorrect, the error message The value for 

Detail ID (traffic_loading_dtl_id) must be unique... will appear. 

 

 

If this occurs you need to run Check Sequences during Status Check to reset your 

sequences. 
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Moving and Processing Data 

Introduction 

The last step in the process to load Traffic Counts into the  database is to 

move the data into  and process it. You cannot do this until the data is 

validated and the data errors fixed. 

Before you do this you need to have: 

• completed steps 1-15 of Checking for Duplicates. See Checking for Duplicates (on 

page 274). 

Menu Path 

Follow the menu path steps 1-15 of Checking for Duplicates to open the Traffic and 

Loading Import screen. The Move to RAMM button will be available. 
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►  Moving  and  Process ing  D a ta  

 

 

To do this you follow these steps: 

1 Press . 

an Information screen will open. 

 

2 Press . 

The Information screen will close and you will be returned to the Traffic and Loading 

Import screen. The Process Data button will be available. 

3 Press Process Data. 

Your data will be processed. 

4 Close the screen in the normal manner. 

 





 

  

C H A P T E R  2 1  

Staff who view or maintain  Traffic Count Estimation will need the correct Staff 

Permissions. 

Firstly a user needs to access the Parameter screen to activate Traffic Count Estimation 

and to set the initial parameters. Other users will need a different set of Staff 

Permissions to allow them to view and maintain Traffic Count Estimation in , 

 and . 

Staff Permissions are set in  at the Staff Permissions screen. 

 

 

In  Th is  Chap ter  

Introduction to Staff Permissions ............................................. 282 

Staff Permissions for the Parameter Screen .............................. 284 

Data Maintenance Staff Permissions ........................................ 287 

Dispatch Creation Permissions ................................................. 291 

 
 

Staff Permissions and Traffic Counting 
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Introduction to Staff Permissions 

Best Practice is to manage access to Traffic Count Estimation by a combination of User 

Profiles and Security Roles. 

User Profiles 

A User Profile is a security item you create in . It holds user 

Login and Organisation information. A user cannot log in to  unless they have 

a User Profile. It is the Staff Permissions associated with the User Profile which 

determine what a user can see and do once they have logged in to . 

Security Roles 

A Security Role is an item you create with Staff Permissions, as if it were a User 

Profile. Then, where there is a group of users who perform the same tasks as each 

other, rather than define individual Staff Permissions for each User Profile, you 

associate the User Profiles with one Security Role. This makes it faster grant a new 

user the appropriate Staff Permissions. You can also change the Staff Permissions 

for a whole group of people by changing the Permissions associated with their 

Security Role. 

 

 

The setting up of User Profiles and Security Roles to manage 

Staff Permissions is explained in full in the Security chapter of the 

Working with RAMM guide. 

 

Create User Profiles and Security Roles 

You create User Profiles for users. You then create Security Roles with the 

appropriate Staff Permissions for the tasks that groups of users perform. 

You then associate the User Profiles with the appropriate Security Role for the 

tasks that user will perform. Security Roles limit the actions of users to those areas 

of Traffic Count Estimation to which they need access in order to be able to perform 

their normal work tasks. 

Individual Security Switches 

You use Security Switches to grant Staff Permissions to a User Profile or Security 

Role. 

In the example below the user or Security Role can Maintain Road Name and 

Carriageway Data but not maintain Lookups or import files. 
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Global Switches 

 Security uses a Global Switch to grant preset levels of database access. 

This sits on top of the individual switches and allows you to set a specific range of 

values across all the individual switches in one go. 

This switch has five settings: 

• No Access 

• View Only 

• Contractor 

• Full Control 

• Custom Settings. 

 

 

No Access 

Setting No Access has the effect of denying a user any access at all to the  

Database. They have no Staff Permissions. 

View Only 

If you use this Global Setting to set a user to View Only it means that all the 

individual Staff Permission switches for that user are set to View Only. 

Contractor 

This setting grants user access to the database in Maintenance Contractor 

applications only. It is used to give access the the user who in the first instance sets 

up Contracts in . If a user is granted access to a Contract from 

within  they will by default be allocated this setting in 

. 

Full Control 

Full Control gives the user just that - permission to access anything and to run any 

process.  
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Custom 

Using Custom Settings gives you access to the individual switches so you can 

personally tailor the Staff Permissions for a user. 

 

 

When you make changes to user Permissions,  tells the 

Informix database to align its internal permissions (Connect, 

Resource, DBA) accordingly. This happens automatically when 

you close the Staff Permissions screen after making changes. If you 

want to manually grant or revoke permissions, you go to the 

menu at the top of the Staff Permissions screen and choose File > 

Grant/Revoke. 

This special control commits the changes you make to a 

Permissions record to a database, allowing you to continue 

working with the Staff Permissions screen. 

 
 

Staff Permissions for the Parameter Screen 

You cannot set up and run  Traffic Count Estimation unless it is switched on 

and the initial parameters have been set. You do this at the Parameter screen in 

. 

See Setting Traffic Counting Parameters (on page 67). 

Parameter Screen Staff Permissions 

You need the appropriate Staff Permissions to turn on  Traffic Count 

Estimation and to select the other initial parameters. You need either Full Control or 

the appropriate Custom Permissions. 

You open the Staff Permissions screen in  by following the menu 

path Maintenance > Staff. 

Full Control 

If you have , you have the complete Permission set for the database. 

This gives you automatic Permission to access the Parameter screen. 
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Custom Permissions 

If you have  Permissions, you need to have Update Allowed Permission at 

the Parameter drop-down list under the General section. 

 

 

 

Granting Staff Permission to Update the Parameter Screen 

Introduction 

You cannot turn on and set initial  Traffic Count Estimation parameters unless 

you have Parameter Update Allowed Staff Permission. 

 

 

You will need to have the correct Security Permissions before you 

can perform this procedure. See your Systems Administrator for 

assistance if required. 

Before you do this you need to have: 

• the correct Staff Permissions. See the note above. 

• logged in to . 

Menu Path 

Follow the menu path Maintenance > Staff to open the Staff Permissions screen. 
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►  Gran t ing  S ta f f  Permiss ion  to  Upda te  the  Parame ter  Screen  

 

 

To do this you follow these steps: 

1 In the (unnamed) Users list panel, press  Plus adjacent to the name of the 

Organisation to which the user belongs. 

The tree will open beneath the name of the Organisation. 

2 Highlight the name of the user to whom you are going to grant Permission to the 

Parameter screen. 

The details of the user will default into the (unnamed) Details panel on the right of the 

screen. 

3 Check the details to be sure that you have selected the correct person. If not, go back to 

step 2. 

4 Press  Plus adjacent to the name of the user.  

The tree will open beneath the name of the user. 

5 Press  Plus beneath the name of the user. 

The RAMM Permissions will become available. 

6 Select RAMM Permissions. 

The (unnamed) RAMM Permissions panel will open on the right of the screen. What 

you see will depend on the current Permissions of the user. 

7 Does the user have  Full Control? 

Yes then go to step 12. 

No then go to step 8. 

8 Press . 

The (unnamed) Permissions list panel will open. 

9 Select General. 

A number of general Permission options will become available on the right of the 

(unnamed) RAMM Permissions panel. 

10 Select Update Allowed from the Parameter drop-down list. 
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11 Press . 

Your changes are saved and the user has Permission to turn on  Traffic Count 

Estimation and set the initial parameters at the Parameter screen. 

12 Close the Staff Permissions screen in your preferred manner. 

You will be returned to the RAMM Manager main screen 

 

Data Maintenance Staff Permissions 

You view and maintain  Traffic Count Estimation data at the following six 

screens: 

• Carriageway 

• Count Site 

• Loading 

• Map 

• Traffic 

• Traffic Link. 

Carriageway Data 

Traffic Links are collections of Carriageways. To maintain Carriageway and Road 

Name data you need Update, Insert, Delete and Bulk Update Staff Permissions as 

appropriate. You locate these at the Staff Permissions screen. You open the tree 

under Maintenance > Core RAMM > Road Name & Carriageway at the (unnamed) Details 

panel on the right of the screen. You select and clear the options at the (unnamed) 

RAMM Permissions panel to the right of the Details panel. 

 

 

Count Site, Loading, Map, Traffic and Traffic Link screens 

To maintain Traffic Count Estimation data you need to access the Map and Update, 

Insert, Delete and Bulk Update Staff Permissions as appropriate. You locate these at 

the Staff Permissions screen. You open the tree under Maintenance > Miscellaneous > 

Traffic Estimates and Counts at the (unnamed) Details panel on the right of the screen. 

You select and clear the options at the (unnamed) RAMM Permissions panel to the 

right of the Details panel. If you intend to manage Loading data at the Loading 

screen you will also need the identical Staff Permissions for Traffic Loading. 
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Lookup Table Staff Permissions 

You view and maintain Traffic Count Estimation Lookup data in  and 

 at the Correction Factors, Traffic Growth Group and Sample Group screens. 

Correction Factors 

For each Road Type value there are default Correction Factors. If you have 

sufficient data and experience with your Network traffic flows you can define your 

own values to replace the defaults. 

See Correction Factors Screen (on page 212). 

Traffic Growth Group 

There are six default Traffic Growth Groups with Growth 1 having the least 

expected growth and Growth 6 having the most. Each Traffic Link is allocated to a 

Traffic Growth Group. 

See Growth Group Factors (on page 219). 

Sample Group 

There are nine default Sample Groups with self-explanatory Descriptions. You can 

add your own, setting the Count Frequency in years to match your business 

requirements. Each Count Site is allocated to a Sample Group. 

See Sample Group (on page 221). 

Lookup Data Staff Permissions 

To maintain Traffic Count Estimation Lookup data you need Update and Merge Staff 

Permissions as appropriate. 

You locate these at the Staff Permissions screen. You open the tree under Maintenance 

> Miscellaneous > Traffic Estimates and Counts at the (unnamed) Details panel on the 

right of the screen. You select and clear the options at the (unnamed) RAMM 

Permissions panel to the right of the Details panel. 
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Status Check Staff Permissions 

You run Status Check for Traffic Count Estimation in  at the Status 

Check screen. 

See Update Traffic Counts and Estimates (on page 230). 

You run Update Traffic Counts and Estimates for Traffic Count Estimation in  

at the Map. 

See Update Traffic Counts and Estimates (on page 204). 

If an error report is produced after you have run Status Check, you will want to 

have the correct permissions to update the erroneous data. 

To view the required Staff Permissions to make the changes through the screens 

see Data Maintenance Staff Permissions (on page 287).  

To see the required Staff Permissions to make the changes through  

see Other Staff Permissions (on page 290). 

Status Check 

To run Status Check you need Status Check Processing Staff Permissions as 

appropriate. 

You locate these at the Staff Permissions screen. You open the tree under Maintenance 

> Miscellaneous > Traffic Estimates and Counts at the (unnamed) Details panel on the 

right of the screen. You select and clear the options at the (unnamed) RAMM 

Permissions panel to the right of the Details panel. 

You will also need the identical Status Check Processing Staff Permissions for Traffic 

Loading. 
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Other Staff Permissions 

There are three areas of specific Staff Permissions which can be switched on if 

required. 

Import Data 

The most common data import to the Traffic and Loading tables are Traffic 

Count and Loading data. 

You need Full File Import Permission to do this. 

Survey Header Maintenance 

You can add and maintain Traffic Headers in  to group traffic 

data. See Traffic Headers (on page 242). 

You need Survey Header Maintenance Permission to do this. 

RAMM SQL 

You can manipulate data in the Traffic and Loading tables using 

. 

You need RAMM SQL Permission under Traffic Estimates and Counts and Traffic Loading 

to do this. 

Menu Path 

You locate these Permissions at the Staff Permissions screen. You open the tree 

under Maintenance > Miscellaneous > Traffic Estimates and Counts at the (unnamed) 

Details panel on the right of the screen. You select and clear the options at the 

(unnamed) RAMM Permissions panel to the right of the Details panel. Identical 

Permissions are available under Traffic Loading. 
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Dispatch Creation Permissions 

If you are going to create Dispatches for Traffic Counts you first need to set up a 

Contract in . See the RAMM Contractor guide. 

Once the set up of the Contract is complete, you need the correct Staff 

Permissions to add a Dispatch and then to assign the Dispatch to the appropriate 

person. 

Best practice is to do this from within  even though it is 

possible to grant Staff Permissions to a Contract in . 

RAMM Contractor Staff Permissions Screen 

In  at the Staff Permissions screen you need either  

or  with the correct options selected. 

At the Detail tab you select Dispatch. Then in the adjacent (unnamed) Permissions list 

panel you need to select at least: 

• Add/Raise a Dispatch and 

• Can Assign Dispatches to Others. 
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There are a number of reports which are useful both when setting up  

Traffic Count Estimation and afterwards when you are maintaining it. 

The reports are generally available from within the Map in  or from within 

. 

 

 

In  Th is  Chap ter  

Counting Schedule Report ....................................................... 294 

Missing Data Report ................................................................. 295 

Recommended Count Sites Report .......................................... 295 

Recommended Traffic Links Report ........................................ 297 

Traffic Latest Errors Report ...................................................... 297 

Traffic Links with No ADT Report ......................................... 298 

Unlinked Carriageways Report................................................. 299 

 
 

Traffic Count Estimation Reports 
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Counting Schedule Report 

You run the Counting Schedule report to schedule Traffic Counts for a period which 

you define. You run the report once you have set up  Traffic Count Estimation. 

You run it any time you want to schedule future Traffic Counts. 

Once the Traffic Count Estimation set up has been completed, you schedule the Traffic 

Counts. You do this based on the Sample Group of the Count Sites combined with the 

date of the most recent count entered into . When you have the list of 

Scheduled Traffic Counts, you can create Dispatches in  for a 

selected Contract. 

 

 

Before you run the report you need to understand the effect of selecting the 

Overdue Counts option. See Overdue Counts (on page 153). See Overdue Counts 

Initial Selection (on page 236). 

You create a list of Scheduled Traffic Counts by running the Counting Schedule 

report. You can do this: 

• in . See View a List of Scheduled Traffic Counts (on page 151). 

• in  See Counting Schedules (on page 234). 

 

 

You need to take care when creating Dispatches for scheduled 

Traffic Counts. 

If you have previously run the Generate Scheduled Traffic Counts 

process for the same date range and created Dispatches from the 

results, the scheduled Traffic Counts will be generated again unless 
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the Traffic Counts have taken place and been entered into . 

So you need to set up your own internal systems to prevent the 

creation of more than one Dispatch for the same Traffic Counts. 

 

 

Missing Data Report 

If your initial data is faulty then your Traffic Count Estimation set up will not be as 

accurate as it should be. 

You run the Missing Data report to check your Traffic Link and Latest Traffic Count 

data and fix any errors before you run Status Check to generate Latest Estimates. 

You locate the errors by running the Missing Data report. 

You can run the report for Count Site Sample Groups, as well as the Time of Day and 

Count Duration values for Latest Traffic Counts. 

 

 

In  you run one instance of the report. See Missing Data (on 

page 238). 

At the Map in  you run the report in sections. You do this for: 

• Sample Groups. See Sample Group Data (on page 74). 

• Time of Day. See Time of Day Data (on page 72). 

• Count Duration. See Count Duration Data (on page 70). 

 

Recommended Count Sites Report 

You run the Recommended Count Sites report when setting up  Traffic 

Count Estimation. You do this after you have started the Traffic Link creation process. 
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When you have created your Traffic Links you then create Count Sites on them. 

Although you could start from scratch when creating Count Sites for your database, 

it is more efficient to let  recommend them for you. If you accept the 

recommendations, you can edit them later. 

 

 

You can run the Recommended Count Sites report from within: 

• . See Recommend Count Sites (on page 226). 

• the Map in . See Recommended Count Sites and the Map (on page 199). 

 

 

If you export and sum VKT values to check the  % VKT 

calculations there may appear to be errors even though the 

highlighted list is accurate. 

When  recommends two Count Sites on one Traffic Link to 

account for multiple historical counts, the VKT value is listed 

twice. VKT for child Traffic Links associated with a parent Traffic Link 

will not appear in the list because  will not recommend 

Count Sites for them. The VKT of Carriageway Sections which are 

not in a Traffic Link will still be part of the calculation but not in the 

list. 
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Recommended Traffic Links Report 

You run the Recommended Traffic Links report when you are setting up  

Traffic Count Estimation. You would generally do this after you have fixed your legacy 

data and before you have started the Recommended Count Sites process. 

You can manually create your own Traffic Links for your database. However, it is 

more efficient to accept the  Recommended Traffic Links which are 

contiguous Carriageway Sections from the same Road that have the same Average 

Daily Traffic (ADT) Estimate value, plus or minus 10%. 

 

 

You can run the Recommended Traffic Links report from within: 

• . See Recommend Traffic Links (on page 223). 

• the Map in . See Recommended Traffic Links and the Map (on page 197). 

 

Traffic Latest Errors Report 

When you have run the Update Traffic Counts and Estimates process, if there are errors 

in the data,  will create the Traffic Latest Errors report. 
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Duplicate Traffic Counts 

The Traffic Latest Errors report will identify Carriageway Sections where there are 

duplicate Traffic Counts. This could occur where the file containing the Traffic Counts 

has been imported twice. 

No Estimate 

It will also list those Carriageway Sections where there is no ADT Estimate. All 

Carriageway Sections in  must have an ADT Estimate. So you will need to 

investigate any Carriageways with no Estimate. 

The Map in RAMM 

You can do this at the Map. You follow the menu path View > Traffic Links with no ADT. 

A Layer will then be created so that you can more easily find the Traffic Links with 

errors. 

 

Traffic Links with No ADT Report 

Every Traffic Link must have an Average Daily Traffic (ADT) value. If they do not 

have one then there is a problem which you need to fix.  
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You can identify the Traffic Links with problems by running the Traffic Links with 

no Average Daily Traffic (ADT) report from within . See Traffic 

Links with No ADT (on page 241). 

Map Layer 

You can also use the Map to locate and fix these Traffic Links with no ADT. You 

follow the menu path View > Traffic Links with no ADT. A Layer will then be created so 

that you can more easily find the Traffic Links with errors. 

When you have located the Traffic Links with errors and fixed them the Layer should 

disappear. If not, there must be more Traffic Links to fix. See Traffic Links with No 

Average ADT (on page 129). 

 

 

Unlinked Carriageways Report 

You run the Unlinked Carriageways report when you have finished associating 

Carriageway Sections to make Traffic Links. You do this to be sure that all 

Carriageway Sections have been linked. You should also run this report every year 

as part of your maintenance plan. Then, if any Carriageway Sections have been 

added since the set up of Traffic Count Estimation but not associated with a Traffic Link, 

you can locate and link them. 

It is possible that some Carriageway Sections will not have been associated with a 

Traffic Link. An Average Daily Traffic (ADT) Estimate value would not be calculated 

for these Carriageway Sections unless this is corrected. 
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You can run the Unlinked Carriageways report from within: 

• . See Unlinked Carriageways (on page 241). 

• the Map in . See Unlinked Carriageways (on page 128). 
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The New Zealand Transport Agency (NZTA) uses  Traffic Count Estimation 

to integrate with their Traffic Monitoring System (TMS) software for estimation 

of State Highway Road usage. 
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State Highways and TMS 

The New Zealand Transport Agency (NZTA) is the Crown Entity responsible for 

State Highways. These are the strategic Roads and motorways that are about 12% 

(10,894 km) of all New Zealand Roads, but account for about half of the 36 billion 

vehicle kilometres travelled every year. It promotes land transport sustainability 

and safety and allocates government funding for land transport. 

New Zealand Transport Agency (NZTA) 

NZTA is committed to planning, developing and maintaining the State Highway 

system in a way that contributes to an integrated, safe, responsive and sustainable 

land transport system for New Zealand. 

To achieve this mission, NZTA must have reliable information about the Road 

users in terms of traffic volumes, vehicle mix and traffic loading. 

Traffic Monitoring System (TMS) 

The TMS software facility is: 

• an accurate data collection system with efficient procedures and means of storing data 

for subsequent retrieval and analysis 

• a means of representing the entire State Highway Road system in terms of nodes and 

links 

• an appropriate vehicle classification scheme for the vehicle fleet using the State 

Highway system  

A reliable estimate of State Highway Road usage is vital to the routine 

management and future planning of the highway infrastructure and other 

transport systems associated with it. 

TMS delivers this information effectively and efficiently. It ensures that 

appropriate decisions concerning the Road network are made in accordance with 

the best business practices. 

State Highway Databases 

 State Highway databases are dynamically configured to match the 

requirements of the TMS. 
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Correction Factors 

 Traffic Count Estimation uses a variety of Correction Factors to correct Traffic 

Counts based on factors such as the time of day and time of year of the Count. 

The New Zealand Transport Agency (NZTA) counts for 365 days of the year. So 

the data imported into  from the NZTA Traffic Management System 

(TMS) does not need Correction Factors. 

So in State Highway databases, these Correction Factors are set to 1 and so have no 

effect. 

 

 

 

Count Site Reference and Site Type 

You can maintain Site Reference and Site Type (Load Method) details for individual 

Count Sites. They are for your information only and serve no functional purpose in 

. 

These were introduced primarily for New Zealand Transport Agency (NZTA) 

but are available for all users. 
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Recording and Estimation of ESA 

The Equivalent Standard Axle (ESA) is the number of standard axle loads that are 

equivalent in damaging effect on a pavement to a given vehicle or axle loading. 

This is used as a Loading unit of measure. 

Local Government Organisations use Traffic Count Estimation to record and estimate 

the ADT, Percentage Heavies and ESA Heavy for each Traffic Link which either has a 

Traffic Counts or is linked to a Traffic Link which is. The New Zealand Transport 

Agency (NZTA) use Traffic Count Estimation to record and estimate ESA for: 

• MCV 

• HCVI 

• HCVII 

• Buses. 
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Traffic Count Duration 

Traffic Count Estimation has recorded the duration of Traffic Counts as: 

• 3 hours 

• 24 hours and 

• 7 days. 

State Highway databases allow count durations of 7 to 365 days. 
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Traffic Growth Calculation 

 Traffic Count Estimation uses Growth Groups in its traffic growth recording and 

calculation. The New Zealand Transport Agency (NZTA) records traffic volumes 

365 days each year on State Highways. 

This negates the necessity to perform traffic growth calculations as the actual 

traffic growth is known. 

So in State Highway databases, this aspect of Traffic Count Estimation is disabled. 

 

 

 

Traffic Link Location 

You can now use GPS coordinates to positively locate the Start and End of Traffic 

Links. Most users will locate the Start and End by the Carriageway Sections which 

comprise the link. The nature of the State Highway Network means that NZTA 

require GPS coordinates. 

Several Traffic Links on the Same State Highway 

Initially, Traffic Count Estimation located a Traffic Link only by the Carriageway 

Sections associated with it. This enabled a Traffic Link to be comprised of one or 

more Roads. 
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The New Zealand Transport Agency (NZTA) needs the option to create multiple 

Traffic Links on the same State Highway. So recording the GPS coordinates for the 

Start and End of the Traffic Link will be meaningful to them. 
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Having set up  Traffic Count Estimation you will want to maintain it so that 

you can produce the most accurate possible Average Daily Traffic (ADT) 

Estimates. You do this using a combination of: 

• adding ADTs as a result of actual Traffic Counts 

• scheduling ad hoc Traffic Counts to check that your traffic flow assumptions are 

accurate 

• running Status Check to update Latest Counts and Estimates 

• updating Traffic Links when new Roads and Carriageways are added to the Network. 

 

 

In  Th is  Chap ter  

Fine Tune Traffic Data ............................................................. 310 

Check for New Carriageways ................................................... 311 

Schedule Regular Traffic Counts ............................................. 312 

Update ADT Values .................................................................. 313 

Traffic Count Estimation Maintenance 
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Fine Tune Traffic Data 

When you set up your Traffic Link associations you do so in a series of hierarchical 

Parent/Child relationships so that when you perform a Traffic Count on the 

uppermost of the Parent Traffic Links the reading will filter down to all the 

subsidiary Traffic Links as per the percentages defined. 

The Traffic Link which is at the top of the hierarchical relationships of the Parent 

Traffic Links will have no Related To values. This is because it does not have an 

Average Daily Traffic (ADT) Estimate calculated as a percentage of another Traffic 

Link. So it needs to have its traffic counted. 

You generally associate one Traffic Link with another at the Map in . See 

Relate Traffic Links (on page 185). 

 

 

Check the Take ADT as  % Value 

When you are associating Traffic Links the value which you set at the Take ADT as  % 

is likely to be either the default value as calculated by <> or a best guess value 

based on your knowledge of your Network. 

You should check these assumptions as part of your maintenance programme. 

How often you do this will depend on your budget and other factors. 

As part of your Ad Hoc Traffic Count budget, when you schedule a standard Traffic 

Count on a major Traffic Link you should schedule Ad Hoc Traffic Counts on associated 

Traffic Links. 
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Check for New Carriageways 

It is possible that some Carriageway Sections will not have been associated with a 

Traffic Link. An Average Daily Traffic (ADT) Estimate value would not be calculated 

for these Carriageway Sections unless this is corrected. 

You should check for unlinked Carriageway Sections as part of your maintenance 

plan. Then, if any Carriageway Sections have been added since the set up of Traffic 

Count Estimation but not associated with a Traffic Link, you can locate and link them. 

 

 

You locate these unlinked Carriageway Sections by running the Unlinked 

Carriageways report. You can do this from within: 

• . See Unlinked Carriageways (on page 241). 

• the Map in . See Unlinked Carriageways (on page 128). 
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Schedule Regular Traffic Counts 

Once the Traffic Count Estimation set up has been completed, you schedule the Traffic 

Counts. You do this based on the Sample Group of the Count Sites combined with the 

date of the most recent count entered into . When you have the list of 

Scheduled Traffic Counts, you can create Dispatches in  for a 

selected Contract. 

Traffic Counts are scheduled based on the Sample Group of the Count Sites combined 

with the date of the most recent count entered into . For instance, if a Count 

Site were in the Core Monitoring - Annual group,  would take the date of the 

most recent count and schedule another for twelve months later. 

 

 

Before you run the report you need to understand the effect of selecting the 

Overdue Counts option. See Overdue Counts (on page 153). See Overdue Counts 

Initial Selection (on page 236). 

You create a list of Scheduled Traffic Counts by running the Counting Schedule 

report. You can do this: 

• at the Map in . See View Scheduled Traffic Counts on the Map (on page 150). 

• in  See Counting Schedules (on page 234). 

 

Add Traffic Count Dispatches 

When you have the list of Scheduled Traffic Counts, you can create Dispatches in 

 for a selected Contract. This will allow the Traffic Count 

Contractor to see what Counts are required over the schedule period. 
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You can add the Dispatches from the Map in . See Traffic Count Dispatches 

(on page 153). 

 

 

You can also add the Dispatches in  as an integral part of the 

process of generating Scheduled Traffic Counts. See Traffic Count Dispatches (on 

page 153). 

 

 

 

Import Traffic Count Data 

When the Traffic Counts have been made it is possible to enter each one at the 

correct Count Site at the Map in . However, if there are a large number of 

Traffic Counts it is more efficient to import them using the Import tool in 

. See Traffic and Loading Data Import (on page 249). 

To do this you will need the correct Staff Permissions. See Other Staff 

Permissions (on page 290).  

 

Update ADT Values 

When the Traffic Counts have been imported you can update the Latest Average 

Daily Traffic (ADT) Counts and Estimates. 
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When you need the most up-to-date Average Daily Traffic (ADT) Estimate data 

you can perform a Status Check at the Map by running the Set most recent flags for 

Traffic and Loading Data process. This updates the database to take into account any 

Traffic Counts, Estimates and Loading data entered since the most recent Status 

Check. It then updates the Estimates taking into account the new readings and the 

other factors. It also creates the Traffic Latest Errors report. 

You can do this at the Map in . See Update Traffic Counts and Estimates (on 

page 204). 

 

 

You can do this in . See Update Traffic Counts and Estimates (on 

page 230). 
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RAMM Software Limited has made enhancements to the  suite of products to 

add functions required for operation in Australia. These include the ability to: 

• import MetroCount files. See MetroCount File Import (on page 315). 

• use the Austroads Vehicle Classification System. See Austroad Vehicle Classes (on page 

317). 

 

In  Th is  Chap ter  

MetroCount File Import ........................................................... 315 

Austroad Vehicle Classes ........................................................... 317 

 
 

MetroCount File Import 

MetroCount software is used for vehicle counting and classification. WALGA 

members use the MetroCount Traffic Count and Loading data files for their 

Traffic and Loading records. 

These files can be imported into  using the a utility specifically created for 

the import of MetroCount files into the  database. 

Austroads and MetroCount Files 



 

3 1 6  T r a f f i c  C o u n t  E s t i m a t i o n  
 

Access from RAMM Applications 

 You can access the MetroCount Import utility directly from RAMM Applications. 

 

Access from RAMM Manager 

You can access the MetroCount Import utility from . You follow 

the menu path Projects > Traffic Counting > Import MetroCount. 

 

 

 

 

Please note that the import utility is optimised for Australian 

Loading Classes. New Zealand MetroCount users will continue to 

import their data into  after having converted it 

into a .csv file or similar. 
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Austroad Vehicle Classes 

The Austroads Vehicle Classification system is used by all Australian Road 

Controlling Authorities (RCAs) including the members of WALGA. 

The Austroads Vehicle Classification system classifies vehicles by axle configuration 

or vehicle length. MetroCount files are configured for the twelve Austroads vehicle 

classes used in Australia. 

RAMM Vehicle Classifications 

 has been updated so that there are three preset  Vehicle Classification sets. 

The database type determines the standard Vehicle Classification set. Depending 

on your circumstances, your database will include: 

• the twelve Austroads vehicle classes 

• the six New Zealand local government vehicle classes  

• the six New Zealand State Highway vehicle classes. 

The WALGA databases will have the twelve Austroads vehicle classes by default. 

New Database Table 

This flexibility is the result of a new database table. Information specific to a 

vehicle class has been removed from the existing Traffic and Loading tables. The 

data has been combined into a new table, traffic_loading_dtl. This table is 

flexible enough to display either the six New Zealand or twelve Austroads vehicle 

classes. 
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In the Territorial Local Authority (TLA) there are N links. In the sample there are 

n links, n
1
…n

5
 from the five Annual Average Daily Traffic (AADT) bands. For any 

link i, AADT and lengths are: a
i  

and l
i
  respectively. 

 

 

 

 

 

 

This estimates the average AADT for the TLA. The sampling structure is designed 

to produce the most efficient sample size to estimate the overall average AADT. 

 

 

 

 

So, estimating from the sample, it is the ratio of the sampled lengths to the total 

length that is important. In English, the method is to compute the Vehicle 

Kilometres Travelled (VKT) for the total sample, then scale up according to the 

ratio of the total TLA length to the sample total length. 

 

Appendix A - VKT Calculation from Sample 
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 Confident that 95% of the time the true value is within +/- 
10% of the estimate 

 

Territorial Local 

Authority (TLA) 

<40% 40-60% 60-80% 80-90% 90-100% Total 

       

Invercargill 2 1 6 6 15 29 

Gore 1 2 7 6 17 33 

Southland 1 5 4 5 24 38 

Clutha 5 1 2 9 23 39 

Dunedin 3 1 6 7 31 47 

Queenstown-Lakes 2 1 5 5 21 34 

Central Otago 10 0 2 3 13 28 

Waitaki 4 0 4 5 25 38 

Waimate 4 1 4 3 25 36 

Mackenzie 2 2 0 2 2 8 

Timaru 3 2 6 5 24 39 

Ashburton 2 2 5 5 33 47 

Selwyn 4 2 0 3 24 33 

Banks Peninsula 1 0 0 4 32 37 

Christchurch 2 1 7 7 15 31 

Waimakariri 2 1 3 3 36 45 

Hurunui 14 1 0 2 12 29 

Westland 1 0 2 5 25 32 

Grey 1 1 2 4 29 37 

Appendix B - TLA Table 
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 Confident that 95% of the time the true value is within +/- 
10% of the estimate 

 

Territorial Local 

Authority (TLA) 

<40% 40-60% 60-80% 80-90% 90-100% Total 

Buller 1 0 3 4 27 35 

Kaikoura 1 1 3 2 13 19 

Marlborough 2 1 4 7 34 47 

Nelson 1 1 4 4 28 39 

Tasman 2 2 5 5 18 31 

South Wairarapa 3 2 4 3 11 24 

Carterton 5 2 3 3 4 16 

Masterton 2 2 5 6 15 29 

Wellington 2 1 5 5 34 47 

The Hutt 3 1 6 7 16 33 

Upper Hutt 1 1 5 6 24 37 

Porirua 2 2 3 5 25 37 

Kapiti Coast 2 2 5 5 26 40 

Horowhenua 13 1 2 4 15 35 

Tararua 5 1 6 3 26 41 

Palmerston North 2 2 7 6 13 30 

Manawatu 1 0 3 4 20 28 

Rangitikei 3 1 3 3 28 39 

Wanganui 2 2 6 6 15 31 

Ruapehu 2 2 4 5 20 32 

South Taranaki 3 2 4 3 11 24 

Stratford 10 1 5 2 13 31 

New Plymouth 2 2 6 6 33 48 
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 Confident that 95% of the time the true value is within +/- 
10% of the estimate 

 

Territorial Local 

Authority (TLA) 

<40% 40-60% 60-80% 80-90% 90-100% Total 

Central Hawkes Bay 2 1 4 4 30 42 

Napier 4 1 2 6 18 31 

Hastings 2 3 8 6 27 45 

Wairoa 2 1 3 6 25 36 

Gisborne 3 1 4 3 47 58 

Opotiki 2 2 5 4 9 21 

Kawerau 3 1 3 1 6 12 

Whakatane 2 2 5 6 23 38 

Rotorua 1 1 3 5 34 45 

Tauranga 3 2 4 6 29 44 

Western Bay of Plenty 3 2 5 5 16 31 

Taupo 2 2 5 5 24 38 

Waitomo 2 2 4 4 16 27 

South Waikato 2 1 4 7 21 35 

Otorohanga 2 2 5 4 14 28 

Waipa 2 1 5 5 41 55 

Hamilton 3 2 5 5 28 42 

Matamata-Piako 3 2 5 5 18 33 

Waikato 3 2 4 5 20 35 

Hauraki 4 2 4 4 14 27 

Thames-Coromandel 3 1 5 4 33 46 

Franklin 3 2 5 4 32 47 

Papakura 1 1 4 4 23 34 
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 Confident that 95% of the time the true value is within +/- 
10% of the estimate 

 

Territorial Local 

Authority (TLA) 

<40% 40-60% 60-80% 80-90% 90-100% Total 

Manukau 1 1 7 8 22 39 

Auckland 1 1 4 11 40 56 

Waitakere 2 2 5 7 46 62 

North Shore 2 1 3 8 41 56 

Rodney 3 2 4 5 28 42 

Kaipara 2 2 5 7 46 62 

Whangarei 2 1 2 4 59 68 

Far North 3 2 5 3 42 56 

 

 



 

3 2 3  T r a f f i c  C o u n t  E s t i m a t i o n  
 

If you are using a local version of  rather than the Hosting Service, you 

require the Informix Client SDK 3 or above which makes use of Microsoft .net 

which uses features that are not available in earlier versions of the Informix Client 

SDK. 

 

 

When installing the Informix Client SDK 3 you have the option 

at the Finish panel to install Visual Studio Add-in. Do not install 

this. Leave the Launch VSAI Installer check box cleared. 

See your System Administrator for details. 

 

 

Appendix C - Local Version Requirement 





 

  

AADT 

The Annual Average Daily Traffic 

(AADT) is a figure to describe traffic 

levels for the length of a Network. It 

is used in many ways throughout 

 and by the regulatory 

authorities. Potentially, it could be 

used to determine whether Speed 

Limit Signs were required. For 

instance, if the AADT Estimate for a 

Road did not exceed 500 vehicles per 

day, a Sign could be required on the 

left hand side. If it were greater than 

500, a Sign on the right hand side or 

in the centre could also be required. 

ADT 

The Average Daily Traffic (ADT) 

count is a figure to describe daily 

traffic levels for a Traffic Link. When a 

variety of factors are taken into 

account an Annual Average Daily 

Traffic (AADT) value is calculated. 

It is this value which is used in 

.   

Carriageway 

Roads in  are divided into 

logical sections named Carriageways. 

These start and end at easily 

identifiable Locations such as 

Intersections and Bridges. You can 

define your Carriageway Sections to 

suit your own purposes. For instance 

you may define them to start and 

end when the number of Lanes in 

the Road changes or if the Road 

changes between Sealed and 

Unsealed sections. 

Count Duration 

The accuracy of a Traffic Count is 

affected by its duration. The longer 

the duration of the count, the more 

accurate it is. There are three 

standard Count Durations in  

being 3 hours, 24 Hours and 7 Days. 

Count Site 

Count Sites in  are the 

Locations at which Traffic Counts will 

occur. They are positioned on a 

Traffic Link. 

Custom 

Custom is one of the settings of the 

Global Security Switch. When you 

individualise the Permissions for a 

user, the Global Security Switch is 

automatically set to Custom. 

Database 

This is a structured collection of data 

that is stored in a computer so that 

an application can consult it to 

answer queries. In , this is a 

particular Road Network. It is 

possible that you will use more than 

one  database, especially if 

you work with more than one Road 

Controlling Authority. 

Detail Screen 

Detail screens in  are used for 

working with Road Inventory, 

Condition and other items one at a 

Glossary 
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time. You use them to view and 

maintain details for one item only at 

a time. 

Dispatch 

A Dispatch is a defined activity 

generated from within 

 so that Contractor field 

crew can repair a Network Fault. In 

 it is referred to as a 

Job. 

dTIMS 

Deighton Total Infrastructure 

Management System (dTIMS) is a 

software tool used to model 

Pavement Deterioration.  

provides a method of extracting 

Treatment Length, Maintenance 

Cost and related data from the Road 

Network in a format that can be 

imported into dTIMS. 

Filter (Database Filter, Grid Filter) 

Filters are the screens which you use 

to sort the data in Detail or Grid 

screens according to selected criteria. 

You use these to streamline the 

information you see in  such 

as in the Roads list panel.  

Full Control Security Switch 

Full Control is one of the settings of 

the Global Security Switch. It allows 

the user Permission to access, add, 

update or delete any record and to 

run any process. You manage access 

to  by setting Staff 

Permissions. You do this to limit the 

actions of users to those areas of 

 to which they need access in 

order to be able to perform their 

normal work tasks. If you set a user 

to Full Control it means that all the 

individual Permission switches for 

that user are set to Full Control. 

Full Day Count 

A Full Day Count is one in which 

traffic volume on a Road is 

measured for a 24 hour period. 

Full Week Count 

A Full Week Count is one in which 

traffic volume on a Road is 

measured for a 7 day period. 

Global Security Switch 

 Security uses a Global 

Switch to grant preset levels of 

database access. This sits on top of 

the individual switches and allows 

you to set a specific range of values 

across all the individual switches in 

one go. This switch has four 

settings: 

 No Access 

 View Only 

 Full Control 

 Custom Settings. 

You manage access to  by 

setting Staff Permissions. You do 

this to limit the actions of users to 

those areas of  to which they 

need access in order to be able to 

perform their normal work tasks. 

Grid Screen 

The Grid screen in  is a 

visual report writer. You use Grid 

screens to work with multiple Road 

Inventory, Condition and other 
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items. You adjust the Grid Layout so 

that is looks right and it suits your 

purposes.  You can then view, 

export or print the displayed details. 

Growth Group 

A Traffic Growth Group is a group of 

Traffic Links that are believed to have 

approximately the same level of 

traffic growth from year to year. 

They are used in the update Average 

Daily Traffic (ADT) Estimates 

process.  averages the actual 

Traffic Counts for Count Sites on Traffic 

Links in the Traffic Growth Group, 

ignoring any greater than one and 

one half standard deviations above or 

below the mean growth for the 

group. Having found the average 

annual traffic growth,  applies 

this factor to previous ADT 

Estimates where there has been no 

count in the current year. 

Network 

A Network is a collection of Roads 

managed by a particular Road 

Controlling Authority (RCA). Each 

 database usually contains all 

the information for one Network. 

NZTA 

The New Zealand Transport 

Agency (NZTA) is the Crown 

Entity responsible for State 

Highways. These are the strategic 

Roads and motorways that are about 

12% (10,894 km) of all New 

Zealand Roads, but account for 

about half of the 36 billion vehicle 

kilometres travelled every year. It 

promotes land transport 

sustainability and safety and allocates 

government funding for land 

transport. 

Parameters 

Parameters are the independent 

variables whose values determine the 

characteristics or behavior of a 

process or system such as Traffic 

Count Estimation. They have 

measurable or quantifiable 

characteristics. 

Part Day Count 

Some Traffic Counts are for only part 

of a day.  can accept data 

from three hour counts and uses 

different factors for the morning and 

the afternoon. 

Pavement Use 

The Pavement Use for a Carriageway 

Section is one of seven Average 

Daily Traffic (ADT) bands. These 

are the range in which the expected 

ADT will fall. 

Permissions 

Staff Permissions are access rights 

granted to specific users and groups 

of users. They are authorisations for 

users to view or make changes to the 

contents of aspects of . 

You manage access to  by 

setting Staff Permissions. You do 

this to limit the actions of users to 

those areas of  to which they 

need access in order to be able to 

perform their normal work tasks. 
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RAMM 

Road Assessment and Maintenance 

Management ( ) is software 

developed and supported by RAMM 

Software Limited. This software is used 

by Road Controlling Authorities 

(RCAs) to manage Road Inventory 

Assets and Condition for their 

Network. 

RAMM Contractor 

 is the module 

of the  suite of products 

which enables Contractors, 

Network Owners and Consultants 

to manage Road Asset Maintenance 

Contracts. In particular, it has been 

optimised to facilitate the 

Programming of Network 

maintenance and the Estimation and 

Claims process which is integral to 

Programmed Maintenance 

Contracts. It also includes the special 

features for the managing of 

Contracts for Signs, Street Lights 

and Traffic Signals maintenance. 

RAMM Hosting Service 

The  Hosting Service is a 

service run by RAMM Software Limited. 

It enables you to run  across 

the Internet. It hosts your database 

and the software on a server at a 

centralised location. You use your 

standard internet browser to access 

the software and work with your 

data, so you do not need any 

specialised software. It is very secure. 

RAMM Software Ltd 

This is the company which 

specialises in the development of 

software for the roading industry. Its 

core product,  (Road 

Assessment and Maintenance 

Management) has been the 

benchmark in road asset 

management software in New 

Zealand for over 20 years.  is 

now a suite of software products 

including , 

, , 

, 

 and the  

CAR Manager. 

RCA 

A Road Controlling Authority 

(RCA) is the organisation 

responsible for a particular Road 

Network. An example of an RCA 

could be the New Zealand 

Transport Agency (NZTA) or a 

TLA (Territorial Local Authority). 

Road 

For Local Authorities, a Road 

denotes a single named Road that is 

part of their Network. For State 

Highways, a Road is a segment of 

the State Highway. 

Road Type 

The Road Type is one of the factors 

which affect traffic volumes on a 

Road. For instance, a Road which is 

an access route to a ski field in 

winter will have a different usage 

pattern from one which is used to 

access a popular beach in summer. 



 

 G l o s s a r y  3 2 9   

Similarly, Roads used for industry 

will have different usage patterns 

from those used as main arterial 

routes for commuters. 

Sample Group 

Sample Groups group Count Sites with 

the same count frequency. You 

count traffic on high volume Roads 

more often than on low traffic 

volume Roads. So you assign a 

Sample Group to each Count Site based 

on how often it needs to be counted, 

whether this is every year, every 

second year or once every five years. 

Security Role 

A Security Role is an item you create 

with Staff Permissions, as if it were a 

User Profile. Then, where there is a 

group of users who perform the 

same tasks as each other, rather than 

define individual Staff Permissions 

for each User Profile, you associate 

the User Profiles with one Security 

Role. This makes it faster grant a 

new user the appropriate Staff 

Permissions. You can also change 

the Staff Permissions for a whole 

group of people by changing the 

Permissions associated with their 

Security Role. 

Staff Permissions 

Staff Permissions are access rights 

granted to specific users and groups 

of users. They are authorisations for 

users to view or maintain specific 

aspects of . You set Staff 

Permissions for users, firstly, to 

manage their access to  and, 

secondly, once they have accessed 

, to limit their actions to 

those which they need in order to 

perform their normal work 

activities. 

Time of Day 

The time of day affects the volume 

of traffic which will travel along a 

Road. Traffic Counts taken in the 

morning are likely to vary from 

those taken in the afternoon.  

Traffic Count Estimation uses a Time of 

Day factor to account for this when a 

Traffic Count is taken, unless it is for 

24 hours or for 7 days. 

TLA 

A city or a district council is 

sometimes referred to as a 

Territorial Local Authority (TLA). 

TLAs are the lower branch of 

government. They are created by 

statute but autonomous and 

accountable to their local 

community. 

They own and manage their Road 

Network so a TLA may also be 

referred to as a Road Controlling 

Authority (RCA). However, RCAs 

such as airports which own their 

own Roads and the New Zealand 

Transport Agency (NZTA) which 

manages the State Highway 

Network, are not TLAs. 

Traffic Count Estimation 

 Traffic Count Estimation enables 

you to combine historical traffic data 

with intelligent Carriageway Section 

linking to produce a traffic counting 

and estimation programme which 
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delivers the most Network coverage, 

the most accurate and up to date 

ADT Estimates for the minimum 

number of counts. 

Traffic Counts 

These are physical Counts of traffic 

passing a Location known as a Count 

Site. Traffic Counts are used to 

calculate the ADT which is then 

used to generate an AADT. The 

Traffic Count applies to the entire 

Traffic Link on which it is sited. 

Traffic Links 

Traffic Links are combinations of 

sequential  Carriageway 

Sections that are considered to carry 

the same volume of traffic over the 

entire length of the link. 

User Profile 

A User Profile is a security item you 

create in . It holds 

user Login and Organisation 

information. A user cannot log in to 

 unless they have a User 

Profile. It is the Staff Permissions 

associated with the User Profile 

which determine what a user can see 

and do once they have logged in to 

. 

View Only Security Switch 

View Only is one of the settings of the 

Global Security Switch. It allows the 

user Permission only to view records 

and not to run any processes or to 

add, update or delete any records.  

You manage access to  by 

setting Staff Permissions. You do 

this to limit the actions of users to 

those areas of  to which they 

need access in order to be able to 

perform their normal work tasks. 

If you set a user to View Only it means 

that all the individual Permission 

switches for that user are set to View 

Only. 

VKT 

Vehicle Kilometres Travelled (VKT) 

is the total kilometres travelled by 

motor vehicles on a Road Network 

during a given period of time. VKT 

is an important variable in the 

analysis of traffic density, highway 

safety and other areas. VKT can 

equally be applied to Traffic Links. 

However, VKT for Traffic Links is not 

explicitly recorded in .  
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programme • 35 

Schedule • 52, 150, 151, 234, 235 

Status • 2 

view • 150 

Custom • 282 

D 

database 

details • 27 

log in • 19 

Day Types •  See Week Day Factors 

Dispatches 

create • 52, 154, 189, 312 

Staff Permissions • 291 

Traffic Count • 153 

dTIMS • 48 

Index 
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E 

Estimates 

calculation • 38, 40, 41, 48 

update • 52 

F 

Filter screen • 76, 83, 90, 225 

Full Control • 282, 326 

G 

Growth Groups • 327 

introduction • 48 

screen • 219, 288 

Traffic Links • 225 

H 

help 

contact ROMAN II • 28 

guides • 25 

other users • 26 

L 

legacy data 

Count Duration • 70, 240 

data, missing • 70, 72, 74, 76, 238, 295 

fix • 52, 238 

Time of Day • 72, 240 

Loading screen • 161 

M 

Map 

actions 

Staff Permissions • 289 

Update Traffic Counts and Estimates 

• 204 

buttons 

Add a Count Site button • 177, 182 

Add a Traffic Count button • 177, 

184 

Add a Traffic Link button • 177, 179 

Associate a Carriageway Section with 

a Traffic Link button • 128, 177, 188 

Relate a Traffic Link to Another 

Traffic Link button • 112, 119, 177, 

185, 241 

Show Traffic Data for All Roads 

button • 177, 189, 193 

Traffic Management Mode button • 

177 

View/Create Count Sites button • 

199, 207 

View/Create Scheduled Counts 

button • 151 

View/Create Traffic Links button • 

197, 207 

Carriageways, unlinked • 128, 188, 193 

Count Duration data, missing • 70, 193 

Count Sites, Recommended • 96, 104, 

107, 182, 199 

Counts, Scheduled • 150 

Legend 

Carriageways, unlinked • 128 

introduction • 207 

Recommended Traffic Links • 197 

Scheduled Traffic Counts • 150 

Show All Roads • 189 
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View/Create Count Sites button, 

display • 104, 199 

View/Create Traffic Links button, 

display • 87, 197 

menu options 

introduction • 177 

Recommended Traffic Links • 197 

Scheduled Traffic Counts • 150 

Show All Roads • 189 

Sample Group data, missing • 74, 193 

Time of Day data, missing • 72, 193 

tool bar • 177 

Traffic Links 

introduction • 90, 119, 122, 185 

Recommended • 80, 83, 87, 90, 197 

with no ADT • 193, 298 

View 

introduction • 193 

Recommended Traffic Links • 197 

Scheduled Traffic Counts • 150 

Show All Roads • 189 

Missing Data 

report • 238, 295 

screen • 238, 295 

N 

Network • 62, 67 

No Access • 282 

P 

Parameter screen • 62, 67, 99, 216, 284, 

285 

parameters • 327 

initial • 62, 216 

set • 52, 67 

Part Day Factors • 213 

Pavement Use • 62, 67, 230 

R 

RAMM Manager 

main screen • 210 

multiplication factors • 210 

RAMM Network Manager • 248 

RAMM SQL • 74, 239, 290 

RCA • 328 

Count Sites • 132 

initial parameters • 62 

select • 67 

Recommended Count Sites screen • 97, 

98, 99, 104, 107, 226, 227, 228, 295 

Recommended Traffic Links screen • 

81, 85, 87, 90, 223, 297 

Regions 

Factors • 216 

initial parameters • 62, 67 

reports 

Counting Schedule report • 153, 294, 

312 

Missing Data report • 238, 295 

Recommended Count Sites • 295 

Recommended Traffic Links • 297 

Traffic Latest Errors report • 129, 204, 

230, 297 
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Traffic Links with no ADT report • 129, 

193, 241, 298 

Unlinked Carriageways report • 128, 

241, 299, 311 

Road Controlling Authority •  See 

RCA 

Road Network •  See Network 

Road Types 

graphs • 211 

multiplication factors • 210 

screen • 212, 288 

selection flowchart • 47 

Traffic Links • 170, 225 

S 

Sample Groups 

Count Site values, update • 122, 159, 228 

data, missing • 74, 239 

default values • 35, 52, 122, 226 

screen • 221, 288 

set in bulk • 107, 122 

screens 

Carriageway screen • 38, 62, 158, 189, 

287 

Correction Factors screen (screens) • 

212, 213, 214, 215, 216, 217 

Count Site screen • 74, 122, 159, 182, 

189, 193, 221, 239, 287 

Counting Schedule screen • 151, 234, 

236, 294, 312 

Filter screen • 76, 83, 90, 225 

Loading screen • 161 

Missing Data screen • 238, 295 

Parameter screen • 62, 67, 99, 216, 284, 

285 

RAMM Manager main screen • 210 

Recommended Count Sites screen • 97, 

98, 99, 104, 107, 226, 227, 228, 295 

Recommended Traffic Links screen • 81, 

85, 87, 90, 223, 297 

Staff Permissions screen • 284, 285, 287, 

288, 290, 291 

Status Check screen • 129, 230, 289, 313 

TMS Header screen • 242 

Traffic Growth Group screen • 219 

Traffic Latest Errors screen • 129, 204, 

230, 297 

Traffic Link screen • 38, 102, 112, 119, 

170, 179, 185, 189, 199, 212, 219, 287, 

310 

Traffic Links with no ADT screen • 129, 

241, 298 

Traffic Sample Group screen • 221 

Traffic screen • 2, 34, 38, 70, 72, 162, 

184, 189, 193, 213, 214, 215, 217, 240, 

287 

Unlinked Carriageways screen • 128, 

241, 299, 311 

Season Profiles 

Factors • 217 

graphs • 45 

Staff Permissions 

Custom • 282 

Full Control • 282, 326 

global security switch • 282 

introduction • 282, 290 

No Access • 282 

Parameter screen • 67, 284, 285 

screen • 284, 285, 287, 288, 290, 291 
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Security Roles • 282 

Traffic data maintenance • 76, 87, 90, 

104, 107, 119, 122, 158, 159, 162, 170, 

177 

User Profiles • 282 

View Only • 282, 330 

Status Check 

ADT values • 38, 230 

factors • 49 

screen • 129, 230, 289, 313 

Staff Permissions • 289 

Update Traffic Counts and Estimates • 

204 

when to run • 52, 67, 129, 204 

T 

Territorial Local Authority •  See RCA 

Time of Day • 72 

TLA •  See RCA 

TMS Header screen • 242 

Traffic 

Count Estimation Management 

introduction • 2 

parameters •  See parameters 

set up process • 52 

Count Sites 

ad hoc • 146, 310 

core • 134, 135, 146 

introduction • 35 

Recommended • 44, 52, 96, 97, 98, 

99, 101, 102, 104, 107, 199, 207, 226, 

227, 295 

rotational • 132, 133, 146 

select • 44, 199 

selection spreadsheet • 135, 137, 139, 

141, 143, 145 

source • 182 

Counts •  See Counts 

ADT values • 184 

Map, Locations • 184 

Growth Groups •  See Growth Groups 

Headers • 242, 290 

Links 

associate • 52, 112, 119, 122, 185 

introduction • 34, 179 

Recommended • 52, 80, 81, 82, 86, 

87, 90, 197, 207, 223, 224, 297 

with no ADT • 52 

Management in RAMM • 2 

screen •  See Traffic screen 

Traffic Growth Groups •  See Growth 

Groups 

Traffic Latest Errors report • 129, 204, 

230, 297 

Traffic Links with no ADT report • 129, 

193, 241, 298 

U 

Unlinked Carriageways 

report • 128, 241, 299, 311 

screen • 128, 241, 299, 311 

User Profiles • 282 

V 

Vehicle Kilometres Travelled •  See 

VKT 
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View Only • 282, 330 

VKT • 330 

AADT calculation • 41 

Network coverage percentage • 62, 67, 

96, 97, 99, 107, 132, 134, 228 

W 

Week Day Factors • 214 

Week Number Factors • 215 

 


